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Introduction

How to use this manual
This document is a user guide for the following printers:
●

HP Latex 3000

●

HP Latex 3100

●

HP Latex 3200

●

HP Latex 3500

●

HP Latex 3600

NOTE: The information contained in this document may be printer-specific, and may not always apply to all
models.
NOTE: This document refers to different printer models. The images shown may differ slightly from your
model.

Welcome to your printer
Your printer is a high-productivity industrial printer for producing signs and graphics on a wide range of flexible
materials up to 3.20 m (126 in) wide. The printer uses water-based HP Latex Inks to provide high-quality, durable
output. Some of the key features of the printer are as follows.
All printers
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●

High quality output, with rich colors, 1200 dpi resolution, and 12 picoliter drop size

●

Print on a wide range of substrates—including PVC banners, self-adhesive vinyls, papers, wall coverings,
PET films, and textiles

●

Durable prints with outdoor display permanence of up to three years unlaminated, and up to five years
laminated

●

Accurate and consistent color reproduction with automatic color calibration (built-in spectrophotometer)

●

Indoor-quality prints up to 77 m²/h (830 ft²/h)

●

HP Latex 3100/3200/3500/3600 only: An energy efficient LED light set, for on-the-fly visual inspection &
proofing of the printed image

●

HP Latex 3100/3200/3500/3600 only: Printer Status Beacon, an intuitive light signaling system to quickly
identify the status of your printer from a distance

●

A new package of productivity software designed to improve business and printer efficiency

How to use this manual
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●

A mobile application for aiding production managers for remote monitoring, and operators for multi-printer
attendance. For latest information on mobile applications visit: http://www8.hp.com/us/en/commercialprinters/latex-printers/workflow-solutions.html

●

Hot swappable ink cartridge: For latex 3000/3100/3200 5 liter, for latex 3500/3600 5 / 10 liter

●

HP Print Care maintenance scheduler and proactive maintenance alerts

●

Environmental differentiation with water-based HP Latex Inks

HP Latex 3500/3600 only
●

(Also optional for HP Latex 3100/3200) In-line slitters for enhancing productivity & alleviating bottle necks
in finishing

●

Larger roll handling capability to extend the uptime for long print runs, and overnight printing

●

Dual-roll split spindles, for managing larger rolls of substrate quicker and safer by one operator on and
around the printer

HP Latex 3200/3600 only
●

Print-zone lights

●

Substrate saver

Documentation
The following documents can be downloaded from http://www.hp.com/go/latex3000/manuals/:
●

Site preparation guide

●

Site preparation checklist

●

Installation guide

●

Introductory information

●

User's guide

●

Legal information

●

Limited warranty

See the Solutions Web site for information about new substrates, at http://www.hp.com/go/latex3000/
solutions/. A new Web-based Media Solutions Locator (http://www.hp.com/go/mediasolutionslocator) has been
developed to collect available substrate configurations for latex printers.
The Quick Response (QR) code images found in some parts of this guide provide links to additional video
explanations of particular topics. For an example of such an image, see The ink collector kit on page 48.

Safety precautions
Before using your printer, read the following safety precautions and operating instructions to make sure you use
the equipment safely.
You are expected to have the appropriate technical training and experience necessary to be aware of hazards to
which you may be exposed in performing a task, and to take appropriate measures to minimize the risks to
yourself and to others.
Operations must be supervised at all times.
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General safety guidelines
WARNING! If your printer includes a printer status beacon, the information provided is for functional
information purposes only, and is not related to any safety provision, or safety states. Warning labels on the
printer must be always considered when operating the printer, and they prevail over any status indicated by the
printer status beacon.
Turn off the printer, using the Branch Circuit Breakers located in the building's Power Distribution Unit (PDU), and
call your service representative (see HP Customer Care Centers on page 409) in any of the following cases:
●

The power cord is damaged.

●

The drying or curing enclosures are damaged.

●

The printer has been damaged by an impact.

●

Liquid has entered the printer.

●

There is smoke or an unusual smell coming from the printer.

●

The printer's built-in Residual Current Circuit Breaker (Ground Fault Circuit Interrupter) has been repeatedly
tripped.

●

Fuses have blown.

●

The printer is not operating normally.

●

There is any mechanical or enclosure damage.

Turn off the printer using the Branch Circuit Breakers in either of the following cases:
●

During a thunderstorm

●

During a power failure

Take special care with zones marked with warning labels.

Electrical shock hazard
WARNING! The internal circuits, drying and curing modules, and vapor removal thermal blankets operate at
hazardous voltages capable of causing death or serious personal injury.
Turn off the printer using the Branch Circuit Breakers located in the building's Power Distribution Unit (PDU)
before servicing the printer. The printer must be connected to earth at mains outlets only.
To avoid the risk of electric shock:
●

Do not attempt to dismantle the drying and curing modules, vapor removal thermal blankets, or the ecabinet except during hardware maintenance tasks. In that case, follow the instructions strictly.

●

Do not remove or open any other closed system covers or plugs.

●

Do not insert objects through slots in the printer.

●

Test the functionality of the Residual Circuit Breaker (RCCB) every year (refer to the procedure below).

NOTE: A blown fuse may indicate malfunctioning electrical circuits within the system. Call your service
representative (see HP Customer Care Centers on page 409), and do not attempt to replace the fuse yourself.
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Checking the functionality of the Residual Circuit Breakers (RCCBs)
Following standard Residual Current Circuit Breaker (RCCB) recommendations, it is recommended that the RCCBs
are tested on a yearly basis. The procedure is as follows:
1.

Turn off the built-in computer using the Internal Print Server’s Shutdown button (or, in Print Care, select
Printer tools > Power options > Shutdown). Do not turn off the printer from the mains switch or the circuit
breakers.
CAUTION: The shutdown process takes some time to complete. Wait until the green Power Enabled light
is off before proceeding.

2.

Once the computer is off, test that the RCCB works correctly by pressing the test button.
●

If the RCCB does not trip when the test button is pressed, this indicates that it has failed. The RCCB
must be replaced for safety reasons; call your service representative to remove and replace the RCCB.

●

If the RCCB trips, this indicates it is working correctly; reset the RCCB to its normal on state.

Heat hazard
The drying and curing subsystems of the printer operate at high temperatures and can cause burns if touched.
LED array supports, and beam and enclosures can reach high temperatures. To avoid the risk of burns, take the
following precautions:
●

Do not touch the internal enclosures of the printer's drying and curing modules or vapor removal thermal
blankets.

●

Take special care when accessing the substrate path.

●

Take special care with zones marked with warning labels.

●

Do not place objects covering LED arrays supports, beam and enclosures.

●

Do not attempt to modify LED array supports, beam and enclosures.

●

Remember to let the printer cool down before performing some maintenance operations.

Fire hazard
The drying and curing subsystems and vapor removal thermal blanket of the printer operate at high
temperatures. Call your service representative if the printer's built-in Residual Current Circuit Breaker (Ground
Fault Circuit Interrupter) is repeatedly tripped.
To avoid the risk of fire, take the following precautions:
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●

Use the power supply voltage specified on the nameplate.

●

Connect the power cords to dedicated lines, each protected by a branch circuit breaker according to the
information detailed in the site preparation guide.

●

Do not insert objects through slots in the printer.

●

Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before using
the printer again.

●

Do not use aerosol products that contain flammable gases inside or around the printer. Do not operate the
printer in an explosive atmosphere.

●

Do not block or cover the openings of the printer.

●

Do not attempt to modify the drying or curing module, e-cabinet, or the vapor removal thermal blankets.

Chapter 1 Introduction
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●

Ensure that the operating temperature of the substrate recommended by the manufacturer is not
exceeded. If this information is not available, ask the manufacturer. Do not load substrates that cannot be
used at an operating temperature above 125°C (257°F).

●

Do not load substrates with auto-ignition temperatures below 250°C (482°F). See note below. No ignition
sources are close to the substrate.
NOTE: Test method based on EN ISO 6942:2002, Evaluation of materials and material assemblies when
exposed to a source of radiant heat, method B. The test conditions, to determine the temperature when the
substrate starts ignition (either flame or glow) were: Heat flux density: 30 kW/m², Copper calorimeter, K
type thermocouple.

●

Proper maintenance and genuine HP consumables are required to ensure that the printer operates safely
as designed. The use of non-HP consumables (foams, filters, printhead cleaner roll, and inks) may present a
risk of fire.

LED array supports, beam and enclosures can reach high temperatures. To avoid the risk of fire, take the
following precautions:
●

Take special care with zones marked with warning labels.

●

Do not place objects covering the LED arrays supports, beam and enclosures.

●

Take care not to spill liquid on the accessory. After cleaning, make sure all components are dry before using
the printer.

●

Do not attempt to modify LED array supports, beam and enclosures.

Mechanical hazard
The printer has moving parts that could cause injury. To avoid personal injury, take the following precautions
when working close to the printer and (optional) in-line slitters:
●

Keep your clothing and all parts of your body away from the printer's moving parts.

●

Avoid wearing necklaces, bracelets and other hanging objects.

●

If your hair is long, try to secure it so that it will not fall into the printer.

●

Take care that sleeves or gloves do not get caught in the printer's moving parts.

●

Avoid standing close to the fans, which could cause injury and could also affect print quality (by obstructing
the air flow).

●

Do not touch gears or moving rolls during printing.

●

Do not operate the printer with covers bypassed.

●

Do not touch the in-line slitters during printing.

●

Handle the in-line slitters with care, and store them safely in their box when not used with the printer.

●

Risk of cutting your fingers! Uninstall the in-line slitters when manipulating the curing module or accessing
the substrate path.

●

Take care when using the air gun. When used for cleaning purposes, make sure to use it according to the
local regulations since additional safety provisions may apply.

Light radiation hazard
Infrared (IR) radiation is emitted from the dryer module. The dryer enclosure limits radiation in compliance with
the requirements of the exempt group of IEC 62471:2006, Photobiological safety of lamps and lamp systems.
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However, you are recommended not to look directly at the lamps while they are on. Do not modify the dryer
enclosure.
UV radiation can be emitted from the LED array in compliance with the requirements of the exempt group of IEC
62471:2006, Photobiological safety of lamps and lamp systems. However, you are recommended not to look
directly for a long time at the output LED lights while they are on.
Alignment tool for Dual roll center support uses a Laser class > I in compliance with limits according to CE and
FDA requirements, and has its laser warning label accordingly. You are recommended not to look directly at the
laser beam.

Chemical hazard
See the safety data sheets available at http://www.hp.com/go/msds/ to identify the chemical ingredients of your
consumables. Sufficient ventilation should be provided to ensure that potential airborne exposure to these
substances is adequately controlled. Consult your usual air-conditioning or EHS specialist for advice on the
appropriate measures for your location. For more detailed information, see the "Ventilation" and "Air
conditioning" sections of the site preparation guide, available from http://www.hp.com/go/latex3000/manuals/.

Ventilation
Fresh air ventilation is needed to maintain comfort levels. For a more prescriptive approach to adequate
ventilation, see the latest edition of the ANSI/ASHRAE (American Society of Heating, Refrigerating and AirConditioning Engineers) document Ventilation for Acceptable Indoor Air Quality.
Air conditioning and ventilation should meet local Environmental Health and Safety (EHS) guidelines and
regulations.
Follow the ventilation recommendations in the site preparation guide.

Air conditioning
In addition to fresh air ventilation, to avoid health hazards, you should maintain the operating conditions
specified in the Environmental specifications on page 414, to avoid operator discomfort and equipment
malfunction. Air conditioning in the work area should take into account that the equipment produces heat.
Typically, the printer's power dissipation is: 9–11 kW (31–38 kBTU/h).

Sound pressure level
The sound pressure level could exceed 70 dBA in some print modes. Hearing protection may be required.

Heavy substrate hazard
Special care must be taken to avoid personal injury when handling heavy substrates.
●

Handling heavy substrate rolls always requires two people. Care must be taken to avoid back strain and/or
injury.

●

Always use a forklift, pallet truck, or other handling equipment to lift substrates. The printer has been
designed to be compatible with many of these devices.

●

Always wear personal protective equipment including boots and gloves.

Ink and condensation handling
HP recommends that you wear gloves when handling ink and condensation system components.

6
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Use of tools and keys
●

Users: Daily operations including printer settings, printing, substrate loading, replacement of ink reservoirs,
and daily checks. No tool or maintenance key is required.

●

Maintenance personnel: Hardware maintenance tasks and replacement of printheads, filters, ink waste
bottles, foams, and printhead cleaning roll. The maintenance key and a flat screwdriver are required.

●

Service personnel: Any repair or maintenance operation, running diagnostics, and troubleshooting.
Required:

Maintenance key

e-cabinet key

Internal Print Server key.

Torx screwdriver set

Mains switch key

NOTE: During the installation of the printer, the designated personnel receive training for the safe operation
and maintenance of the printer. It is not allowed to use the printer without this training.
NOTE: After using the maintenance key to open a door, remember to lock it afterwards, and return the key to
safe and secure storage.

Warnings and cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer
from being damaged. Follow the instructions marked with these symbols.
WARNING!
death.

Failure to follow the guidelines marked with this symbol could result in serious personal injury or

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the product.
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Warning labels
Label

Explanation
Electric shock hazard
Heating modules operate at hazardous voltage. Disconnect power
source before servicing.
Caution! Double pole. Neutral fusing. Refer servicing to qualified
service personnel.
In case of operation of the fuse, parts of the printer that remain
energized may represent a hazard during servicing. Before
servicing, turn off the printer using the Branch Circuit Breakers
located in the building's Power Distribution Unit (PDU).
Warning
High leakage current. Current leakage may exceed 3.5 mA. Earth
connection essential before connecting supply. Equipment to be
connected to earthed mains only.

Located on the e-cabinet; for service personnel only

See installation instructions before connecting to the supply. Ensure
that the input voltage is within the printer's rated voltage range. The
printer requires up to two dedicated lines, each protected by a
branch circuit breaker according to site preparation requirements.
Before starting
Read and follow the operating and safety instructions before
starting the printer.
Risk of burns. Do not touch the internal enclosures of the printer's
drying and curing modules, vapor removal thermal blankets,
universal support beam, and LED array and enclosures.

Located on the curing and drying modules and universal support
beam.
Crush hazard. Do not touch PPS while moving. When the substrate
has been loaded, the carriage descends into its printing position,
and could crush your hand or anything else left underneath it.

Located on each side of the substrate path, close to the PPS gear
Risk of trapped fingers. Do not touch gears while moving. Danger
that your hands may become trapped between gearwheels.

Located on each side of the substrate path, close to the PPS gear,
and on the dual roll center support

8
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Label

Explanation
Hazardous moving part. Keep away from moving printhead
carriage. When printing, the printhead carriage travels back and
forth across the substrate.

Located internally on the substrate path and internally on the right
cover; for maintenance/service personnel only
Light radiation hazard. Infrared (IR) radiation is emitted from this
printer. Do not modify the dryer enclosure. You are recommended
not to look directly at the lamps when they are on.
The dryer enclosure limits radiation in compliance with the
requirements of the exempt group of IEC 62471:2006,
Photobiological safety of lamps and lamp systems.
Located on the dryer module; for maintenance/service personnel
only
You are recommended to wear gloves when handling the
maintenance cartridge, the platen, the ink collector, condensation
on the printer, and the condensation system components.

Located on the condensation collector bottle and the printhead
cleaning roll carriage
Sound level could exceed 70 dBA in some print modes. Hearing
protection may be required.

Located at the rear, on the left cover
Electric shock hazard. Disconnect power before servicing. Heating
modules and electrical cabinets operate at hazardous voltage.

Located internally on heating modules and electrical cabinets; for
maintenance/service personnel only
Risk of cutting your fingers. Do not touch in-line slitters during
printing.
Handle in-line slitters with care and store them safely in their box
when not used with the printer.

Located on each side of the in-line slitters
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Label

Explanation
Hazardous moving parts. Keep away from moving fan blades.

Located internally, close to vacuum fan blades; for maintenance/
service personnel only
Identifies the Protective Earth (PE) terminal for qualified electricians,
and bonding terminals for maintenance/service personnel only.
Earth connection essential before connecting supply.

Emergency stop buttons
There are four emergency stop buttons distributed around the printer. If an emergency occurs, simply push one
of the emergency stop buttons to stop all printing processes. A system error message is displayed, and the fans
turn at maximum speed. Ensure that all emergency stop buttons are released before restarting the printer.

For safety reasons, access to the print zone is not permitted while printing is in progress. Therefore, if the front
door or the loading table is opened, power to the carriage and to the drying and curing module is disconnected.
The print is cancelled and a system error may be displayed.

Main components
The following views of the printer illustrate the main components.
10
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Front view HP Latex 3000 Printer

1.

Condensation collector bottle

2.

Ink cartridges

3.

Emergency stop buttons

4.

Service position window

5.

Built-in computer

6.

E-cabinet

7.

Power switches, lights, and circuit breakers

8.

Printhead cleaner roll door

9.

Curing module latches, one on each side

10. Tension roller (for roll-to-free-fall configuration)
11. Front door
12. Curing module handles
13. Substrate output spindle

ENWW
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Front view HP Latex 3100/3200/3500/3600 Printer
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1.

HP Latex 3500/3600 only: Dual roll split spindle center support

2.

HP Latex 3200/3600 only: Printzone lights

3.

Universal Mounting Beam

4.

(Also optional for 3100/3200) Slitters

5.

HP Latex 3500/3600 only: Split spindles

6.

LED proofing lights

7.

HP Latex 3500/3600 only: Roll ejector lever

Chapter 1 Introduction
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Rear view HP Latex 3000 Printer
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1.

Emergency stop buttons

2.

Ink cartridges

3.

Loading table latches, one on each side

4.

Loading table

5.

Drive roller

6.

Substrate input spindle

Main components
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Rear view HP Latex 3100/3200/3500/3600 Printer
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1.

Printer status Beacon

2.

HP Latex 3500/3600 only: Dual roll split spindle center support

3.

HP Latex 3500/3600 only: Roll ejector lever

4.

HP Latex 3500/3600 only: Split spindles

5.

HP Latex 3500/3600 only: Diverter

Chapter 1 Introduction
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Carriage view

1.

Optimizer printhead latch

2.

Oiler foams

3.

Printhead

4.

Aerosol filters

5.

Drying filters

6.

Printhead latch

Printer software
Your printer requires the following software:
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●

The HP Internal Print Server is provided with your printer and is already installed in the printer's built-in
computer. It displays printer alerts and a summary of printer status, manages print jobs, and must be used
to interact with the printer in various ways. See HP Internal Print Server on page 20.

●

The HP Print Care program is provided with your printer and is already installed in the printer's built-in
computer. It displays printer status and history in detail, and helps you to maintain the printer and solve
any problems that may arise. See HP Print Care on page 185.

●

A Raster Image Processor (RIP) should be run on a separate computer; it cannot be installed on the printer's
built-in computer. It is not provided with the printer and should be obtained separately. The printer is JDFenabled. If your RIP supports this interface, it can retrieve and display printer and job status.

Printer software

15

Turn on the printer for the first time
1.

Make sure that the two bottom rows of circuit breakers at the front right of the printer are all in the up
position.

2.

Turn the main switch to the on position, and also turn on the PC switch beside it.

3.

Check that all three green lights are on. In normal operation these lights should always be on. If any of
them are off, check the Internal Print Server in case there is a system error, and see Printer messages
on page 415 or check with your electrician.

4.

Wait for the Internal Print Server to tell you that the printer is waiting for rearm.

5.

Perform a visual check of the printer.

6.

Press the blue rearm button at the front right of the printer. This enables all of the printer's high-power
subsystems.

7.

Check that the printer-enabled green light turns on. In normal operation this light should always be on. If at
any time you notice that this light is off, check the Internal Print Server in case there is a system error, and
see Printer messages on page 415.

8.

Wait for the Internal Print Server to indicate that the printer is ready. This can take several minutes. When
initialization is complete, the Internal Print Server displays a Ready message. If a system error message is
displayed, see Printer messages on page 415.

Turn the printer on and off
The printer has three power-off levels. Each of them goes deeper, until you reach complete shutdown at level 3.
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Level

Turn off

Turn on

1: Major power
electronics and engine
off.

Wait for the Internal Print Server to indicate that the
printer is ready, then turn off the high-power
subsystems by pressing the shutdown icon near the
top left corner of the screen. Wait until the Internal
Print Server reports that it has lost its connection to
the printer.

Click the Wake Up button up in the top left corner of
the Internal Print Server window, and wait for the
printer to turn on the high-power systems.
When prompted, press the blue rearm button at the
front right of the printer.

NOTE: After the printer electronics have been
turned off at the Internal Print Server, the fans turn at
maximum speed for safety reasons. This is normal
behavior and not a cause for concern.
2: All printer systems off
(recommended).

After completing level 1, turn off the main switch. The
fans should stop.

After completing level 1, turn on the main switch, and
ensure that the circuit breaker beside it is on.
When prompted, press the blue rearm button and
wait for the Internal Print Server to announce that the
printer is Ready.

3: All printer systems and
Internal Print Server off.

After completing level 2, shut down the Internal Print
Server from the Windows Start button, and wait until
you see a black screen with the message No input
signal.

After completing level 2, see Turn on the printer for
the first time on page 16.

CAUTION: The computer may be damaged if it is
turned off incorrectly.
Once the Internal Print Server is completely off and
you see No input signal on the screen, turn off the
computer power switch.
4: Reboot.

—

—

5: Reboot and print.

—

—

IMPORTANT:

The printer incorporates a counter that indicates the printer usage time that remains.

Move the printer
If you wish to move the printer a short distance on the same site, across a horizontal floor with no steps and no
slopes of more than 5% inclination, see the following instructions. For more difficult movement operations, call
your service representative (see HP Customer Care Centers on page 409).
CAUTION:
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Slopes steeper than 5% may cause serious damage to the printer.

1.

Turn off the printer.

2.

Disconnect all power and network cables from the printer.

3.

Disconnect all ink cartridges and remove them from the printer. Hold the cartridge connectors in position
with adhesive tape.

4.

If your printer is an HP Latex 3500/3600, raise the secondary feet before moving the printer.

5.

Is your printer is an HP Latex 3500/3600, unload the split spindles and remove both center support split
spindles from their base (see HP Latex 3500/3600 dual-roll split spindles center support on page 63).

6.

Raise the feet so that the wheels (A) touch the ground. To raise a foot:

Move the printer
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a.

Use a 30 mm (1.18 in) wrench to unlock the nut at the top of the foot.

b.

Rotate the nut manually down the bolt. Leave about 2 cm (0.8 in) clearance at the bottom between
nut and foot.

c.

Use a 15 mm (0.59 in) wrench to rotate the foot upwards. Use the flat faces at the bottom of the bolt
to fit the wrench.

d.

Raise the foot as far as the bolt allows.

e.

Use the 30 mm (1.18 in) wrench to relock the nut.

CAUTION: Take care to raise the feet as high as you can. They may break if they touch the ground while
the printer is in motion.

7.

HP Latex 3500/3600 only: If the printer is anchored to the floor, unanchor it; remove the 2 M20 bolts from
each anchor support, then, once the printer has been moved away, there will be access to remove the
anchor supports from the floor.

8.

Push the printer from the outside corners of the top covers. Remember to avoid slopes steeper than 5%.

9.

if you have an HP Latex 3500/3600, it is possible that you have to adjust the center support split spindles
after moving the printer (see HP Latex 3500/3600 dual-roll split spindles center support on page 63).
If the printer needs to be reinstalled, see the installation guide for more details on anchoring the printer to
the floor and dual roll center support installation.

After moving the printer, you may in some cases need an electrician to reconnect the power cables. You may also
need to reconfigure the network, from the printer's built-in computer and from the RIP computer. See the
Installation Guide for more details, including the minimum space required around the printer.

Printer Status Beacon
CAUTION: In the case that the printer includes a printer status beacon; the information provided is for
functional information purposes only, and is not related to any safety provision, or safety states. Warning labels
on the printer must be always considered when operating the printer, and they prevail over any status indicated
by the printer status beacon.
If your printer is an HP Latex 3100/3200/3500/3600 your printer has a light signaling system to visually identify
the status of your printer.
Printer status beacon messages mean:
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Color

Description

Red

Unexpected printing interruption. A job that had started to print stopped unexpectedly and
appears as Failed. Attention required.
An UI user confirmation appears in the IPS window. When attended to, the red color in the
beacon changes to reflect the state of the printer.

Orange

Alert present in the IPS (Warnings)

Green

Idle
Printing

Output platen light (HP Latex 3200/3600 only)
The output platen light illuminates both the platen and the job that is being printed. It can be switched on and off
manually

ENWW

Output platen light (HP Latex 3200/3600 only)
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2

HP Internal Print Server

Start the Internal Print Server
The Internal Print Server starts automatically with Windows, and runs continually, in the background if not in the
foreground.
If for some reason it has stopped running, or its window is not visible, you can start it from the Windows Start
menu or by double-clicking its icon on the desktop.

When it starts, the main screen appears.
IMPORTANT: The screen captures shown below are for reference, be sure to have latest firmware version
installed. See Update the firmware on page 26.

In the main screen:
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●

You can shut down the printer by pressing the Shut down button at the top left.

●

The top central pane shows the printer status and maintenance status. See Printer status and alerts
on page 25.

●

The thermometer to the right of the status pane shows the curing temperature.
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●

To the right of the thermometer, you can see a summary of the status of the ink cartridges, the printheads,
and the printhead cleaning roll.

●

The Printing pane occupies most of the window, and includes:

●

–

The Print, Cancel, and Print adjustment buttons

–

The job queue

–

The print preview and job settings

The Substrate pane includes the Substrate load/unload, Enable collector, and move carriage beam buttons;
and information about how the current substrate is loaded.

Change the language of the Internal Print Server
When the Internal Print Server starts, it uses the language selected in the Windows Regional and Language
Options. To change the selected language:
1.

Open the Control Panel from the start menu.

2.

If you are using the Category View of the Control Panel, open the Clock, Language, and Region category.

3.

Open the Regional and Language Options.

4.

In the Formats tab, change the current format to correspond with the language you want.

5.

Press the OK button.

The change takes effect when Windows is restarted.

Change the units of measurement in the Internal Print Server
To change the units of measurement in the Internal Print Server, select the Tools > Preferences > Units. You can
change the units of length and temperature.

Set the Internal Print Server preferences
To change the Internal Print Server's preferences, select Preferences from the Tools menu. In the Preferences
window, you will see four tabs.
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General tab

●

Units of length and temperature

●

Remarks (to add as a footer to the printed file)

●

Font of footer text

●

Hot folder

●

JMF connection url

Queue Rules tab
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●

Action when job fails

●

Action when job has been printed

●

Action when job is removed from the queue

●

Action when fiducials are missing
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Additional Settings tab

●

Maximum roll length

●

Gap between jobs

●

Nesting gap between images

●

Margins:

●

ENWW

–

RIP: Margins are set as defined in the RIP.

–

Center: The image is horizontally centered on the loaded substrate.

–

Default: The default margins are set to 5.0 mm (0.02 in). You can define the default left margin in the
Job Properties window.

Optimize for tiling:
–

Print preparation plot at the beginning of the queue.

–

Print color bars.

Set the Internal Print Server preferences
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Remote Assistance tab

●

Enable remote assistance

●

Subscribe to services

Internal Print Server menus
The Internal Print Server provides the following menus.
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The File menu

The Information menu

The Printer menu

●

Add New Job

●

Alerts

●

Printing adjustments

●

Add Existing Job

●

Supplies

●

Printhead alignment

●

Edit Job

●

Service information

●

Printhead cleaning

●

Delete Job

●

Replace printheads

●

Exit

●

Replace cleaning roll kit

●

Advance calibration

●

Enable/Disable collector

The Substrate menu

The Tools menu

The Help menu

●

Load/Unload

●

Preferences

●

About

●

Settings

●

HP Scitex Print Care

●

User's guide

●

Create

●

HP Proactive Support

●

Contact HP

●

Edit

●

Firmware update

●

HP Remote Support

●

Clone

●

Restart

●

Optimize for tiling

●

Restart and print

●

Rename

●

Wake up

●

Remove

●

Shut down

●

Color calibration

●

Reinitialize carriage

●

Presets management

●

Search substrate online

Printer status and alerts
The Internal Print Server displays the general status of the printer, the maintenance status, the loaded substrate,
and the ink system.
The printer can communicate the following types of alerts:
Printer status
●

Errors: When the printer is unable to print.

●

Warnings: When the printer needs attention for an adjustment, such as a calibration, preventive
maintenance or ink cartridge replacement.

●

The remaining boot time will be displayed in the Internal Printer Server while the printer is starting.

A summary list of printer alerts appears in the main window of the Internal Print Server. To display a more
complete and detailed list, select Information > Alerts.
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For more information about a particular alert, see Printer messages on page 415.
Maintenance status
●

Green light: No maintenance is needed.

●

Yellow light: Maintenance procedure date is approaching. Press the yellow button to check Print Care for
details. See HP Print Care on page 185.

●

Orange light: Maintenance is required. Press the orange button to check Print Care for details.

●

Red light: Maintenance is required urgently. Press the red button to check Print Care for details.

●

Grayed out: Print Care is not running. Press the orange button.

Update the firmware and the Internal Print Server
TIP: When updating the firmware and the Internal Print Server, first update the firmware and then the Internal
Print Server.

Update the firmware
From time to time firmware updates will be available from HP that increase the printer's functionality and
enhance its features.
Firmware updates can be downloaded from the Internet and installed in your printer using the Internal Print
Server: select Firmware update from the Tools menu.

Follow the instructions on your screen to download the firmware file and store it on your hard disk. Then select
the downloaded file and click Update.
The firmware includes a set of the most commonly used substrate presets. Extra substrate presets can be
downloaded separately; see Substrate presets on page 102.

Update the Internal Print Server and HP IPS Services
IMPORTANT: It is mandatory to remove the HP Info Retriever, the HP IPS Services and the HP Internal Printer
Server software from the built-in printer computer before installing the new IPS version.
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1.

Download the latest version IPS package available from the HP support web site onto the IPS PC hard disk
(dedicated folder recommended, not on the desktop) and unzip all the files.

2.

Remove the HP Info Retriever software via the Windows control panel in case it is listed in Programs and
Features in the Windows control panel.
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3.

Remove the HP IPS Services and/or ProxyService software via the Windows control panel, click the Uninstall
button.

4.

Remove the Internal Printer Server software via the Windows control panel. Select the HP Internal Printer
Server application and click the Uninstall button. This deletes any current job in the queue except ripped
files.

5.

Install the Internal Printer Server.
Run the Setup.exe file inside the IPS folder and follow the onscreen instructions until the new software is
installed.

6.

Install IPS Services.
Run the Setup.exe file inside the HP IPS Services folder and follow the onscreen instructions until the new
software is installed..

7.

ENWW

Once the IPS installation process has completed, open the IPS application. The first time it is opened the
Data Transfer Agreement (PDSA) window will appear. HP strongly recommends you enable it in order to
take advantage of information retriever functionality and for faster improved remote support.

Update the firmware and the Internal Print Server

27

8.

In the Remote assistance tab, go to Tools > Preferences and check the Enable Remote Assistance check
box.

Maintain the Internal Print Server
The Internal Print Server runs under Microsoft Windows on the computer supplied with the printer. In that
operating environment, there are various things you can check in order to maintain optimum performance. You
can make these checks after restarting the computer and before starting the Internal Print Server.
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●

The user account should be a Standard account and not an Administrator account.

●

No software should be installed on the computer except the software initially provided by HP (which
includes antivirus software).

●

Free space on the hard disk should be at least 10 GB.

●

In the Control Panel, Hardware and Sound > Power Options, the high-performance power plan should be
selected and sleep mode disabled.

●

Turn off User Account Control from the User Accounts icon in the Windows Control Panel.

●

User a blank screen saver.

●

Press the start button and right-click Computer. Select Manage > Device Manager > Disk drives. Right-click
the hard disk, and select Properties > Policies. Ensure that Optimize for performance, Enable write caching
on the disk and Enable advanced performance are all enabled.

●

Ensure that scheduled defragmentation is enabled. Press the start button and right-click Computer. Select
Manage > Disk Management. Right-click the hard disk, and select Properties > Tools > Defragment Now,
and ensure that Run on a schedule is enabled.

●

In the Control Panel, select System > Advanced system settings > Advanced > Performance > Visual Effects
> Custom. Ensure that all effects are disabled except Enable Desktop composition, Enable transparent
glass, Smooth edges of screen fonts and Use visual styles on windows and buttons.

●

Open Internet Explorer and select Tools > Internet options > Connections > LAN settings. If a proxy server is
used, ensure that Bypass proxy server for local addresses is enabled.

●

Ensure that the computer is connected to the Internet and use Windows Update to ensure that all available
updates (including Windows Service Packs) have been installed successfully.

●

Start the Internal Print Server, and use File > Delete job to delete any jobs for which there is no further use.

Chapter 2 HP Internal Print Server

ENWW

3

Printing workflows integration

Introduction to JDF
What is JDF?
JDF is a software method by which devices from a variety of vendors and manufacturers can interoperate
together. It uses a text-based language known as XML that is compliant with many devices and workflow
controllers in varying vertical print markets.
JDF implementation is typically based upon an MIS system to be use for job scheduling, submission, accounting,
and costing. An integrator typically interfaces an MIS system to the devices that are present in a workflow
through JDF technology.
JMF is a communication protocol (based upon the JDF specification) that allows devices to communicate job
status information and other real-time job metrics and parameters. It can be used to poll a device for status or to
watch a device at regular intervals.

Benefits of working with JDF for file submission
JDF can be useful in providing an accurate MIS-driven way to know the job status of content as well as when a
device has completed a job. Since the role of an MIS is to track, schedule and cost-account for a job, JDF/JMF
allows for a simple way to interface devices to an MIS for this task.
JDF and JMF can be used to be able to analyze and later perform accounting principles upon work created in a
JDF workflow. A detailed analysis can be performed after a day or series of jobs to see the profit margin of a job,
the costs and materials consumed, as well as inventory control and stock consignment.
HP is a partner member of the CIP4 organization, and you can obtain many more details about JDF at the CIP4
www site at http://www.cip4.org.

Working with JDF
Creating JDF job tickets
JDF Implementations typically use an MIS system to control and monitor a JDF/JMF workflow. The MIS can then
monitor a device’s status, can track time and consumables and provide interfacing with counting and inventory
control modules integrated into an MIS. An MIS is typically the origin of a JDF job and resultant ticket. JMF
communication can be used to send that ticket information to production milestones.

What information is captured by the HP latex 3000 printer series and what can be
communicated by JMF to an MIS?
The printer implements a subset of the JDF 1.5 specification, using JMF. This allows it to communicate printerstatus, and notifications together with job status, job ink, and substrate consumption to external applications.
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NOTE: It is important to consider the fact that the RIP is capable of combining several jobs into one for the
purpose of substrate optimization, and finishing. In this example, the printer sees the print as one job. In this
situation, the MIS should query the RIP for the status of each individual job on the nest.
The RIP application can retrieve substrate and consumable tracking to report back to MIS.

Guidelines for Integration
How to integrate the HP Latex 3000 printer series into CALDERA RIP
From CALDERA RIP 10.1, the RIP can take advantage of the JDF interface in the printer by selecting the option on
the printer driver setup. Once the JDF interface is enabled, the RIP will display printer status and notifications
together with job status, job ink and substrate consumption.
In order to activate this functionality in the CALDERA RIP, you need to type the printer's JMF url in the JDF area of
the printer configuration dialog (IPS URL). Please, make sure you have the latest driver available from the
CALDERA Website.

Once configured, you can display the printer status by opening the info window in the print client, and opening
the spooler for the job status.

To obtain the JMF URL: Go to the IPS PC, on the Internal Print Server SW, and then Tools>Preferences>General.
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If there are problems using the printer’s hostname, switch to the printer’s IP using the HP Latex 3000 System
Configuration Tool. For more details refer to the Service Manual or talk to your network administrator to solve
hostname resolution.

How to integrate the HP Latex 3000 printer series into ONYX RIP
ONYX RIP (version ONYX 10.1.2) can take advantage of the JDF interface in the printer by selecting the option on
the printer driver setup. Once the JDF interface is enabled, the RIP will display printer status and notifications
together with job status, job ink and substrate consumption.
In order to activate this functionality in ONYX RIP, you need to type the printer's JMF url in the JDF area of the
printer configuration dialog (JDF URL). Please, make sure you have the latest driver version from the ONYX
Download manager.

Once configured, you can display the printer and job status opening the info window in the RIP queue.
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To obtain the JMF URL: Go to the IPS PC, on the Internal Print Server SW, and then Tools>Preferences>General.

If there are problems using the printer’s hostname, switch to the printer’s IP using the HP Latex 3000 System
Configuration Tool. For more details refer to the Service Manual or talk to your network administrator to solve
hostname resolution.

Job submission methods
The HP Latex 3000 printer series supports two file submission methods (in addition to open a file directly in
HP IPS UI):
Select the submission method within the Preference dialog in HP IPS Tools>Preferences>General, in the Submit
method drop down list:
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Hotfolder: Select a shared folder in the HP IPS PC and the RIP copies the output job there, the IPS automatically
loads jobs into the queue.
NOTE:

The shared folder should be the same as the one configured in the RIP.

JMF: The RIP sends the location of the job via a JMF command and the IPS automatically looks for the files there
and loads them directly into the printer queue.
Not specify: Load the file manually in the IPS File>Open.
Removing a queued job from the RIP:
Remove a job from the IPS/printer queue directly via the RIP interface, but only if it was submitted using the JMF
method.

How to integrate the HP Latex 3000 printer series into an MIS system or production control software
Specific RIP/MIS implementations will require vendor specific configurations.
MIS or Production Control Software applications can retrieve printer status and notifications together with job
status, job ink and substrate consumption, from the printer via the JDF/JMF interface.
As explained in the previous section, if the RIP combines several jobs into one before sending it to the printer, the
recommendation is to connect the MIS or Production Control software to the RIP instead of the IPS in order to get
the grouped jobs’ individual job status.
Be sure to assign unique names to each job in order to identify them on the gathered information from the
printer.

If you are using CALDERA 10.1 or higher versions of the software, then the MIS can communicate using the
Caldera Nexio module. Caldera Nexio is a tool that connects the Caldera RIP and other third-party software using
standard JDF/JMF protocols, making it possible to produce automatic sequences of actions that speed up
production and advanced reports to improve operations. Please, contact CALDERA for further information.
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ONYX customers wishing to integrate with MIS solutions can use the ONYX Connect module to communicate via
JDF. ONYX Connect does not currently support JMF. Please contact ONYX for further information.
If you are using another RIP solution, please contact your specific RIP vendor for JDF/JMF configuration and
interface guidelines.
MIS vendors or customers that would like to integrate the printer with a solution directly, can obtain the HP
specifically supported JDF Software Development Kit from the HP Solutions Portal: https://developers.hp.com/
lfp-enroll.
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4

Handle the substrate

Supported substrate types
The following substrate types are compatible with your printer. For specific substrate settings and profiles, see
the Online substrate manager on page 117.
NOTE: Porous substrates and substrates with porous liners are supported only when using the ink collector kit
(see The ink collector kit on page 48).
Self-adhesive vinyl
●

Cast self-adhesive vinyl

●

Calendered self-adhesive vinyl

●

Perforated self-adhesive vinyl

●

Transparent self-adhesive vinyl

●

Reflective self-adhesive vinyl

PVC banner
●

Frontlit banner

●

Backlit banner

●

Scrim banner

●

Scrimless banner

●

Mesh banner with liner

●

Blockout banner

●

Truck curtain banner or tarpaulin

●

Coated paper

●

Uncoated paper

●

Photo paper

●

Photorealistic paper

●

Blue-back paper

●

Self-adhesive paper

Paper
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PP and PE film and banner
●

Polypropylene (PP) film

●

Synthetic paper (such as Yupo)

●

Tyvek

●

Coated PE/HDPE (polyethylene) banner

●

Polyester (PET) backlit film

●

Polyester (PET) frontlit film

●

Polyester (PET) grey-back film

PET film

Textile
Porous textiles may be used only with the ink collector. To check the porosity of your substrate, see Check the
porosity of your substrate on page 36.
●

Polyester textile and fabric

●

Textile banner

●

Backdrops

●

Textile mesh with liner

●

Frontlit textile with liner if porous

●

Backlit textile with liner if porous

●

Canvas

●

Flag and voile with liner

●

Cotton textile

●

Self-adhesive textile

Wall covering
NOTE: This is an application example, not a selectable category.
●

Paper wall covering or wallpaper

●

PVC wall covering

●

Pre-pasted wall covering

●

Non-woven wall covering

●

Textile wall covering

●

Self-adhesive wall covering

Check the porosity of your substrate
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1.

If the printer has any substrate loaded, unload it.

2.

Cut a piece of self-adhesive vinyl white gloss 15 × 50 mm (0.6 × 2 in) in size.
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3.

Stick it to the platen, covering the substrate-advance sensor.

4.

Load the substrate that you want to check.

5.

Open your RIP software.

6.

Obtain the test file from the printer’s built-in computer: C:\Users\hplatex\Documents\HP IPS
\InkTrespassingCheck\Ink_trespassing_check.pdf.

7.

Print the test file using the number of passes and substrate preset that you intend to use in future with this
substrate (or a similar profile in terms of ink limit).

8.

Unload the substrate.

9.

Remove the strip of self-adhesive vinyl from the platen.

10. Look at the self-adhesive vinyl you have taken from the platen.
●

If the strip is completely white (has no ink on it), the tested substrate is non-porous and may be used
for printing as described in this guide.

●

If the strip is non-white, the tested substrate is porous and may be used only with the ink collector
installed.

11. Clean the print zone, see Clean the print zone on page 202.

Supported HP substrates
Category

Substrate

Color
calib.

Self-adhesive
vinyl

HP Air Release Adhesive Gloss Cast Vinyl

Yes

Without liner: 50 microns (2 mil) • 100 g/m² • 45,7 m (150 ft)

Applications
Vehicle wraps, car/bus/
track fleets, signs

With liner: 241 microns (9.5 mil) • 260 g/m² • 45,7 m (150 ft)
HP Permanent Gloss Adhesive Vinyl

Yes

Without liner: 121 microns (4.8 mil) • 150 g/m² • 45,7 m (150 ft)/ 91,4 m (300 ft)
With liner: 248 microns (9.8 mil) • 270 g/m² • 45,7 m (150 ft)/ 91,4 m (300 ft)
HP Permanent Matte Adhesive Vinyl

Yes

Without liner: 121 microns (4.8 mil) • 150 g/m² • 45,7 m (150 ft)/ 91,4 m (300 ft)
With liner: 248 microns (9.8 mil) • 270 g/m² • 45,7 m (150 ft)/ 91,4 m (300 ft)
HP One-View Perforated Adhesive Window Vinyl

No

Without liner: 165 microns (6.5 mil) • 155 g/m² • 50 m (164 ft)
With liner: 406 microns (16 mil) • 288 g/m² • 50 m (164 ft)
PVC banners

HP Durable Frontlit Scrim Banner

Yes

Banners, POP, flags,
track covers, wall
murals

Yes

POP indoor and
outdoor, windows, bus
shelters, billboards,
wall decorations

449 microns (17.7 mil) • 535 g/m² • 35 m (115 ft)
Paper

HP PVC-Free Wall Paper
177 microns (7 mil) • 175 g/m² • 30,5 m (100 ft)
HP White Satin Poster Paper
165 microns (6.5 mil) • 136 g/m² • 61 m (200 ft)
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Category

Substrate

Color
calib.

HP Photo-realistic Poster Paper

Yes

Applications

205 microns (8.1 mil) • 205 g/m² • 61 m (200 ft)
HP Blue Back Billboard Paper

Yes

165 microns (6.5 mil) • 123 g/m² • 80 m (262 ft)
New HP Universal Coated Paper, 3 in core

Yes

124 microns (4.9 mil) • 90 g/m² • 61 m (200 ft)
New HP Coated Paper, 3 in core

Yes

114 microns (4.5 mil) • 90 g/m² • 61 m (200 ft)
New HP Universal Heavyweight Coated Paper, 3 in core

Yes

165 microns (6.5 mil) • 125 g/m² • 61 m (200 ft)
New HP Heavyweight Coated Paper, 3 in core

Yes

167 microns (6.6 mil) • 130 g/m² • 61 m (200 ft)
New HP Super Heavyweight Plus Matte Paper, 3 in core

Yes

259 microns (10.2 mil) • 210 g/m² • 61 m (200 ft)
HP Professional Gloss Photo Paper

Yes

248 microns (9.8 mil) - 275 g/m2 - 30,5 m (100 ft)
HP Professional Satin Photo Paper

Yes

248 microns (9.8 mil) 275 g/m2 - 30,5 m (100 ft)
HP Everyday Satin Photo Paper

Yes

187 microns (7.4 mil) - 180 g/m2 - 30,5 m (100 ft)
PP and PE film
and banners

New HP HDPE Reinforced Banner

Yes

203 microns (8 mil) • 170 g/m² • 45,7 m (150 ft)
New HP Everyday Matte Polypropylene, 3 in core

Yes

Banners, POP, flags,
track covers, wall
murals, large
photographs, floor
covering

203 microns (8 mil) • 120 g/m² • 61 m (200 ft)
New HP Everyday Adhesive Matte Polypropylene, 3 in core

Yes

Without liner: 180 microns (7.1 mil) • 120 g/m² • 30,5 m (100 ft)
With liner: 215 microns (8.5 mil) • 168 g/m² • 30,5 m (100 ft)
HP DuPont Tyvek Banner

No

304 microns (12 mil) • 135 g/m2 (4 oz) • 30,5 m (100 ft)
PET film

HP Backlit Polyester Film
304 microns (12 mil) • 135 g/m² • 30,5 m (100 ft)
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ads, POP, street ads
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Category

Substrate

Color
calib.

Textile

HP Light Textile Display Banner

No

381 microns (15 mil) • 210 g/m² • 50 m (164 ft)
HP Heavy Textile Banner

Applications
Indoor flags, wall
murals, interior
decoration, fine arts

No

381 microns (15 mil) • 210 g/m² • 50 m (164 ft)
HP Satin Canvas

No

419 microns (16.5 mil) • 370 g/m² • 14,9 m (49 ft)
HP Premium Satin Canvas

No

462 microns (18.2 mil) - 381 g/m2 - 22,9 m (75 ft)
HP Everyday Satin Canvas

No

444 microns (17.5 mil) - 340 g/m2 - 22,9 m (75 ft)

●

For third-party substrate solutions with ColorPRO technology, see http://ColorPROtechnology.com/.

●

HP PVC-free Wall Paper imprimé avec les encres HP Latex est classé A+ selon l’arrêté du 19 avril 2011
«Émissions dans l'air intérieur», qui définit des seuils sur l’émission de polluants volatils posant des
problèmes en cas d’inhalation – sur une échelle de A+ (émission très basses) à C (émission élevée).

●

HP PVC-free Wall Paper printed with HP Latex Inks is rated A+ according to Émissions dans l'air intérieur,
which provides a statement of the level of emission of volatile substances in indoor air posing health risks if
inhaled—on a scale from A+ (very low emission) to C (high emission).

* HP PVC-Free Wall Paper printed with HP Latex Inks is GREENGUARD Children & Schools Certified. See
http://www.greenguard.org/.
* HP PVC-Free Wall Paper printed with HP Latex Inks meets AgBB criteria for health-related evaluation of VOC
emissions of indoor building products. See http://www.umweltbundesamt.de/produkte-e/bauprodukte/
agbb.htm.
HP large-format substrate take-back program availability varies. Some recyclable HP substrates can be
recycled through commonly available recycling programs. Recycling programs may not exist in your area. See
http://www.hp.com/recycle/ for details.

Substrate tips
Maintain the substrates
Keep substrates in their sealed wrapping material while they are in storage, and store rolls vertically to avoid the
migration of plasticizers in some materials.
Move substrates from the storage area to the print production area at least 24 hours before use, so that they can
adapt to its temperature and humidity.
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General tips
Handle unprinted and printed substrates with care, and preferably with cotton gloves, to avoid fingerprints. For
heavy rolls, use a forklift, and two people wearing security shoes.
Before loading a roll:
●

Check that temperature and humidity in the room are within the recommended ranges for the printer. See
Environmental specifications on page 414.

●

Check that neither the roll nor its core are bent or deformed, which may cause the substrate to jam in the
printer.

●

If the roll has been stored in a place not offering the recommended environmental conditions, allow some
time for it to adapt to the temperature and humidity of the printer's environment.

●

Check which is the correct side for printing, by reading the label inside the core or the note inserted into the
package.

●

Check that the substrate is correctly attached to the input core. Otherwise, the Internal Print Server will
report an error.

●

Check the substrate thickness.
–

Up to 0.4 mm (0.016 in): Print normally.

–

0.4 to 2 mm (0.016 to 0.079 in): Raise the carriage beam to a custom position. Edge holders are not
needed and should not be used.

–

More than 2 mm (0.079 in): Not supported.

While loading a roll, ensure that the leading edge is parallel and straight across the output core, and attached
evenly (start taping the substrate to the core at the center, then move towards the edges).
Also ensure that the side edges of the input and output roll are properly aligned. An incorrectly loaded roll may
cause waves or cockles in the substrate, leading to ink smearing and printhead crashes.
After you have loaded a roll:
●

If you intend to use substrate edge holders, do not use edge holders from another printer, use only the
edge holders that came with your printer.

●

Check the correct carriage beam position for printing: customized position for thick substrates, printing
position for others. See Set the carriage beam position on page 123.

●

Check that you are using the correct substrate preset in the Internal Print Server and the correct ICC profile
and other settings in the RIP.

●

HP substrates are optimized to provide the best out-of-the-box printing experience with your printer.

●

Use the Internal Print Server to check that any calibrations appropriate for your substrate have been done:
printhead alignment, color calibration. See Printer calibration on page 172.

●

Do not cut off pieces of substrate while the substrate is loaded into the printer. This may cause the
remaining substrate to jam.

You can find further information on the Web:
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●

The specifications, finishing, processing, and warranty information for each individual HP substrate are
available from http://www.globalBMG.com/hp/signagemedia and http://www.globalBMG.com/hp/
HPMediaWarranties.

●

HP Image Permanence information is available from http://www.globalBMG.com/hp/printpermanence.

●

HP offers to recycle some substrates through the HP Take-Back Program, such as HP HDPE Reinforced
Banner, HP Light Textile Display Banner, HP Heavy Textile Banner, HP Everyday Matte Polypropylene, 3-in
Core, and HP DuPont Tyvek Banner. Recycling opportunities for these products may not exist in all areas.
You should consult local recycling resources about recycling these products. For recycling in the USA, see
the HP recycling services site, http://www.hp.com/go/recycleLFmedia/.
HP offers to recycle some other substrates through the standard paper recycling process, such as HP White
Satin Poster Paper, HP Photo-realistic Poster Paper, HP Coated Paper (3-in core), HP Universal Coated Paper
(3-in core), HP Universal Heavyweight Coated Paper (3-in core), HP Heavyweight Coated Paper (3-in core),
and HP Super Heavyweight Plus Matte Paper (3-in core).

Color consistency
Your printer has been designed to provide an excellent experience in terms of color consistency and repeatability.
This allows large jobs such as fleet graphics and wall coverings to be printed in tiles or panels, with confidence
that, when the finished panels are placed edge to edge, the colors will match at the joins.
The color variation within a printed job has been measured to be within this limit:
Maximum color difference (95% of colors) <= 2 dE 2000
NOTE: This is based on reflective measurements on a 943 color target under CIE standard illuminant D50, and
according to the standard CIEDE 2000 as per CIE Draft Standard DS 014-6/E:2012. 5% of colors may experience
variations above 2 dE 2000. Backlit substrates measured in transmission mode may yield different results.
Color matching is dependent on many external factors. Take the following points into account to achieve this
level of consistency:
●

If a large job is being printed in panels, more than one roll may be required. All rolls should be from the
same batch, and stored under correct conditions according to the manufacturer’s specifications.

●

Operating conditions (temperature and humidity) should be kept constant during the printing of the entire
job. See step 5 in Edit a substrate preset on page 110.

●

Ensure that a printhead check and clean routine has been run prior to starting the job. If any printhead
changes are required during the job, printhead alignment and color calibration should be done.

See also Color calibration on page 178.

Substrate configurations
The substrate can be loaded in a variety of different configurations to suit your different needs. Before loading,
you must go to the Internal Print Server and select Substrate load/unload, then select the configuration you
intend to use.
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The basic configurations are illustrated below. These configurations can be used for single-roll or dual-roll
printing.
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●

The roll-to-roll configuration is suitable when you do not intend to cut and take away some prints or the
output roll in the middle of a print job being done using a particular input roll. The substrate cannot be cut
in mid-roll, except during double-sided printing, and then it must be reloaded afterwards.

●

The roll-to-free-fall configuration is suitable when you want to cut and remove one or more prints as soon
as they come out of the printer. The substrate is kept under tension between the input roll and the tension
roller; but it can be cut after the tension roller because then it is no longer under tension.

●

The roll-to-collector configuration is suitable when you may want to cut the substrate and remove the
output roll before finishing the print job being done using a particular input roll. The substrate is kept under
tension between the input roll and the tension roller; but it can be cut after the tension roller because then
it is no longer under tension.
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Prepare to print
The following steps must be followed before the printer can print:
1.

Go to the Internal Print Server and select Substrate Load/Unload to open the Printer Configuration window.

2.

Select the printer configuration that you intend to use; the on-screen help will appear on the left.

NOTE: The Reload substrate check box should be checked only if the printer has just previously had the
same configuration (i.e. the same substrate, same profile), and because of a severe system error, you had
to restart the printer.
3.

Load the substrate. Substrate loading instructions are displayed in the Internal Print Server window. For
more detailed instructions, see Load a roll onto the spindle on page 59 and Load a roll into the printer
on page 65.

4.

Select the substrate type.

5.

Press the Finish button in the Internal Print Server to start the substrate check, then enter the substrate
type in the Loaded Substrate window.

TIP: If the printer has been idle overnight with substrate loaded, and exposed to high or low temperatures,
advance the substrate 13 to 25 cm (5 to 10 in) before printing, to avoid printhead crashes or ink smears on the
substrate.

The substrate edge holders
The purpose of the substrate edge holders is to prevent the substrate edges from lifting up and jamming while
printing. If you experience this kind of problem while printing, you can try using the edge holders to overcome it.
The edge holders are highly recommended when printing on textile substrates. When printing on porous
substrates, use the edge holders included in the ink collector kit (see The ink collector kit on page 48).
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NOTE: The edge holders are not recommended when printing on substrate that is more than 0.4 mm (0.016 in)
thick.
TIP: The edge holders may be easier to deploy if you raise the carriage beam (see Set the carriage beam
position on page 123); however, they can be deployed without raising the carriage beam.

Substrate edge holders for HP Latex 3000, 3100 and 3500
The correct position is illustrated below. The substrate should be free to move, and should not touch the ends of
the edge holder.

CAUTION:

Wrongly positioned edge holders could severely damage the printheads and carriage.

NOTE: If the substrate is loaded with the right edge outside the 161 cm position on the spindle ruler, or the left
edge outside the −162 cm position, the edge holders cannot be used because there is not enough space for
them.
NOTE: When printing with the Double-sided Day Night Kit, specific edge holders are also needed.

Install an edge holder on the HP Latex 3000, 3100 and 3500

To install an edge holder, stand at the front of the printer and attach the front of the edge holder (marked with
the number 1 on the blue part) to the front of the platen. Ensure that the substrate is aligned with the marks on
the edge holder.
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Then go to the rear of the printer, open the loading table, pull the rear of the edge holder towards you, and attach
it to the rear of the platen. A built-in magnet helps to position the edge holder correctly on the platen. Ensure
that the substrate is aligned with the marks on the edge holder.
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If the rear of the edge holder cannot be placed due to a ramp, slide the ramp away to provide space for the edge
holder. There are three ramps to help the substrate to load in assisted mode. The two ramps at the sides can
slide; the center one is fixed. The edge holder cannot be placed in that position.
CAUTION: Place the edge holder carefully. It should remain perfectly straight, otherwise it could damage the
printheads and carriage.
TIP: Once installed, an edge holder cannot be slid sideways. If you want to move it sideways, you must remove
it and reinstall it in the new position.

Replace an edge holder strip

Replacement edge holder strips come with the Cleaning Kit. Replace the strip if it is broken (for example, by an
impact) or deteriorated (for example, by accumulated ink).
1.

If it is installed in the printer, remove the edge holder from the platen, disengaging it from the back and
then from the front.

2.

Loosen but do not remove the screw at each end of the edge holder.

3.

Remove the old strip, insert the new one, and tighten the screws.

4.

Replace the edge holder on the platen, if you intend to use it.

Substrate edge holders for HP Latex 3200, 3600 and 3000/3100/3500 with Doublesided Day Night Kit
1.
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Standing in front of the printer, place the edge holder onto the far side of the platen and cover the edge of
the substrate with it.
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2.

Attach other side of the edge holder in the space between the platen and diverter wheels, cover the edge of
the substrate with it. Make sure that each edge holder is properly positioned and not bent as this could
cause a carriage crash.

3.

Turn the screw at the front part of the edge holder to fix it in place. If it interferes with the diverter wheels;
move the edge holder slightly until a better position is found.

4.

Ensure that the substrate is aligned with the edge holder.

CAUTION: Place the edge holder carefully. It should remain perfectly straight, otherwise it could damage the
printheads and carriage.
NOTE: If the edge holder interferes with a diverter wheel holder, move the edge holder slightly into a better
position.
TIP: Once installed, an edge holder cannot be slid sideways. If you want to move it sideways, you must remove
it and reinstall it in the new position.
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The ink collector kit
Before printing on porous substrates (textile mesh, flag, and voile), you must install the ink collector kit available
as an accessory, to protect the printer from the ink that falls through the substrate. The kit should be removed
before printing on non-porous substrates.
See Check the porosity of your substrate on page 36 if in doubt.
CAUTION: Ensure that the operating temperature of the substrate recommended by the manufacturer is not
exceeded. If this information is not available, ask the manufacturer. Do not load substrates that cannot be used
at an operating temperature above 125°C (257°F).
CAUTION: Proper maintenance and genuine HP consumables are required to ensure that the printer operates
safely as designed. The use of non-HP consumables (foams, filters, printhead cleaner roll, or inks) may present a
risk of fire.
CAUTION: Do not load substrates with auto-ignition temperatures below 250°C (482°F). Ensure that no ignition
sources are close to the substrate.
NOTE: Test method based on EN ISO 6942:2002: Evaluation of materials and material assemblies when
exposed to a source of radiant heat, method B. The test conditions, to determine the temperature when the
substrate starts ignition (either flame or glow) are: Heat flux density: 30 kW/m², copper calorimeter, K type
thermocouple.
IMPORTANT: Do not use the Ink Collector Kit when in-line slitters are installed, as the cutting position can
damage the protector of the Kit. It is recommended to uninstall the in-line slitters when working with the ink
collector.

The above image is a QR code containing a link to a video; see Documentation on page 2.
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Kit components

1.

Ink-collector container

2.

Six ink collectors with two replaceable foams

3.

Four ink-collector substrate-edge holders

4.

Protector

NOTE: Keep the ink-collector container and protector core to protect and store the ink-collector parts when not
in use.

Install the kit

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

TIP:

You are advised to wear gloves.

If any substrate is loaded, unload it. Then remove the edge holders from the substrate path.
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If necessary, clean the platen and the curing plates with a cloth dampened with an all-purpose cleaner.
Install the six ink-collector modules
1.

Ensure that the printer is not printing.

2.

Ensure that all windows, covers, and doors are closed and remain in their original position.

3.

Open the ink collector container and check that the ink collector foams are dry and clean enough to be
used.

4.

Go to the Internal Print Server and press the Install ink collector button in the main window.

5.

Follow the instructions in the Internal Print Server to complete the installation. If you need further
information, read the steps below.
CAUTION:
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If you install the kit incorrectly, some parts of the printer may be damaged.

6.

Ensure that the module latches are open (turned to the left).

7.

To facilitate module installation, we recommend raising the carriage beam to the installation position.

8.

Open the front door.

9.

From the front on the right side, install the first module (1) and insert it into the guide (2).
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10. Slide the module to the middle until it reaches the stop.

11. Insert all the ink collector modules on either side of the central one.

12. Attach each one that you insert to a module that is already in place.
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13. Go to the rear of the printer, lower the pinchwheel latches (1), and pull down the pinchwheel module to its
lowest position.

14. Close the latches of all modules (turn to the right).

15. Check that all the ink collector modules are aligned with each other and that there are no gaps between
them.

16. Check that the foams fit into the spaces provided for them. If they have expanded and no longer fit, replace
them.
NOTE: Ensure that you dispose of the used foams correctly. Consult the guidelines from your local
authority.
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17. Lift the pinchwheel module (1) and the pinchwheel latches (2).

Install the protector
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1.

Take the rolled protector and ensure that it is completely clean and dry.

2.

Place the rolled protector on the curing module. Do not open the curing module yet.

The ink collector kit
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3.

Slide or clip a barrier onto each end of the protector tab.

4.

Place the tab of the protector (1) onto the slot (2). The black side should be face up.
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5.

Open the curing module latches (1) and the curing module (2).

6.

Drop the protector through the gap under the curing module.

7.

Close the curing module and the latches.

8.

Hook the clips from the protector to the bottom part of the printer.

9.

Close the front door.
NOTE: If you plan to load substrates thicker than the value shown on the main screen, set the thickness
value appropriately.

10. Press Finish to complete the ink collector installation. The carriage beam adjusts to the ink collector height.

Uninstall the kit
TIP:

ENWW

You are advised to wear gloves.
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Unload the substrate (see Unload a roll on page 92) and remove the output spindle.
To facilitate module uninstallation, we recommend raising the carriage beam to the installation position, by
pressing the Raise carriage beam to install position button.
Uninstall the protector

56

1.

Go to the Internal Print Server and press Uninstall ink collector.

2.

Unhook the four clips from the bottom.

3.

Extract the protector tab from the slot.
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4.

Open the curing module latches and curing module and leave the protector to slide down softly.
WARNING! Do not touch the internal enclosures of the printer's curing module: they can be hot enough to
cause burns.

ENWW

5.

Remove the protector by the bottom part.

6.

Remove the barriers, one on each side.

7.

Check that nothing is dirty or broken. If dirty, clean with a lint-free cloth moistened with distilled water.

8.

Roll up with the red side on the bottom and the black part on the top. Start rolling up on the side of the
clips.

The ink collector kit
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9.

Place the protector in the packaging, and store it.

Uninstall the six ink-collector modules
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1.

Close the curing module and latches.

2.

From the rear of the printer, open the three latches of each module.

3.

From the front of the printer, remove each module. First, slowly lift the back part of the ink collector
module, then, take out the guide from the platen, moving the ink collector module forward towards the
front of the printer.

4.

Press Finish to complete the removal process. The carriage beam moves down and the carriage moves
along the platen for checking.

5.

Check whether the foams need to be replaced; if so, replace them. Store them in the ink collector container,
keeping the latches on top. You can also store the barriers and edge holders there.

6.

Perform the maintenance operations recommended after uninstalling the kit: see Additional maintenance
operations for porous substrates on page 201.
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Load a roll onto the spindle
NOTE:

Contact HP to know the recommended third party solutions for substrate lifter and core adaptors.

Single-roll printing
The spindle has a pneumatic connector at one end and a gear at the other.
1.

Check that the gear is on the correct side.

2.

Insert the spindle into the roll taking into consideration the winding direction.
TIP: The spindle is quite heavy in order to ensure stiffness and so avoid skew and wrinkles, so two people
are recommended for this operation.
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3.

Note the position of the end of the roll on the scale marked on both sides from the center of the spindle.
The input and output rolls should be positioned identically on their respective spindles.

TIP:

4.

The rolls should be centered to reduce the risk of skew, wrinkles, and telescoping.

Connect the air gun to the pneumatic connector on the spindle, and inflate the spindle so that it cannot
move inside the roll.
TIP:

Before inflating, use the pneumatic gun to blow air around the valve area to remove any dirt.

WARNING! The air gun provided with the printer is only intended to inflate the spindle. When
recommended to use for cleaning purposes, make sure to do so according to local regulations since
additional safety provisions may apply.
TIP: If the substrate is telescoped on the input roll, there is a risk of substrate jams and damage to the
printheads. Try to straighten the edges of the substrate to minimize telescoping on the input roll before loading
it into the printer.
TIP:

Check that the substrate is attached to the input core.

The roll is now ready to be loaded into the printer.
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TIP: If you are a regular user of different substrate types, you can change rolls more quickly if you preload rolls
of different substrate types on different spindles. Extra spindles are available for purchase.

HP Latex 3000/3100/3200 dual roll

If your printer is an HP Latex 3000/3100/3200, you can print on two rolls at the same time by using the dual-roll
spindle.
Loading the dual-roll spindle
1.

Insert the first roll on the spindle.

2.

Insert the second roll on the spindle.

3.

Center both rolls, using the marks on both sides of the center of the spindle. The input and output rolls
should be positioned identically on their respective parts of the spindle.

4.

Inflate the valves at both ends.
TIP:
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Before inflating, use the pneumatic gun to blow air around the valve area to remove any dirt.
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WARNING! The air gun provided with the printer is only intended to inflate the spindle. When
recommended to use for cleaning purposes, make sure to do so according to local regulations since
additional safety provisions may apply.
5.

Place the spindle with the roll in the substrate input.

6.

Place the dual-roll spindle on the printer with the long lever up.
TIP: The spindle and two rolls of substrate are heavy. You are recommended to use a forklift to move it
into position.

7.

Position the dual-roll center support under the center of the dual-roll spindle.

8.

Pull the long lever down.
When engaging the support, make sure that the position of the support bearings corresponds to the
grooves of the differential cover and that the two sets of bearings are approximately the same distance
from the middle of the spindle to maximize their contact.

9.

Repeat the procedure for the output dual-roll spindle.

10. You can now feed the substrates into the printer.
11. Once the substrate is aligned, automatic substrate-edge detection can be run. If this automatic process
fails, or if you are using a roll width not within the dual-roll spindle specifications shown below, introduce
the substrate edge values manually. Physically measure the position of the substrate edges on the dualroll spindle ruler. The dual-roll spindle ruler, in inches and centimeters, uses positive (+) signs on one side
and negative (−) signs on the other side.
Latex 3000/3100/3200 dual-roll spindle specifications
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Minimum roll width

635 mm (25 in)

Maximum roll width

2 × 1.60 m (2 × 63 in)
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Latex 3000/3100/3200 dual-roll spindle specifications
Minimum gap between rolls

40 mm (1.6 in)

Maximum roll diameter

300 mm (11.8 in)

Maximum total weight of both rolls

2 × 70 kg (2 × 154 lb)

If this is the first time you use the dual roll, it has to be installed and calibrated. See the Installation Guide for
more information.

HP Latex 3500/3600 dual-roll split spindles center support

Risk of trapped fingers

If your printer is an HP Latex 3500/3600, you can print on two rolls at the same time by using the dual-roll split
spindle. See the Installation Guide to check the installation of the center support split spindle assembly.
IMPORTANT: Two dual roll center supports are provided. The higher one corresponds to the input side of the
printer and the other one to the output side. You have to follow the same process in order to install input and
output side central supports to the corresponding base.
To assemble the center support split spindles to its base, insert the center support foot on the base guides and
move it to the end by pushing the handle. Make sure that the base hook is fixed.

If you want to remove the center support, raise the blue lever with a hand, and firmly pull the center support to
remove it from its base.
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Loading the rolls on the split spindles

64

1.

Insert the first roll on one of the split spindles.

2.

Insert the second roll on the other split spindle.

3.

Load the split spindles in the printer.
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4.

Move the rolls to the center of the printer. Accurately position each roll following one of the spindle marks.
The input and output rolls should be positioned identically on their respective parts of the spindle.

5.

Inflate the valves at both ends by connecting the air gun to the pneumatic connectors.
TIP:

Before inflating, use the pneumatic gun to blow air around the valve area to remove any dirt.

WARNING! The air gun provided with the printer is only intended to inflate the spindle. When
recommended to use for cleaning purposes, make sure to do so according to local regulations since
additional safety provisions may apply.
Latex 3500/3600 dual-roll split spindles specifications
Minimum roll width

635 mm (25 in)

Maximum roll width

2 × 1.55 m (2 × 61 in)

Minimum gap between rolls

134 mm (5.3 in)

Maximum roll diameter

400 mm (15.75 in)

Maximum total weight of both rolls

2 × 200 kg (2 × 440 lb)

Load a roll into the printer
The objective when loading substrate is to get a uniform tension across its width and length to minimize the risk
of skew, wrinkles, and telescoping. There are four ways in which the substrate can pass through the printer:
●
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●

Dual roll-to-roll configuration

●

Roll-to-free-fall configuration

●

Roll-to-collector configuration

For each configuration, there are two ways of loading the substrate:
●

Manual loading: this is recommended for rigid and narrow substrates

●

Assisted loading: this can be used to make loading flexible or wide substrates easier
NOTE:

Assisted loading is not recommended with dual rolls.

If your printer is an HP Latex 3500/3600, you have a diverter in the input side of the printer to help to
homogenize the tension of the paper. We strongly recommend to print with it installed. Check the
Installation Guide in case you need to uninstall it.
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Load a roll (roll-to-roll configuration)

HP Latex 3000/3100/3200 and HP Latex 3500/3600 have different dual roll options. For HP Latex
3000/3100/3200 you can use a spindle with two rolls, but for HP Latex 3500/3600, a split spindle system can
be used. See HP Latex 3500/3600 dual-roll split spindles center support on page 63/3600 for more information.

The substrate roll is mounted on the input spindle (single or dual) and will be collected on the output spindle. The
substrate goes from the input spindle (1) over the main roller (2), over the platen (3), over the front diverters (4)
and then to the output spindle (5).
If your printer is an HP Latex 3500/3600, between the input spindle and the main roller, you have to make use of
the diverter.

The above illustration shows the substrate loaded with the printed face outwards on both input and output rolls.
You can also load substrate with the printed face inwards on either or both rolls, in which case the spindle will
turn in the opposite direction. The printer asks you for the winding direction if it cannot detect it automatically.

Each of the spindles has its own motor. The motors maintain tension on the substrate. Some vacuum is applied
at the level of the platen to keep the substrate flat. The substrate is moved forwards by the drive roller motor, on
which there is a pinch mechanism to prevent the substrate from slipping.
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Before loading a roll into the printer, you must have a roll loaded onto a spindle (the input roll) and an empty core
loaded onto another spindle (the output roll). See Load a roll onto the spindle on page 59.
NOTE: For the output roll, use a single empty core the same length as the input core. Do not place two or more
shorter cores on the same spindle, which could cause substrate-advance problems.
TIP: The spindle and a roll of substrate can be heavy. You are recommended to use a forklift or some other
equipment to move it into position; otherwise, lift one end into the printer, and then the other end.
1.

Go to the Internal Print Server and select Substrate Load/Unload, then select the correct configuration.

2.

In the Internal Print Server, choose from the list of substrate types the type that you have loaded.

3.

If they are installed, remove the substrate edge holders from the print platen so that they do not get in the
way while loading the substrate.
CAUTION:
carriage.

Loading the substrate on top of the edge holders could severely damage the printheads and

4.

Bring the new roll on its spindle to the rear of the printer, with the geared end of the spindle on the left.

5.

Rest the ends of the spindle on the platforms provided at the rear of the printer; plastic pads are provided
to absorb the impacts.

6.

In the same way, load the spindle with the empty core into the front of the printer. In this case, the geared
end of the spindle should be on the right.

7.

All substrates can be loaded with the manual loading procedure (below). However, you may find it easier to
use the assisted loading procedure if your substrate is flexible or wide.

Assisted loading
1.
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Open the front door.
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2.

Open the curing module latches.

3.

Open the curing module.
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4.

Open the loading table latches.

5.

Open the loading table.

6.

Unwind a length of substrate.
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7.

Place it on the loading table.
If your printer is an HP Latex 3500/3600, you have to load the paper making sure it is loaded behind the
diverter.
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8.

Close the loading table.

9.

Rewind the substrate manually until the leading edge is close to the pinchwheels.

Load a roll into the printer
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10. Close the loading table latches.

11. Go to the Internal Print Server and use the large blue button to advance the substrate until it reaches the
output spindle. Ensure that the substrate advances smoothly and is not trapped by any obstruction. If
necessary, help the substrate to advance and to pass through the curing module slot.

12. Open the loading table.
13. Align the substrate by checking that the substrate edge is in the same position on the input and output
spindles. This can be done by using the rulers on the spindles or by measuring the distance between the
right edge and the side plate.
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14. When the substrate is evenly tensioned and flat (no wrinkles or bumps), attach it to the empty core with
adhesive tape. Tape it first in the center, and then at the left and right sides, making sure not to pull the
substrate excessively or leave it wrinkled.

15. If you are using them, place the substrate edge holders into position and attach them at the front.
16. Close the curing module and latches, then the front door.
17. If you are using them, attach the substrate edge holders at the rear.
18. Close the loading table and latches.
19. Go to the Internal Print Server and press the Finish button. The printer rotates both rolls to check their
diameters, and it also checks the width of the roll, the winding direction, the vacuum, and the substrate
advance calibration (this takes about a minute).
NOTE:

The roll size appears at the bottom of the screen; to change it, click Change substrate settings.

NOTE: Some substrates (such as transparent substrates) cannot be measured by the printer in this way.
In such cases, you will be asked to enter the Left Edge and Width fields yourself into the Internal Print
Server. Use the ruler on the spindle to check these values.
20. An alert about substrate-advance tracking may appear at this point. For more information on when you
might want to turn off automatic tracking, see Substrate-advance compensation on page 181.
21. For more information on when you might want to change the carriage beam position, see Substrate tips
on page 39.
Manual loading
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1.

Use the Internal Print Server to raise the carriage beam to its loading position.

2.

Open the front door.
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3.

Open the curing module latches.

4.

Open the curing module.
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5.

Open the loading table latches.

6.

Open the loading table.
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7.

Unwind a length of substrate.
If your printer is an HP Latex 3500/3600, you have to load the paper making sure it is loaded behind the
diverter.

8.

Place it in the print zone.

9.

Push the substrate through the printer until it reaches the output spindle.

10. Align the substrate by checking that the substrate edge is in the same position on the input and output
spindles. This can be done by using the rulers on the spindles or by measuring the distance between the
right edge and the side plate.
11. When the substrate is evenly tensioned and flat (no wrinkles or bumps), attach it to the empty core with
adhesive tape. Tape it first in the center, and then at the left and right sides, making sure not to pull the
substrate excessively or leave it wrinkled.

12. If you are using them, place the substrate edge holders into position and attach them at the front.
13. Close the front door and the curing module.
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14. If you are using them, attach the substrate edge holders at the rear.
15. Close the loading table.
16. Use the Internal Print Server to lower the carriage beam to its printing position.
17. Go to the Internal Print Server and press the Finish button. The printer rotates both rolls to check their
diameters, and it also checks the width of the roll, the winding direction, the vacuum, and the substrate
advance calibration (this takes about a minute).
NOTE: Some substrates (such as transparent substrates) cannot be measured by the printer in this way.
In such cases, you will be asked to enter the Left Edge and Width fields yourself into the Internal Print
Server. Use the ruler on the spindle to check these values.
18. An alert about substrate-advance tracking may appear at this point. For more information on when you
might want to turn off automatic tracking, see Substrate-advance compensation on page 181.
The printer is now ready to print.

Load a roll (dual roll-to-roll configuration)

HP Latex 3000/3100/3200 and HP Latex 3500/3600 have different dual roll options. For the HP Latex
3000/3100/3200 you can use a spindle with two rolls, but for HP Latex 3500/3600, a split spindle system can
be used. See HP Latex 3500/3600 dual-roll split spindles center support on page 63 more information.

The two substrate rolls are mounted on the rear dual-roll spindle and will be collected on the front dual-roll
spindle. The substrate goes from the input spindle over the main roller, over the platen, over the front diverters
and then to the output spindle.
NOTE:
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When using dual rolls, you are recommended to use the roll-to-roll configuration for best performance.
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You can load substrate with the printed face inwards or outwards on the spindle, in which case the spindle will
turn in the opposite direction. The printer asks you for the winding direction if it cannot detect it automatically.

Before loading two rolls into the printer, you must have both rolls loaded on the rear dual-roll spindle and two
empty cores loaded on the front dual-roll spindle. See Load a roll onto the spindle on page 59.
If the rolls are of unequal lengths, the longer roll should be on the right as seen from the front of the printer; on
the left as seen from the rear. That way, when the shorter rolls runs out, you can continue printing on the other
roll.

NOTE: When one roll runs out, you should lock the differential in the middle of the spindle, using the lever on
the left-hand side.
HP Latex 3500/3600 only: In order to use the Dual Roll, it must be installed first.
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1.

Go to the Internal Print Server and select Substrate Load/Unload, then select the correct configuration.

2.

In the Internal Print Server, choose from the list of substrate types the type that you have loaded.

3.

If they are installed, remove the substrate edge holders from the print platen so that they do not get in the
way while loading the substrate.
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CAUTION:
carriage.

Loading the substrate on top of the edge holders could severely damage the printheads and

4.

You may find it helpful to lock the differentials on the input and output spindles while loading.

5.

Rest the ends of the spindle on the platforms provided at the rear of the printer; plastic pads are provided
to absorb the impacts.

6.

In the same way, load the spindle with the empty cores into the front of the printer. In this case, the geared
end of the spindle should be on the right.

7.

HP Latex 3000/3100/3200 with a single spindle only: If you intend to use the Dual Roll Center Supports,
install them now, for both input and output spindles, and move them up to their calibrated positions to
ensure that the substrate is later brought to the output spindle and properly wound. See Loading the dualroll spindle on page 61 for more information.
CAUTION: The calibrated position should be set following the instructions provided with the accessory
(see Calibrate the dual-roll center support on page 370). An incorrect position could cause the carriage to
crash (see There are wrinkles and ink smears on the substrate on page 363).

Manual loading
NOTE:
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Assisted loading is not recommended in a dual-roll configuration.

1.

Use the Internal Print Server to raise the carriage beam to its loading position.

2.

Open the front door and the curing module.

3.

Open the loading table.

4.

Unlock the differential in the input spindle.

5.

Unwind a length of substrate from the first input roll and place it in the print zone.

6.

HP Latex 3500/3600 only: take care with the diverter when loading the substrate.

7.

Push the substrate from the first roll through the printer until it reaches the output spindle.

8.

Unwind a length of substrate from the second input roll and place it in the print zone.

9.

Push the substrate from the second roll through the printer until it reaches the output spindle.

Load a roll into the printer
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10. Align the substrate by checking that the substrate edge is in the same position on the input and output
spindles. This can be done by using the rulers on the spindles or by measuring the distance between the
right edge and the side plate.
NOTE: You are recommended to align the edges of both rolls by the lines on both sides of the spindle’s
center mark.

NOTE:
ruler).

The substrate-advance sensor must be covered by the substrate (from 252 to 310 cm on the

11. When the substrate is evenly tensioned and flat (no wrinkles or bumps), attach it to each empty core with
adhesive tape. Tape it first in the center, and then at the left and right sides, making sure not to pull the
substrate excessively or leave it wrinkled.
12. If you are using them, place the three or four substrate edge holders into position and attach them at the
front.
TIP: HP Latex 3000/3100/3200 only: When aligning the roll edges with the marks on the dual-roll
spindle, the center edge holder (if needed) is shared by both rolls. If you position the rolls differently, and
you are using edge holders, take into account the distance required for the edge holders.

13. Close the front door and the curing module.
14. If you are using them, attach the substrate edge holders at the rear.
15. Close the loading table.
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16. Ensure that the spindle differentials are unlocked.

17. Use the Internal Print Server to lower the carriage beam to its printing position.
18. Go to the Internal Print Server and press the Finish button. The printer rotates the rolls to check their
diameters, and it also checks the width of the roll, the winding direction, the vacuum, and the substrate
advance calibration (this takes about a minute).
NOTE: Some substrates (such as transparent substrates) cannot be measured by the printer in this way.
In such cases, you will be asked to enter the Left Edge and Width fields yourself into the Internal Print
Server. Use the ruler on the spindle to check these values.
19. An alert about substrate-advance tracking may appear at this point. For more information on when you
might want to turn off automatic tracking, see Substrate-advance compensation on page 181.
20. For more information on when you might want to change the carriage beam position, see Substrate tips
on page 39.
The printer is now ready to print.

Load a roll (roll-to-free-fall configuration)

The substrate roll is mounted on the input spindle; the printed substrate will be deposited on the floor in front of
the printer. The substrate goes from the input spindle (1) over the main roller (3), over the platen, over the front
diverters (5) and then to the tension roller (7), after which it continues to the floor.
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You can load substrate with the printed face inwards or outwards on the spindle, in which case the spindle will
turn in the opposite direction. The printer asks you for the winding direction if it cannot detect it automatically.

Before loading a roll into the printer, you must have a roll loaded onto the input spindle. See Load a roll onto the
spindle on page 59.
TIP: The spindle by itself is quite heavy, and a roll of substrate can be much heavier. You are recommended to
use a forklift or some other equipment to move it into position; otherwise, lift one end into the printer, and then
the other end.
To load the substrate, follow the same procedure as in the roll-to-roll configuration, except that the output
spindle is not needed.
1.
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Ensure that the tension roller lever is raised.
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2.

Unlatch the tension roller at both ends.

3.

Move the roller to the front, so that you have more space to pass the substrate behind the roller.

4.

Pass the substrate through and push the roller backwards, taking care not to trap your fingers between the
roller and the black substrate guide lying underneath and behind.

5.

Close the latches at both sides.

6.

Align the substrate by checking that the substrate edge is in the same position on the input spindle and
tension roller. This can be done by using the rulers on the spindle and tension roller or by measuring the
distance between the right edge and the side plate.

7.

Ensure that the substrate is evenly tensioned and flat (no wrinkles or bumps), and close the tension roller
lever.

8.

Go to the Internal Print Server and press the Finish button as in the roll-to-roll configuration.

Load a roll into the printer
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Load a roll (roll-to-collector configuration)

This configuration is similar to the roll-to-free-fall configuration, but with the addition of a collector roller and
loop shaper.

TIP:

Do not try to load or unload the collector while printing.

Before starting to load the substrate, select a loop shaper of the correct length to match the substrate width. The
following tubes are supplied so that you can make up loop shapers of many different lengths.
●

One 152-mm (6-in) tube

●

Two 203-mm (8-in) tubes

●

One 305-mm (12-in) tube

●

One 610-mm (24-in) tube

●

Two 1067-mm (42-in) tubes

●

Two end flanges, to be placed at each end to avoid lateral displacement of the loop shaper during printing

For example, you can make up the following loop shapers.
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●

914 mm (36 in): 610-mm (24-in) and 305-mm (12-in) tubes

●

1016 mm (40 in): 610-mm (24-in) and two 203-mm (8-in) tubes

●

1270 mm (50 in): 1067-mm (42-in) and 203-mm (8-in) tubes

●

1372 mm (54 in): 1067-mm (42-in) and 305-mm (12-in) tubes
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●

1524 mm (60 in): 1067-mm (42-in), 305-mm (12-in) and 152-mm (6-in) tubes

●

1829 mm (72 in): 1067-mm (42-in), 610-mm (24-in) and 152-mm (6-in) tubes

●

1981 mm (78 in): 1067-mm (42-in), 610-mm (24-in) and two 152-mm (6-in) tubes

●

2032 mm (80 in): 1067-mm (42-in), 610-mm (24-in), 203-mm (8-in) and 152-mm (6-in) tubes

●

2489 mm (98 in): two 1067-mm (42-in), 203-mm (8-in) and 152-mm (6-in) tubes

●

2642 mm (104 in): two 1067-mm (42-in), 305-mm (12-in) and 203-mm (8-in) tubes

●

3200 mm (126 in): two 1067-mm (42-in), 610-mm (24-in), 305-mm (12-in) and 152-mm (6-in) tubes

1.

Follow the whole loading procedure for the roll-to-free-fall configuration.

2.

Load an empty substrate core onto the output spindle. For dual-roll printing, load two cores of the same
diameter onto a single spindle (it is not recommended to use a dual-roll spindle as the collector).

3.

Use the buttons in the Internal Print Server to advance the substrate's leading edge until it reaches the core
on the collector.

4.

Tighten the substrate so that it is evenly tensioned, then attach the leading edge to the core with tape, first
at the center and then at the sides. There should be no wrinkles or slackness across the substrate.

5.

Use the buttons in the Internal Print Server again to advance the substrate so that a substrate loop is
produced between the tension roller and the collector.

6.

Place the loop shaper into the substrate loop.

NOTE: Loop detection is done in the center of the printer; so avoid putting your foot or any other object
under the collector in the center.
7.

Go to the Internal Print Server and press the Enable collector button.

8.

Select the winding direction: Outwards is recommended, as it permits an output roll up to 300 mm (11.81
in) in diameter. If you select Inwards, the diameter of the output roll is limited to 200 mm (7.87 in): with a
fatter roll, the loop shaper would start to touch the roll.
NOTE: The winding direction cannot be changed on the fly: the collector has to be deactivated and
reactivated.

9.

Press the Finish button.

The printer is now ready to print.

Skew check option
This option is selected via the Printer Configuration window during substrate load in all previous configurations.
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Skew check option
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This option does not indicate whether the substrate is properly loaded or not, but it does provide the amount of
lateral movement during the load. You can set a threshold for each substrate type.

Additional notes
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●

When this option is selected, while loading, the printer moves the substrate backwards and forwards
several times in order to measure the skew at different points.

●

During this phase Calibrating advance appears.
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●

When finished, the substrate loads, and a window appears with the skew test result.

Double-sided printing

Selecting the double-sided printing option will provide you with guidance and help specific to double-sided
printing during the load process.
The roll-to-roll configuration is recommended for double-sided printing. You cannot perform double-sided
printing if the dual-roll spindle or the ink collector kit is in use.
Double sided printing is designed for single jobs with multiple copies, it does not work properly with multiple
jobs.
A double-sided job must be defined as a pair of images.
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●

Side A is the first image to be printed.

●

Side B is the second image to be printed, on the reverse of Side A.

Double-sided printing
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On Side A, after each row of images a black continuous line called a “registration line” is automatically printed: (a)
and (b) below. These registration lines are used while printing Side B to minimize any registration errors in the
direction of substrate movement.
When the whole of Side A has been printed, a space (c) is normally left blank for calibrations (the substrate is
already warmed up), and a further space (d) is left blank so that the substrate can be loaded for printing Side B.
However, these blank spaces are optional: you can turn them off.

Side A: Load and print
1.

Load the roll-to-roll configuration: see Load a roll (roll-to-roll configuration) on page 67.
NOTE:

Neither the dual-roll spindle nor the ink collector kit can be used while printing double-sided jobs.

2.

Define side A preferences (see Double-sided on page 135) and select the Print button.

3.

Before unloading the substrate, select the Substrate load/unload button in the IPS, select How to unload
side A, and follow the on-screen instructions.

NOTE: Jobs must be defined for double-sided printing, side A and side B, this information is available
while a job is printing in Print Properties.
NOTE: Selecting the check boxes Side B: loading space and Side B: Calibration space is highly
recommended, see Define double-sided job on page 135.
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Side A: Unload
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1.

Cut the substrate close to the input roll.

2.

Collect the substrate onto the output spindle. Check the substrate is collecting correctly on to the spindle to
avoid telescoping.

3.

Remove the input spindle.

4.

Remove the output spindle (1), carry it around to the input side with the same orientation (2) and install it
into the input position (3). Maintain the same orientation: Left edge always on the left, as indicated below
with the colors blue and red.

5.

When completed, click Done in the IPS window to confirm.

Double-sided printing
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Side B: Load and print
1.

Load roll-to-roll configuration: see Load a roll (roll-to-roll configuration) on page 67.
NOTE: By default the left edge of the substrate is detected to minimize registration errors along the scan
axis when printing double-sided. When printing on translucent substrates or types of substrate with
irregular edges you can disable this option by clicking Substrate Edge Detection.

2.
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Align the registration line with the beginning of the platen.
●

If Side B: Calibration space was selected, align the dotted line.

●

Align the registration line (continuous line).
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NOTE: To help make the alignment we recommend making a mark with a pen or pencil at the registration
line (1), but on Side B (2). Do not make a mark by cutting with scissors as this can cause the substrate to
come into contact with the printheads.
3.

Define Side B (see Double-sided on page 135) and press the Print button.
NOTE:

Before pressing Print, ensure that the correct side is selected.

The printer will automatically detect the registration line and the Side B image will be positioned to
minimize registration errors. This detection occurs automatically after each row detected and an
adjustment is made accordingly.
4.

Unload the roll.

Print a double-sided job with dual-roll
You can also print side A of a double-sided job with dual rolls. To print side B, each roll has to be printed one at a
time.
IMPORTANT: Rolls that weigh more than 200 kg (441 lb) on narrow rolls less than 178 cm (70 in) can cause
dangerous spindle bow that can in turn lead to spindle deformation. See Substrate sizes on page 411 for
information on appropriate dimensions of substrate rolls.
1.

When you have printed all jobs on side A, make a small mark on the registration line so that it can be
aligned later with the platen.
NOTE:
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When loading side A, check the Dual roll and Load side A boxes.

Double-sided printing

91

2.

Cut the substrate on the output side, near the spindle.
NOTE: Before unloading the substrate, select the Substrate load/unload button in the IPS, select Unload
side A (opaque substrate).

3.

Put one of the two already-printed rolls onto a single spindle and place it in the input position. It is
important that substrate orientation remains the same.

4.

Once side B is on the first roll, put the second roll onto the single spindle and print side B. Again, it is
important that substrate orientation remains the same.

View information about the loaded substrate
Information about the loaded substrate is displayed at the bottom of the main screen of the Internal Print Server.
To see more information, select the Substrate menu and then Settings.

Unload a roll
NOTE: Contact HP to know the recommended third party solutions for substrate lifter and core adaptors.
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1.

Check that the printing is not printing.

2.

Go to the Internal Print Server and select Substrate Load/Unload.

3.

Lift the loading table latches at the rear of the printer.

4.

If you need to raise the carriage beam, go to the Internal Print Server and select Carriage beam position >
Move to substrate load position. The printer raises the carriage. This process takes about 2 minutes to
complete.
TIP:

5.

This step is optional. It may be feasible to unload some substrates without raising the carriage beam.

When the carriage has been raised, cut the substrate
For porous substrates only, when the ink collector kit (see The ink collector kit on page 48) is in use:
a.

Cut the substrate at the front.

b.

Go to the rear of the printer and pull the substrate over the loading table.

c.

Cut the substrate again.

6.

Wind the substrate manually onto the output roll.

7.

Open the two latches at each side of the spindles.
IMPORTANT:
lever.

HP Latex 3500/3600 only: Be sure the latches are open before manipulating the roll ejector

8.

HP Latex 3500/3600 only: Press the roll ejector lever at both sides to unload the paper.

9.

Remove the output roll from the printer.

10. Press the valve to deflate the spindle, and remove it from the roll.
IMPORTANT: When you press the spindle valve, make sure nobody else is touching the spindle/roll to
minimize the risk of trapping a finger between any spindle component and the roll.

11. Rewind the substrate manually onto the input roll.
12. Open the two latches at each side of the spindles.
IMPORTANT:
lever.

HP Latex 3500/3600 only: Be sure the latches are open before manipulating the roll ejector

13. HP Latex 3500/3600 only: Press the roll ejector lever at both sides to unload the paper.
14. Remove the input roll from the printer.
15. Press the valve to deflate the spindle, and remove it from the roll.
IMPORTANT: When you press the spindle valve, make sure nobody else is touching the spindle/roll to
minimize the risk of trapping a finger between any spindle component and the roll.

The printer is now ready for new input and output rolls to be loaded.
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Unload a roll
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If you need more information about how to load/unload a roll, see Loading the dual-roll spindle on page 61 for
dual-roll, and Loading the rolls on the split spindles on page 64 for dual roll split spindles.

HP Latex Double-sided Day and Night Kit
The HP Latex Double-sided Day and Night Kit is an accessory that allows to easily print on translucent substrate
double-sided prints for outdoor advertising with better color appearance in any light—frontlit during the day or
backlit at night.

NOTE: This video applies to HP Latex 1500 and HP Latex 3000 Series Printers.

Substrate saver
IMPORTANT: To use Substrate saver kit with HP Latex 3100 and 3500, an upgrade kit is needed
(1HA07-67014), contact HP Support.

NOTE: This video applies to HP Latex 1500 and HP Latex 3000 Series Printers.
IMPORTANT: Before using the substrate saver; make sure the substrate is loaded, reaches the print zone, and
that the loading table is closed.
NOTE: The standard model provided with the product supports substrates from 48 to 63 inches (1220mm to
1600mm)width. For smaller substrate widths, special solutions are available. Contact HP Support.
1.
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Place the substrate saver on the curing module (hold it with a single magnet in the center), and make sure it
is fixed; use the 3 magnets under the accessory.
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IMPORTANT: If your printer is an HP Latex 3000, 3100 or 3500, make sure you place the substrate saver
on the installed metallic parts.
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2.

Use the curing top plate tool and the marks to ensure that the substrate is centered (no ruler, marks on the
metallic part).

3.

Open the substrate saver flaps.

Substrate saver
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4.

Advance the substrate manually or automatically but do not surpass the red line inside the flaps. Make sure
to advance enough paper to reach the substrate saver.

5.

Grip the substrate with the substrate saver. Make sure there are no wrinkles in the substrate or the tool
flaps.

6.

Open the curing module.
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7.

Push the substrate saver through the curing module.

8.

Go to the Internal Print Server to start the loading process. Use the move the substrate buttons manually or
in the IPS to move the substrate backwards to detach the substrate saver magnets from the curing module
and up to the platen.
IMPORTANT:

9.

To avoid damage; do not let the substrate saver reach the loading table.

Rewind the substrate saver in order to position the lower side of the tool next to the core.

10. Turn the input spindle to tighten the substrate on the roll and avoid any sag.
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11. Open the loading table.

12. Pull the edge of the tool and center it on the core.

13. Attach the tool to the core with tape. Make sure to put the tape on the blue edge of the substrate saver.

14. Roll the tool on the core until the tool's upper edge lies beyond the platen.
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15. Close the loading table and finish the loading process in the IPS.

NOTE: When processing a finished roll, see if the tool is inside by locating the blue edge of the saver on
the core. If necessary, make use of the substrate-saver edge holders.

In-line slitters

WARNING!

Do not touch the in-line slitters when printing.

WARNING!

Handle in-line slitters with care and store them safely.

WARNING! Risk of cutting your fingers! Uninstall the in-line slitters when manipulating the curing module or
accessing the substrate path.

Risk of cutting your fingers.

Risk of trapped fingers

Risk of burns

For more safety information, see Safety precautions on page 2

If you have an HP Latex 3500/3600 you can install the in-line slitters provided with your printer.

ENWW

In-line slitters

99

In-line slitters are an optional accessory for the HP Latex 3100/3200 printer.
NOTE: Two in-line slitters co-exist, and the in-line slitters accesory can be slightly different from the one on the
following images.
CAUTION: Do not use the Ink Collector Kit when in-line slitters are installed, as the cutting position can damage
the protector of the Kit. It is recommended to uninstall the in-line slitters when working with the ink collector.
IMPORTANT: The in-line slitters can be used with a wide range of papers, but a successful cut with canvas,
fabrics, and some banners is not guaranteed.
NOTE: The in-line slitters cannot be used when the ink collector is installed.
In-line slitters are vertical cutters that allow you to cut the substrate in the direction of the substrate advance,
and they have to be installed, one by one, on the universal mounting beam; the position on it is decided and fixed
by the user. They can be used all at the same time or individually, depending on your necessities.

IMPORTANT: The in-line slitters can be installed onto the mounting beam when needed, but have to be placed
on the cutting position once the substrate is already loaded.
To install the in-line slitters on the mounting beam the hooks have to be inserted into the mounting beam
guides. To move the hooks, untighten the top blue labeled thumb screw and pull it to help the hooks fit into the
mounting beam guides.
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Once the vertical cutter is placed onto the mounting beam, slide it to the desired position. Untighten the lateral
thumb screw to be able to move the slitter without interfering with the substrate in case it is loaded.

Once installed, check the slitter can run through all of the universal mounting beam.
Once the slitter is in the desired position, tighten the top blue labeled screw to fix it.
To proceed with the cut, push the slitter until you cut the paper, then fix the position by tightening the lateral
screws.
WARNING! With in-line slitters installed, special care must be taken when handling heavy substrates and when
manipulating the curing module.
To uninstall the in-line slitters, reverse the process described above.
We recommend always storing the in-line slitters in the box provided if you don't wish to use them.
See how to rotate the blades when necessary or how to replace them in Slitter poor cutting quality on page 376.

LED proofing lights

Risk of burns
For more safety information, see Safety precautions on page 2

If your Printer is an HP Latex 3100/3200/3500/3600, you have a set of LED lights at the output side of the
Printer.
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The set of lights allows the visual inspection of the image printed on-press. It is comprised for 2 lights:
●

Front light: Mounted underneath the New Universal Mounting Beam (UMB), illuminating the print output for
frontal visual assessment.

●

Back light: Two strips of LED illuminating from the rear of the substrate output, providing an on-printer light
source for visually assessing backlit prints; no need to stop the printer to view in a light box.

The LED proofing lights can easily be managed and switched on and off from the IPS.
IMPORTANT:

After 3 minutes of being on, the LED proofing lights will automatically switch off.

CAUTION: LED proofing lights can reach high temperatures, take caution when approaching and working close
to LED strips.
CAUTION:

You are recommended not to look directly at the LEDs while they are on.

Substrate presets
Each supported substrate type has its own characteristics. For optimum print quality, the printer changes the
way it prints on each different substrate type. For example, some may need more ink and some may require
higher temperatures for drying and curing. So the printer must be given a description of the requirements of
each substrate type. This description is called a substrate preset. The printer is supplied with substrate presets
for some specific substrate types, and also with presets for some generic types.
As it is inconvenient to scroll through a list of all substrate types available, your printer contains substrate
presets for only the most commonly used substrate types.
You can check substrate availability from the Online substrate manager on page 117.
To install a new substrate preset without .oms, go to the Internal Print Server and select Substrate > Search
substrate online, then search for your specific substrate file and click the Down arrow of the Status column.
To install a new substrate preset that you have downloaded, go to the Internal Print Server and select Substrate
> Presets management > Import label, then search for your .oms file and click Update. You can also export
substrate presets using Export label.
NOTE: The maximum number of substrate presets supported by the printer is 126.

Export multiple presets
Multiple substrate presets can be exported together in a single .oms substrate file.
How to export multiple substrate presets
1.

Via the IPS, select Substrate > Preset management.
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2.

Go to the Export tab, select all the substrates to export, and click Export.

NOTE:
3.

This functionality allows up to 120 substrate presets to be exported at once.

A window pops up asking to save the generated .oms file. Click Save to continue.

How to import the generated .oms file
1.

Via the IPS, select Substrate > Preset management > Import.

2.

Browse to select the .oms file (in this case ‘1_paperpresets.oms’) and click Update.

3.

When the .oms file has been imported, the following information is displayed:

Use a new substrate
Whenever you load a new substrate type into your printer, you must choose a substrate preset for it.

ENWW

Use a new substrate 103

1.

If no specific preset for that substrate appears in the list, check the Online substrate manager on page 117
in case a preset for your substrate is available there. Alternatively, get the specific preset from your
substrate reseller or the substrate manufacturer.

2.

If no specific preset is available, try using a generic preset in the same substrate category.

3.

If you are not satisfied with the results, use the Add New Substrate wizard to create a new preset for your
substrate. See Create a new substrate preset with the Add New Substrate wizard on page 108.

4.

For full control of your preset, clone a generic preset (or the preset obtained from the Add New Substrate
wizard) and adjust the settings manually. See Edit a substrate preset on page 110. This is recommended
for advanced users only.

5.

Tiling optimization for a new substrate. To optimize tiling performance, create a new substrate via the IPS
(Substrate > Optimize for tiling).

Optimize for tiling
Optimize for tiling improves color consistency, specifically for tiling applications within a printer, within a single
job, and within the same substrate roll, it also:
●

Creates a new substrate structure, based on existing ones, with tiling specific optimizations.

●

Reduces color variations during long printing to maximum color difference (95% of color) <=1 dE 2000 in
Tiling mode.

●

Has a workflow to create substrate optimized for tiling based on customer substrate.

●

An automated introduction of preparation plot and color bars to plot stream to stabilize system during long
runs.

It is/does not:
●

A printer to printer color consistency solution.

●

Does not modify existing print modes or substrate.

It only supports the following print modes:
●

8p 70% - 120%

●

10p 70% - 130%

●

14p 70% - 140%

1.

Select Substrate > Optimize for tiling, then select the required substrate from the list.
NOTE: Only substrates that can be optimized for tiling appear in the list. Supported types are: Front-lit
Substrate, Vinyl, Wallpaper and PVC Banner. Substrates that have been converted as optimized for tiling
will not appear.
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NOTE:
suffix.

A Tiling suffix is added to the name of the substrate, you edit the name, but you cannot erase the

2.

A warning about the solution space change in the new substrate appears, click OK.

3.

A window appears to recommend the CLC to select before the first time the substrate is used.

4.

System Preheat is automatically checked for the selected tiling substrate, it is greyed out in the window,
and cannot be unchecked. Only the recommended solution space, (number of passes and ink levels)
appears in the tiling window.

NOTE: If the paper mode from the original substrate is not within the recommended solution space, it is
deleted from the list. If the existing paper modes have been deleted during creation, a recommended paper
mode is automatically added.
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5.

During creation, the CLC color reference is reset and the status appears as Color reference not set in the IPS.

NOTE: After creation, a CLC is required to create the reference for future color calibration. A warning
window appears straight after substrate creation. You can create an ICC profile from the RIP and manage
the substrate as normal from this point on.
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6.

A beginning of job preparation plot (A) and sideway color bars (B) are automatically added.

NOTE: When tiling optimized substrate is loaded, the specific workflow changes and beginning of job
preparation plot and sideway color bars are automatically introduced. Workflow for non-optimized
substrates is not affected.
7.

Substrate can be exported from one printer to another.

IMPORTANT:
on page 26.

Tiling substrates can only be imported with the latest firmware. See Update the firmware

Prepare the printer for a new substrate
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1.

Whenever possible, try to ensure that your printer is in an optimum state before you create a new preset:
run any pending maintenance task, in particular printhead checks and alignment.

2.

Stop the print queue and wait for the printer to finish the current job. No jobs should be sent to the printer
until the new substrate preset is complete.
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3.

Load your new substrate. The process of loading a substrate into the printer has been designed to be
completely independent of the substrate type. When loading, follow the correct procedure and ensure that
the roll width is specified, either automatically by the printer or by yourself. You may not experience the
best possible results if there are significant differences between the specified and the actual roll width.
NOTE:

4.

You are recommended to use the roll-to-roll configuration when creating a new preset.

Choose a suitable carriage beam printing position: see Set the carriage beam position on page 123.

Create a new substrate preset with the Add New Substrate wizard
The Add New Substrate guides you to work out the best settings for your substrate. It first requests some
information about the substrate and your intended use of it, then prints some test prints and asks you to
evaluate them. From this information, it creates the new preset.
To use the wizard, first ensure that the new substrate is loaded in the roll-to-roll configuration, then go to the
Internal Print Server, select the Substrate tab, and then Create.

Material
The first question from the wizard asks for the primary material of which your substrate is made.
●

Self-Adhesive Vinyl includes cast self-adhesive vinyl, calendered self-adhesive vinyl, perforated selfadhesive vinyl, transparent self-adhesive vinyl, and reflective self-adhesive vinyl.

●

PVC Banner includes frontlit banner, backlit banner, scrim banner, scrimless banner, mesh banner with liner,
blockout banner, truck curtain banner, tarpaulin, and PVC wall covering.

●

Paper includes coated paper, uncoated paper, photo paper, photorealistic paper, blue-back paper, paper wall
covering or wallpaper, self-adhesive paper, and non-woven wall covering.

●

PP & PE Film & Banner includes polypropylene (PP) film, synthetic paper (such as Yupo), Tyvek, and PE or
HDPE (polyethylene) banner.

●

PET Film includes polyester (PET) backlit film, polyester (PET) frontlit film, and polyester (PET) grey-back
film.

●

Textile includes polyester textile and fabric, textile banner, backdrops, textile mesh with liner, frontlit textile,
backlit textile, canvas, flag and voile *, cotton textile, textile wall covering, self-adhesive textile, and woven
wall covering.

Application
The next question asks how you intend to use your substrate.
●

Frontlit means that the print will be viewed by light from in front of the substrate.

●

Backlit means that the print will be viewed by light from behind the substrate.

Optimized for
The next question asks whether you want to give priority to speed, quality, or neither.
●

Print Quality: You want the best possible print quality.

●

Print Speed: You want fast printing.
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Test print
Next, the wizard shows you the proposed settings for the first test print. These settings are generated based on
the information you have already given.
NOTE: If you are an advanced user and the suggested settings do not meet your expectations, you can select
Advanced settings at any time and make manual changes. However, you are recommended to print the first test
print as an indication of overall performance on your substrate.
NOTE: If you cancel the test print because you are experiencing substrate issues or print-quality issues such as
banding, consider modifying the substrate preset, following the guidelines provided in Troubleshoot substrate
issues on page 359 and Troubleshoot print-quality issues on page 378.
When the test print has been made, the wizard asks you some questions about it.

The print is organized into horizontal bands which are printed at a range of different ink densities. There are two
different sections. The left part (Section A) is focused on color saturation and curing performance. The right part
(Section B) is focused on the interaction of several ink densities with different levels of optimizer.
1.

Start with Section A. Check whether any of the bands is completely cured. Use the black 4-color patch for
this purpose. Do a smudge test if possible. Check whether any curing defects are visible. One possible
curing defect appears as a pattern of small round spots on the print, from the perforated plate through
which the curing air passes.
If you have found an ink density that is perfectly cured, choose this or a lower ink density in the Ink Density
drop-down menu. Never select a ink density with curing defects.
If none of the ink density bands is completely cured, or the ink density you prefer for your application is not
cured, select NONE in the Ink Density menu. The wizard then generates another test print with different
settings.

2.

When you have found a satisfactory ink density, you need to select the best amount of optimizer for this ink
density.
Within the ink density band you have selected, look at Section B of the print to determine the best amount
of optimizer. Look at color-to-color bleed and smooth area fills. If you see several levels of optimizer
performing equally well, you are recommended to choose the lowest amount without defects.
If you cannot find any amount of optimizer giving satisfactory performance with the selected ink density,
look at neighboring ink densities (usually lower, but could be higher in some rare cases). Consider changing
the selected ink density if there is a combination without defects. If you do so, remember to change the ink
density in the drop-down menu.

3.
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Once you have found a good combination of ink density and optimizer, click Next to add the substrate and
the printing condition you just selected. You can rename both. In some cases, several printing conditions
are offered at once. You can deselect the options you are not interested in.
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4.

You are recommended to perform color calibration immediately after completing the wizard, to ensure that
the calibration process can cope with the selected ink density.

5.

The new preset is now loaded into the Internal Print Server. You can print your own test prints or create an
ICC profile with your RIP software.

TIP: If you need to provide different printing conditions or change those currently available in the new preset,
you can select Edit from the Substrate menu.

Edit a substrate preset
Editing a preset has several purposes.
●

You can assign a name of your own choice to a particular substrate.

●

You can adjust the preset to suit the precise characteristics of your substrate.

●

You can adjust the preset to your intended use of the substrate, which may range from highest-quality
printing to fast production output.

To edit the technical characteristics of a custom substrate type, go to the Internal Print Server and select
Substrate > Edit. This allows you to change all the important settings in the substrate preset. It is recommended
for advanced users only.
NOTE: You can change only the presets that you have created yourself. The presets supplied by HP cannot be
changed.
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1.

In the upper part of the Edit Substrate window, select the substrate category and the name of the specific
substrate preset that you want to edit.
NOTE:

Generic presets cannot be edited.

2.

In the central part of the window, select the number of passes, number of colors, and ink density; and
name the combination to make it visible in the Print dialog.

3.

Under the printmode table, change the substrate settings. Press Update substrate if you want to change it.

4.

In the lower part of the window, change the settings for your named combination. Press Update print mode
if you want to change an already-existing named combination.

5.

TIP:

The recommended print mode mask type is Large mask to obtain the best color balance.

TIP:

The Uniformity mask is recommended to obtain better grain uniformity.

Enable System Preheat mode to achieve more stable color consistency over long runs. When enabled, the
printer automatically runs a warm-up routine immediately prior to the real job in order to bring the print
system up to a stable operating temperature. This procedure can take up to two minutes and is therefore
only recommended for those jobs that require tight color matching over long runs. Do not use this option
for single prints or short runs.
System preheat is only applicable in the following print modes:
●

6p 80% - 100%

●

8p 80% - 120%

●

10p 80% - 120%

In order to achieve a highly optimized preset for one specific purpose and substrate, you may need to adjust
other settings to compensate. To achieve a balanced preset, you are recommended to use the Add New
Substrate wizard or a generic preset.
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Printing masks
The concept of printing masks refers to the relative positions of the ink drops on the substrate. The mask uses a
randomization algorithm to avoid visual patterns, and the result is a visually smooth surface, with minimal
graininess, and no banding.
Inaccurate alignment or substrate advance can interfere with the algorithm, causing different grain patterns
along long jobs. On tiling applications, differences between panels can lead to visible seams.
The new Uniformity mask is more robust against this kind of phenomenon, delivering a uniformly textured look
in long runs, and enabling seamless tiling applications even when using Dual-roll. This is why the Uniformity
mask is recommended for applications such as wall-covering, or vehicle wrapping; while the Large mask is
recommended for applications such as posters, roll-up banners, or backlit signs
The following images show the performance of the two types of masks when the substrate does not advance
uniformly.
Large mask

Uniformity mask

How to select mask type
1.

You can select the desired mask by creating the corresponding print mode on the Edit Substrate menu.
Remember that generic substrate presets must be cloned before being edited.

2.

Provide a name to the print mode with Uniformity mask to make it accessible for printing.
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By default, all the generic print modes use the Large mask.
Consider the Optimize for Tiling option to get the best color consistency when printing tiles.

On-the-fly adjustments
You can modify the substrate settings while printing. In the Internal Print Server main window, press the Print
adjustment button, and a dialog box opens.
The dialog box is divided into sections for the substrate advance (see Substrate-advance compensation
on page 181), the curing and drying temperatures, and the substrate tension.
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1.

Adjust the drying power up or down.

2.

Adjust the curing power up or down.

3.

Illustrations of the possible effects of not enough, too much, and correct heating respectively.

4.

Adjust the vacuum level up or down. The input and output tensions are adjusted automatically, depending
on the vacuum level.

5.

Illustrations of the possible effects of not enough, too much, and correct tension respectively.
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To apply and save the values, press the Apply button in the dialog box before closing it. The new settings are
saved for that particular substrate type for the current and future prints. They are not applied to all substrate
types.

Optimize the preset for higher print speed
Action
Reduce the number of passes.

Possible risks and compensations
●

Risk: Poor curing performance.
–

Compensation 1: Reduce the ink density by one or two levels for each level that the number of passes
is reduced.
Example: For most front-lit materials, 6-pass 100% ink > 4-pass 80% ink > 3-pass 60% ink.

–

Compensation 2: Slightly increase the curing airflow to eliminate minor curing artifacts.

–

Compensation 3: Increase the curing temperature if you choose not to compensate with the ink
density.
NOTE: This is feasible only with substrates that do not show thermal deformation defects at higher
temperatures.

●

Risk: When you reduce the number of passes, especially to 4 or fewer, some artifacts such as grain, bleed,
and coalescence may become visible. It is possible to compensate to some extent with the following
settings:
–

Compensation 1: Reduce the ink density as described above.

–

Compensation 2: Increase the optimizer ink level in 2% steps for each level that the number of passes
is reduced.
Example: 6-pass 12% optimizer > 4-pass 14% optimizer.

–

Compensation 3: Increase the drying lamp power in 10% steps for each level that the number of
passes is reduced.
Example: 6-pass 50% power > 4-pass 60% power.

Optimize for best print quality and/or widest gamut
Actions
●

Use a 6-color ink set.

●

Increase the number of passes.

●

Increase the ink density.

Considerations
●

A 6-color ink set enables smooth transitions; always use this option for best print quality.

●

Use an 8-pass print mode for best print quality with frontlit substrates.
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●

Use a 14- or 18-pass print mode for best print quality with backlit substrates and textiles.

●

When using a high number of passes, substrates can be saturated above 100% ink (example: 130% frontlit,
300% backlit). Higher ink densities may increase gamut and color saturation, and, in backlit materials,
increase opacity of printed areas.

NOTE:

This is highly substrate-dependent.

Optimize for ink consumption
Actions
●

Reduce ink density.

●

Use a 4-color ink set.

Considerations
●

Reducing the ink density usually reduces the gamut and color saturation.

●

A lower ink density may permit a lower number of passes.

●

A 4-color ink set may reduce overall ink consumption, as the light cyan and light magenta inks are not used
in printing.
NOTE:

●

Some ink is still used from each printhead to maintain the health of the printhead.

A 4-color ink set is less resistant to some print-quality defects, such as contouring.

Recommended print modes for each substrate type
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* Non-porous textile or canvas. See Check the porosity of your substrate on page 36.

Adjust the printing workflow for optimum color performance
1.

Check your substrate's color calibration status and calibrate it if recommended, by selecting Substrate >
Color calibration in the Internal Print Server. See Printer calibration on page 172.

2.

Create ICC profiles for your substrate; see your RIP documentation for instructions.

Remove a substrate preset
To remove a substrate preset from your printer, go to the Internal Print Server and select Substrate > Remove.
Then select the category and type of the substrate you wish to remove from a list of removable substrates.
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Online substrate manager
From the menu select Substrate > Search substrate online, or click the Search online button in the Load printer
configuration dialog. This screen is shown:

Sorting
To sort, click on the column title or place the mouse cursor over the column title and click on the drop down
arrow.

Structured Search
There are several structured search fields. You can use a single search field or a combination of fields.
●

There are several search options:
–

Select a manufacturer to find specific manufacturer substrate.

–

Select a category and grade to find specific type substrate.

–

Select applications to find optimized and certified substrate.

●

Application Remote Media searches automatically.

●

Click Clear filters to display the full list.

Free Text Search
The free text search locates substrate by checking the substrate name, supplier name, the comments and
technical note, for the presence of the specified text string.

ENWW

●

Type a text string.

●

Application Remote Media searches automatically if search text contains more than one character.

●

Click Clear filters to display the full list.
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Install new substrate
To install a new substrate preset, go to the Internal Print Server and select Substrate > Search substrate online,
then search for the specific substrate file and click the. Down arrow in the status column.

This agreement dialog is shown:

The agreement dialog must be accepted to continue with the installation.
If installation is successful a check icon is shown in the status column.
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Update existing substrate
The substrate update option is shown when a new substrate version is available on the server. To update a
substrate, go to Internal Print Server and select Substrate > Search substrate online, then click on the substrate
update icon in the status column.

Substrate synchronization
Onyx and Caldera RIP drivers contain all the default substrate presets and ICC profiles the HP Latex 3000 printer
series comes with.
If you carry out any substrate management action in the HP IPS, go to the RIP and synchronize the substrate list.
NOTE: Any new substrate created directly in the HP IPS does not contain an ICC profile. You should create the
color profile from the RIP using an external spectrophotometer.
If you download and install a substrate preset from the Online Substrate Search via the HP IPS, or you import a
substrate preset OMES downloaded from HP Media Locator, the presets already contain the ICC profiles.
In order to make sure the RIP has the latest substrates available, follow these steps:
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Synchronize substrates with the Caldera RIP
1.

Go to the Caldera RIP software and click the Easy Media tool.

2.

Click on the printer icon, then click Next.

3.

Select the printer to retrieve the substrate, then click Next.
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4.

Click Import.

5.

Click Autosync.

6.

Click Missing presets only.

All your custom substrates from the machine are downloaded to the RIP and added to the end of the
substrate list.

ENWW

Online substrate manager 121

Synchronize substrates with the ONYX RIP
1.

For retrieving your custom substrates from the machine, click on Configure Printer.

2.

Click the Device tab, select the machine, then click Features.

3.

A new window appears, select Global Printer Options, then click Configure.

122 Chapter 4 Handle the substrate

ENWW

4.

Another window appears, click From Printer.

5.

A new window appears, select the custom substrates you want to import, and click OK.

The selected substrates are now added to the Media Manager library. Close all the open windows.

Set the carriage beam position
The carriage beam position determines the vertical distance between the printheads and the platen. If it is too
great, print quality will be impaired. If it is too small, there is a risk that the printheads will come into contact with
the substrate, causing smears or damage.
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●

The substrate-load position is not used for printing: it may be used for loading thick substrates or for
maintenance tasks.

●

The printing position is a fixed height suitable for unwrinkled substrates up to 0.4 mm (0.016 in) thick.

●

A custom position is used for substrates thicker than 0.4 mm (0.016 in), or for substrates that wrinkle
slightly due to heating. We recommend setting the custom position as follows:
–

The thickness of the substrate plus 1.9 mm for substrates that do not wrinkle.

–

The thickness of the substrate plus 2 to 3 mm for substrates that wrinkle.

You cannot exceed the maximum height permitted by the Internal Print Server.
TIP: Try to avoid wrinkling by using substrates that do not wrinkle, or by using a slower print mode that
will allow you to lower the drying and curing power.
●

The ink collector install position is used only for installing the ink collector kit (see The ink collector kit
on page 48); it is not used for printing.

To set the carriage beam position, go to the Internal Print Server and select the appropriate position from the
drop-down list.

WARNING!
CAUTION:

Keep away from the printer's moving parts until the carriage beam has reached its new position.
Do not change the carriage beam position while the printhead cleaning roll is out of place.
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5

Create and manage print jobs

Add a new print job
Each print job must be created in your Raster Image Processor (RIP) and then added to the Internal Print Server.
When the RIP has generated a print job, its output folder will contain at least three files:
●

An XML file containing job settings

●

A low-resolution TIFF file for use in previews

●

At least one high-resolution TIFF file containing the image to be printed

The output folder should be the shared folder on the Internal Print Server computer that was created during
printer installation. The Internal Print Server cannot take files directly from the network because access would
not be fast enough.
1.
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Go to the Internal Print Server.
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2.

Select the Add New Job icon
or File > Add New Job. Navigate to the folder containing the print job files,
and click Open to import the job into the Internal Print Server.

TIP:
3.

You can sort the list by any column.

The next dialog box displays information about the job.

You can change the default job name the first time you open its properties window. Once you save the job
name, it cannot be changed. Use the Save As button to create a copy of an existing job with a different
name.
This dialog has the following options:
●

Number of copies: the total number of copies to print

●

Number of columns: the number of copies to print horizontally, across the width of the substrate

●

Max: if this option is checked, the number of steps will be set to the maximum that will fit into the
substrate width

In the Spacing section, this dialog gives the opportunity to define a horizontal margin that will be left blank,
or to center your jobs on the substrate so that there is an equal amount of white space on both sides. If the
number of copies is more than one, then it will apply these properties:
●

Horizontal Space: the horizontal gap between copies

●

Vertical Space: the vertical gap between copies
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Although the substrate and print mode can be changed from this dialog window using the change button, it
is recommended not to do so because it may adversely affect print quality. It is better to make such
changes from the RIP.
The drop-down list at the top of the preview field allows to choose all sections or just one of the sections to
be printed, and with the other drop-down list, can select the roll preference where the job will be queued.
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4.

To see more job options, click the Advanced settings button in the Job Properties dialog.

In this dialog, although the substrate and print mode can be changed from this window by using the
Change button, it is recommended not to do so, because it may adversely affect print quality. It is better to
make such changes from the RIP.
The Job Info paragraph can be used to select annotations and special marks to be printed alongside the
image.
The Partial Job Printing section appears only when the number of copies is one, the job is not double sided,
contains one whole image, and can be used to select the job printing offset. The hatched area will not print.
The Easy Printing resume can be useful to resume a job after an unexpected interruption.

Click the Save button to store the advanced settings, or Cancel to discard them and return to the previous
main dialog.
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5.

Click the Save button to store the job in the Internal Print Server for further processing in the main job
dialog.
NOTE: The Internal Print Server gives you a warning if you select layout changes that are not compatible
with your selections in the RIP software.

6.

Click the Save button to store the job in the Internal Print Server for further processing.
NOTE: The Internal Print Server gives you a warning if you select layout changes that are not compatible
with your selections in the RIP software.

Dual-roll printing
If two rolls have been loaded and the dual-roll checkbox has been checked when loading, the following window
appears:

The main difference is that there are now two queues, one per roll. Jobs sent to roll 1 will be seen in the first
queue, and jobs sent to roll 2 in the second queue.
When printing, jobs with the same resolution and print mode are printed at the same time (one on each roll). You
can see in the preview how they will be processed.
You can move from one queue to another by clicking the
If you click the

and

icons.

icon, the jobs are automatically arranged to minimize substrate waste without altering the

order.
The closed padlock icon indicates jobs that cannot be moved when you click the

icon. The closed padlock

appears when a manual update to the job has been made. To lock or unlock a job, just click the padlock.
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Dual-roll layout preview
When printing in Dual-roll, a tab named Layout appears in the preview section of the IPS. Its purpose is to provide
clear information on how the dual job has been set up via its simple interface, and thus facilitate substrate waste
reduction.

The Layout tab provides information about:
1.

The print mode used for each print.

2.

The length of substrate to be printed from each roll.

3.

A substrate waste warning for each roll. This warning has two statuses with thresholds set-up to 2 meters:
a.

Background on grey: substrate waste less than 2 meters.

b.

Background on red: substrate waste greater than 2 meters.
NOTE: The warning is located on the side where substrate waste is expected. If there is no risk of
substrate loss (0.00 cm), the warning is located on the left side by default.

Substrate waste causes
●

Unbalanced queues or different print modes in both rolls (seen in the above image).

●

Printhead service routines: In order to keep good image quality, the printer has to perform a service routine
from time-to-time while printing. Service routines don’t have a major influence when printing on a single
roll, but there can have in dual-roll if the queues are not balanced enough. Layout preview indicates the
service routines the printer needs to perform, it shows how the waste is distributed between the actual job
set-up, and makes it easier the rearrange jobs in order to minimize waste in dual-roll configuration.
Service routines while printing are carried out at the end of a job, when any of the following conditions are
reached:
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●

Printer has printed more than 100 meters uninterrupted.

●

Printer starts the next job, and when finished, it would have printed more than 100 meters
uninterrupted.

Rotate a print job
A job can be rotated by 90 degrees in either direction by using the rotation icons at the top right of the Job
Properties window of the dialog that appears when clicking the Image composition button.
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NOTE: Rotation is available only when the printer is not printing.
Press the Save button to store the current image rotation or Cancel to discard the changes and return to main
dialog of the properties of the job.
The rotation effect is shown in the preview. After you press the Save or Save As button in the Job Properties
window, the actual rotation of the job takes place. This could take a few minutes, depending on the image size
and resolution, during which time the job can neither be printed nor edited, and the job status is shown as
Rotating. When completed, the job is ready for printing.

Manage the print queue
The main screen of the Internal Print Server displays the queue of print jobs and various icons that can be used
to manage the queue.
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Above the print queue are the following icons:
●

Add New Job

: See Add a new print job on page 125.

●

Add Existing Job : Return a job to the queue that has been printed already. Printed jobs remain available
unless deleted manually.

●

Edit Job

●

Proof : Proof a job in the queue (not available for nested jobs). This can be used to crop the image before
printing.

●

Up

●

Down

●

Remove

: Edit the properties of a job in the queue.

: Select the next job upwards in the queue.
: Select the next job downwards in the queue.
: Delete the selected job from the queue.

You can check the boxes of the jobs you want to print, and press the Print button to print them.
You can cancel all jobs in the queue by pressing the Cancel button.
The Print adjustment button displays the substrate-advance compensation (which can be changed).

Delete a print job
This is the correct procedure to delete a job.
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1.

Remove the job from the queue by using the Remove icon
or by ticking the job in the queue and
selecting Remove. When deleting a job in this way, the files may or may not be left on the printer's hard
disk, and the file may or may not still be available from the list in the Add Existing Job window, depending
on the settings in Tools > Preferences > Queue Rules, in the section “When removing jobs from the queue”.

2.

Remove the job with File > Delete job, select the job and press the Delete button. Now the file cannot be
retrieved from the Add existing job window.
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Image composition
The Job Properties window is displayed when you import a job into the Internal Print Server, or when you rightclick the job queue in the Internal Print Server.
This window contains an Image composition button that allows you to choose among the following alternatives:
●

Tiling: A single job is printed in sections, to be put together later. See Tiling on page 134.

●

Nesting (Multi-image): The selected jobs are printed one after the other, across the width of the substrate if
there is room. You can use the Advanced Nesting Arrangement window to alter the layout manually. See
Introduction to JDF on page 29.

●

Double Sided: Block Out.

All image compositions can be used with dual-roll printing, when so, the software will warn if the layout involves
printing in the gap between rolls; but it will allow so it if the warning is disregarded.

Tiling
Tiling is a layout method that allows you to print a large image in sections, and then put the sections together
later.

Click the Tiling Check and the Tiling section will be activated.
This composition will automatically cut your image into sections and print the sections separately. There are two
alternative ways to select the size of the sections:
●

Select the width and height of each section. The number of sections is then calculated automatically.

●

Select the number of horizontal and vertical sections. The width and height of each section is then
calculated automatically.

If you choose a non-zero overlap, the size of each section will be increased by that amount so that the printed
sections will overlap when put together.
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The drop-down list at the top of the preview in the main properties job dialog field allows to choose all sections
or just one of the sections to be printed.

Double-sided
Double-sided printing helps you to print rows of images on both sides of the substrate.
●

There is a process to guide you when printing a substrate on both sides.

●

Double-sided printing can be used to print the same image or different images on each side.

●

The process automatically compensates for any registration errors, of the position of the plot, along both
axes (along the substrate width + substrate advance) to minimize any errors.

●

The ink collector kit cannot be used when printing double-sided.

●

The images of Side A and Side B must have approximately the same dimensions. The image that you select
for each side must be the same image for the entire side.

●

You can print side A of a double-sided job on dual-roll and then finish side B with a single roll.

Create a job
Any image created in the RIP can be printed in either side A or side B, without any special requirements. However,
side A and side B must have the same dimensions when printed on the substrate.
NOTE: In order to minimize registration errors on some substrates, you are recommended to compensate for
substrate contraction in the RIP when the image is generated.
Define double-sided job
From the Internal Print Server's main window, click the Add New Job icon
to open the Choose Image File
window. You will see the Double sided check box on the bottom left of the window. If you select more than two
jobs, double sided is impossible and the box is grayed out.
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This type of composition works for opaque substrates. Click the Image composition button from main job dialog
and the following screen is displayed. Here you can define the Double Sided Block Out job properties.

1.

If Check Double Sided is not checked then click it.

2.

Press the Change image side B button to select a filename containing the image to be printed on Side B if a
different image than side A on side B is required.

3.

In the Advanced settings section, the following options are recommended when printing double sided block
out:
●

Side B calibration space: When selected, the printer leaves an area of substrate empty after the
images have been printed (the substrate is warmed-up). This is to give space to perform substrateadvance compensation on side B, which is recommended. At the end of the empty space a dotted line
is printed.

●

Side B loading space: When selected, the printer will advance the substrate so that there is sufficient
substrate to load side B.
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●

Check registration line every row: This option enables you to choose which registration lines are
scanned by the printer, if you select 1 (the default), the printer stops printing and checks every
registration line, if you select a higher number, for example 2, the printer only scans every second
registration line. This increases the speed of the job, but also slightly increases the chances of
misregistration.
NOTE:

This option is enabled when the second image is selected (from Side B).

4.

From the Image list section, you can rotate the selected image 180°.

5.

Press the Save button to store the current image composition or the Cancel button to discard the changes
and return to the main job properties dialog.
The following screen is displayed where the double-sided job properties can be defined:

6.

From the drop-down menu, select the side with the properties you want to define or view.
NOTE:
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The side selected here is the side that will be printed. To print side B, select B.
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●

●

For both sides you can define the following properties:
–

Number of copies: The number of total copies to print

–

Number of columns: The number of copies to print horizontally, across the width of the
substrate

–

Max: If this option is checked, the number of steps will be set to the maximum that will fit into
the substrate width

For side A you can define the following properties:
–

Horizontal Margin: Gives the opportunity to define a left margin that will be left blank

–

Center: To center your jobs on the substrate so that there is an equal amount of white space on
both sides
NOTE: Centering the images is highly recommended to compensate for any possible
registration errors that may occur.

–

Horizontal Space: Gives the opportunity to define the horizontal gap between copies

Preview (Image/Layout/Preview both)
There are three different previews:
1.

Main dialog of the job properties and preview how the printer will print each side.
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2.

Click the Image composition button to see the image that contains the job on each side.

3.

Click the Preview both button to see a simulation of how both images will print on side A and on side B. You
can use this simulation preview to check that the orientation of the images relative to each other is how
you expect the finished result to be.

1.

Select Side A from the drop-down menu.

Print
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2.

Select Save or Save As.

3.

Select Print Job and print the selected images.

The number of copies are automatically distributed according to the parameters defined in Define doublesided job on page 135 (number of rows, column, centered)..
●

At the end of each row a black registration line is printed automatically (a). This registration line is
used while printing side B, to position the side B rows and minimize the registration errors.

●

It is recommended to mark with a marker the back side of the last registration line (b) to position the
substrate during the side B loading process.

●

When side A has been printed, after the last continuous black registration line, the printer
automatically provides an area in which to perform the side B calibration (c) and side B loading (d)
area.
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NOTE: The area dedicated to calibration, between the continuous registration line and the dotted line (c),
must be advanced at the same speed as the printed area, and at the same temperature, to ensure an
effective calibration.
4.

When Side A has finished printing, unload side A. See Side A: Unload on page 89.

5.

Check that the substrate-advance sensor is clean, and do not hesitate to clean it. See Clean the substrateadvance sensor on page 204.

6.

Load Side B. See Side B: Load and print on page 90.
NOTE:

7.
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For accurate printing we recommend that Substrate Edge Detection is selected.

When Side B is loaded, perform the following steps. For more details of these procedures, refer to Side B:
Load and print on page 90:
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a.

Align the dotted line with the platen

b.

Perform substrate-advance compensation.

c.

Select Side B from the drop-down menu.

d.

Ensure that the registration line is aligned with the platen and start printing side B.

e.

Configure Rows to register, see Define double-sided job on page 135.

f.

Select Save or Save as.

g.

Select Print Job and print the selected image.
While printing Side B the printer will automatically read each registration line and Side B will be
positioned to minimize the registration errors.

NOTE: To activate the side you want to print, always select it from the drop-down menu first, make any
changes to the image, and select Save.

TIP: If a particular substrate is often used for double-sided printing, to avoid having to redo the substrateadvance compensation between side A and side B, a second specific substrate could be used based on the
initial one. Apply the substrate-advance compensation of sie B, and select this new substrate preset each
time side B is loaded (and select the previous one each time side A is used).

Multijobs on double side block out
Double side block out supports Multijobs functionality which allows to print differently dimensioned images in
the same print (same side).
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Some considerations need to be taken into account before using this functionality:
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1.

Whenever a new job is added to the print queue, Advanced Settings>Side B loading space is enabled by
default.

2.

When selected, at the end of each job, the printer advances the substrate about 1.5 meters in order to load
side B.
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3.

The Side B loading space option is used to leave an empty area of substrate after the images have been
printed. This is done to leave space to perform substrate advance compensation on side B. It must be
unchecked on each job in the print queue except the last one, if not there will be about 1.5 meters of
substrate waste after each job.
IMPORTANT:

Only enable Side B loading space on the last job in the print queue:

Nesting
Nesting is a layout method that allows you to choose the layout of your printed jobs on the substrate, relative to
one another, instead of simply printing them one after another as usual. Jobs can be printed side by side if there
is room.
TIP:

Printing jobs side by side on the substrate gives you faster throughput and uses less substrate.

You can use nesting in the Internal Print Server, from the Choose Image File window or the Job Properties
window.

The Choose Image File window
From the Internal Print Server's main window, click the Add New Job icon
to open the Choose Image File
window. You will see the Nesting check box on the bottom left of the window. If you select only one job, nesting
is impossible and the box is grayed out. If you select more than one job, you can click the box to enable nesting.
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NOTE: To be nested together, jobs must be of the same resolution and printed on the same substrate. Any
incompatible job is added to the queue as a separate, non-nested job, and an explanatory message is displayed.
When you press the Open button with nesting enabled, the Advanced Nesting Arrangement window opens (see
The Advanced Nesting Arrangement window on page 146).

The Job Properties window
From the Internal Print Server's main window, right-click the print queue to open the Job Properties window. In
to add more jobs, in which case you will see a Nesting section
this window, you can click the Add New Job icon
in the Layout pane.

Nested jobs must all be printed with the same number of passes. Therefore, the number of passes used for all
jobs will be copied from the first job.
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From the current dialog, press the Image composition button to access another dialog where the Arrange button
can be selected.

If you press the Arrange button in this section, the Advanced Nesting Arrangement window opens. If you use
advanced nesting, the number of passes used for all jobs will be copied from the job with the highest number of
passes specified.
The best location for the next added image is selected automatically.

The Advanced Nesting Arrangement window
The Advanced Nesting Arrangement window displays a preview of your jobs and their layout on the substrate.
●

You can alter the layout by selecting a job in the preview and changing the Left and Top values, or by
dragging with the mouse.

●

You can zoom and scroll the preview.

●

You can rotate images at any stage.

●

You can rotate images at any stage.

146 Chapter 5 Create and manage print jobs

ENWW

The Rearrange button automatically optimizes the positions of the images, keeping the established margin.
When you are satisfied with the layout, press the OK button.

Restart and Print
If the printer suddenly shut downs and the Internal Print Server goes offline, you can ready the printer to
continue rapidly
To use this feature, via the Internal Print Server, go to Tools>Restart and Print.

By selecting this option:
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●

The substrate will automatically load during boot up. All the print queue checked jobs, except the failed one,
will automatically print.

●

No operator interaction is required, just press the re-arm button.
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6

Handle the ink system

Ink system components
Ink cartridges
Ink cartridges store the ink and are connected to the printheads, which deposit the ink on the substrate.

Each cartridge contains HP Latex ink, and consists of a bag within a recyclable cardboard box.
CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the
Glossary on page 418). Avoid touching pins, leads, and circuitry.
If pressure is put on a cartridge while it is connected to the printer, the pressure is transmitted to the ink pressure
sensor, which may break; in which case ink may leak from the cartridge. To avoid such ink leaks, avoid putting any
pressure on cartridges while they are connected to the printer. In particular:
●

Always disconnect cartridges from the printer before handling them.

●

Never place anything heavy—more than 1 kg (2.2 lb)—on top of a cartridge.

●

Take care not to drop a cartridge.

●

Do not try to force the last of the ink out of an almost-empty cartridge by pressing the ink bag inside the
cartridge.

Printheads
The printheads take ink from the ink cartridges and deposit it on the substrate.
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CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices (see the
Glossary on page 418). Avoid touching pins, leads and circuitry.
The printer's six-color writing system uses six dual-color printheads with a total of 63,360 nozzles, and an
HP Latex Optimizer printhead with 10,560 nozzles.
WARNING! Printheads should be stored vertically: if boxed, with the box arrows pointing up; if out of the box,
with the nozzle cap up.

Printhead cleaning roll
The printhead cleaning roll is a roll of absorbent material used in the normal operation of the printer to wipe the
printheads periodically (at the beginning and end of printing, on printhead check and clean, and so on). This helps
the printheads to deliver continuous ink and maintain print quality.
The roll should be replaced whenever it is used up, to avoid damaging the printheads. The frequency of
replacement depends on your use of the printer. A single roll will last approximately 40 liters; this may take
about 3.5 weeks at a usage level of 5,000 m²/month (50,000 ft²/month).
An alert is displayed when 75% of the roll has been used, and again when 95% of it has been used. You can
choose to replace the roll at any time. The printer will not print when the roll has been 100% used.
If there is not enough of the roll to start a new job, the printer cancels the job.
To change the printhead cleaner roll, see Replace the printhead cleaning roll on page 167. The HP 881 Latex
Cleaning Roll can be ordered in the normal way.
TIP: You should not touch the printhead cleaner roll except when you need to replace it. Any interference with
the roll may prevent the printer from keeping track of roll usage, in which case you may see spurious error
messages, and a printing job may be cancelled unnecessarily.

Aerosol filters and drying filters
The printheads produce many fine droplets of ink, most of which are placed accurately on the substrate.
However, a small proportion of these droplets escape sideways; the two aerosol filters are placed on either side
of the printhead carriage to intercept them.
The drying filters keep dust and aerosol off the drying lamps.
The filters should be changed every time the printhead cleaning roll is replaced. They are provided with the HP
881 Latex Cleaning Roll.

Left spittoon
The left spittoon is a rectangular piece of foam that allows the printhead nozzles to be refreshed at the left side,
before printing a pass from left to right.
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Change the left spittoon every time the cleaning roll is replaced. The foam is provided with the HP 881 Latex
Cleaning Roll.

Condensation collector bottle
The printer has a system that collects most of the vapor generated while drying and curing the ink and
condenses it in a bottle located at the left side of the printer. You should check the bottle from time to time and
empty it when necessary. Consult your local authorities to determine the correct manner in which to dispose of
wastes. The waste-profile datasheet contains the required information for correct disposal. This document is
located here: https://hplatexknowledgecenter.com/applications/wasteprofiles/.

Ink deposits
The printer can check the firing capacity of each single nozzle. Doing so causes small amounts of ink to
accumulate close to the drop detector. This ink gradually forms ink deposits that need to be cleaned; see Clean
the drop-detector ink deposits on page 242.

How to work with ink system components
Ink cartridges
Remove an ink cartridge
An ink cartridge should be removed and replaced when it is empty or past its expiry date. An empty cartridge is
indicated in the Internal Print Server and by an orange blinking light beside the cartridge itself. You may also
decide to remove a cartridge if it contains little ink and you want to provide for a long period of unattended
printing.
The printer can continue printing without any ink cartridges for at least 10 minutes, depending on the print mode
and the job being printed. Therefore, cartridges can be replaced while printing continues. A functional ink
cartridge is required in order to start a new job.
1.

Go to the cartridge that you intend to remove. The cartridges are arranged as shown below.
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2.

Disconnect the cartridge connector by pressing the tabs on each side of it and pulling it gently away from
the cartridge.

3.

Remove the empty cartridge from the printer.
NOTE:

Some residual ink can be expected in the cartridge, ranging from 2% to 5% of the original content.

Insert an ink cartridge
NOTE:

The ink cartridge is supplied in an insulating bag; do not open it until you are ready to use the cartridge.

1.

Check that the new cartridge is of the correct color.

2.

Place the cartridge on a flat surface and turn it four times (rotating it through 360 degrees) as indicated on
the label, to ensure that the ink is well mixed before use.

3.

Tear off the square and fold it inside the handle as illustrated.

4.

Put the new cartridge into its correct place on the printer.
TIP:

5.
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Use both hands: the cartridge is quite heavy.

Check that the rubber part around the needle in the cartridge connector is clean. Clean gently if necessary.
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6.

Connect the cartridge connector to the cartridge.

NOTE: The cartridge connectors will refuse connection to the wrong type or color of cartridge. If you
cannot connect the connector easily to the cartridge, check that you have the correct cartridge.
7.

Ensure that the tabs on each side of the cartridge connector are opened but in place, showing successful
connection. You will hear a click.

8.

A few seconds after you have connected the cartridge, the green LED should be lit. If it is not lit after 10
seconds, reconnect the cartridge. The LED will turn red if the cartridge is expired or not valid; see the
Internal Print Server for further details and corrective action.

Although it is possible to use non-HP ink cartridges, this choice has several serious disadvantages. It may not be
possible to determine with enough accuracy the ink level or status of used, refilled, or counterfeit ink cartridges.
Any service or repair required as a result is not covered under the warranty. System ink flushing, color calibration,
and printhead alignment are recommended. If you experience print-quality problems, HP recommends changing
to Original HP inks.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain the
best print quality, replace a cartridge when it reaches its expiration date. An alert notifies you when any cartridge
reaches its expiration date.
You can also check a cartridge's expiration date at any time: see Printer status and alerts on page 25.

Check the status of the ink cartridges
The Internal Print Server provides information about the status of the ink cartridges. Additional information can
be obtained from the status lights in front of each ink cartridge (on the left side).

●

Green steady light: no problems

●

Green slowly blinking light: cartridge in use, do not touch

●

Orange blinking light: cartridge is empty
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●

Red steady light: there is a problem, check the Internal Print Server for more information

●

All lights off: no cartridge, cartridge not connected, or unknown problem

The level of ink remaining in each color is displayed at the top right of the Internal Print Server's main screen. You
can see more details of ink cartridge and printhead status by selecting Information > Supplies.
NOTE:

The ink level estimates are not guaranteed to be accurate.

NOTE: If the warranty status is See warranty note, this indicates that expired ink is being used. If the warranty
status is Out of warranty, this indicates that non-HP ink is being used. See the limited warranty document
provided with your printer for details of the warranty implications.

Misuse of ink cartridges
Consequences of using Expired ink:
●

The ink delivery system of the color is marked as using expired ink.

●

Affected printheads are immediately marked as using expired ink and lose their warranty. Warranty status
becomes See Warranty note. As the printhead information is write once only, the status of the printhead
cannot be reverted.

●

Ink cartridge is marked as Expired and considered as used.

Recovery from expired ink usage
1.

Remove the expired ink cartridge and replace it with a new one (non-expired).

2.

Keep using the same printheads until 9 liters of non-expired ink are used for the ink color marked as
expired. If you insert a new printhead, it will be marked as using expired ink because the ink delivery system
is marked as having expired ink (the following IPS warning message will be displayed):
“Using expired ink will invalidate the printhead warranty. Press YES to continue or NO to cancel inserting the
new printhead and maintain the warranty of the printhead.”

3.

After consuming 9 liters of non-expired ink, the ink delivery system of the respective color recovers and is
marked as using valid HP ink. The user can now proceed with printhead replacement.
IMPORTANT: 9 liters of non-expired ink must be consumed in the affected color in order to completely
recover from the expired ink state.

Consequences of using non-HP ink
The ink delivery system of the color is marked as using non-HP ink.
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●

The printhead is immediately marked as using non-HP ink and the printhead loses its warranty. Warranty
status becomes See Warranty note. As the printhead information is write once only, the status of the
printhead cannot be reverted.

●

Ink supply marked as Non-HP and considered as used.

●

The printer enters Safe Mode and the drying lamps are turned OFF with a direct impact on print quality.
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Recovery from non-HP ink usage
1.

Remove the non-HP ink cartridge and replace it with a new one (original HP cartridge).

2.

Keep using the same printheads until 9 liters of original HP ink are used for the ink color marked as non-HP.
If you insert a new printhead, it will be marked as using non-HP ink because the ink delivery system is
marked as having non-HP ink (the following IPS warning message will be displayed):
“Using non-HP ink will invalidate the printhead warranty. Press YES to continue or NO to cancel inserting
the new printhead and maintain the warranty of the printhead.”

3.

After consuming 9 liters of original HP ink, the ink delivery system of the respective color recovers and is
marked as using original HP ink. The user can now proceed with printhead replacement.
IMPORTANT: 9 liters of original HP ink must be consumed in the affected color in order to completely
recover from the non-HP ink usage state.

Printheads
Remove a printhead

WARNING!

This operation is limited to trained personnel only!

NOTE: During the installation of the printer, the designated personnel received training for safe operation and
maintenance of the printer. It is not allowed to use the printer without this training.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

If a printhead develops an electrical fault or overheats, the Internal Print Server will indicate that it should be
reseated or replaced. In addition, you may wish to replace a printhead if its warranty has expired or if you feel
that its performance is not adequate.
1.

Ensure that the printer is not trying to print: stop the job queue.

2.

In the Internal Print Server, select Printer > Replace printheads.

3.

If the service position window is open, you are asked to close it.
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4.

The carriage moves automatically. Open the service position window to access it.

5.

The Internal Print Server tells you which printhead to remove. Release the latch that secures the printhead,
and lift it.
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6.

Lift the handle provided with the printhead, and pull the handle gently upwards to disconnect the printhead
from the carriage.

7.

Remove the printhead from the printer. The original packaging materials can be used to discard the old
printhead or in case there is a need to return it to HP.

When removing the optimizer printhead
1.

Locate the optimizer printhead.

2.

Push the latch handle against the rear beam as much as possible.
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3.

Tilt the printhead a little before taking it completely out of its pocket.

4.

If the printhead is to be reused, protect it using its orange sealing cap.
CAUTION: Make sure each printhead uses its own cap and not the cap for some other printhead. This is
especially important with the optimizer printhead caps as there is a high risk of nozzle damage if they are
mixed with the color printheads and vice versa. The optimizer caps are labeled as shown below.

NOTE: Remember which printhead came from which slot; the printer will report an error if you later replace a
printhead in a different slot.

Insert a printhead
1.

Check that the new printhead is of the correct colors.
NOTE:
it.

2.
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Each printhead has a unique shape and cannot be inserted into the wrong slot. Do not try to force

Shake the printhead according to the instructions on the packaging.
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3.

Remove its packaging and protective caps.
TIP: You may wish to keep the protective caps for later reuse, in case you ever want to remove a
printhead from the printer.

4.

Put the new printhead into its correct place in the printer, and lower its handle.
CAUTION: Insert the printhead slowly. It is recommended to insert it as vertically as possible without
hitting any parts of the carriage or the sides of the slot. It may be damaged if inserted too fast, or if it hits
something.

5.

Lower the latch until it lies on the printhead but do not close it yet.
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6.

Press with two fingers on the primer to ensure the primer ports are well inserted.

7.

Secure the latch.

8.

Close the service position window and press OK. The printer checks that the new printhead has been
correctly inserted (the status is shown in the Internal Print Server), and recommends printhead alignment,
which is optional.

9.

Restart the job queue.

When inserting the optimizer printhead
1.
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Push the latch handle against the rear beam as much as possible.
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2.

Insert the printhead at an angle and below the two little latches shown below. Rotate it until it is vertical
and press it to insert.

3.

Press on the primer with two fingers before securing the latch to ensure proper connection.

Maintain the printheads
You should perform an automatic printhead check and clean every morning, before starting to print. While the
printer is idle, the components of the ink can precipitate inside the printhead and block the nozzles. The check
and clean process pre-cleans the printheads, checks them with the drop detectors, and cleans them further if
necessary. It takes between 10 and 30 minutes, depending on the condition of the printheads.
To maintain the best print quality, replace a printhead when it reaches its expiration date. An alert notifies you
when any printhead reaches its expiration date.
You can also check a printhead's expiration date at any time: see Printer status and alerts on page 25.
Printheads should be aligned from time to time: see Align the printheads on page 172.
TIP: If you remove an unexpired printhead from the printer, planning to reuse it later, the best way to protect it
is by replacing the protective caps that you removed before inserting it into the printer.
CAUTION:

It is important to use the HP Latex Optimizer sealing cap for the HP Latex Optimizer printhead.

Check and clean the printheads
This procedure should be followed daily.
1.

Go to the Internal Print Server and select Printer > Printhead cleaning.
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2.

Press the Check button to perform routine cleaning automatically.

Safe mode
Under certain conditions, including printer operation outside of environmental specifications, and when a used,
refilled, or counterfeit ink cartridge has been detected, the printer will operate in ‘safe’ mode. HP is unable to
warrant the performance of the printing system when operated outside of environmental specifications or when
a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect the printer and the
printheads from damage due to unexpected conditions, and is in operation when the

icon is displayed on

the printer’s computer. For optimal performance, use Original HP ink cartridges. HP Latex printing systems,
including Original HP inks and printheads, are designed and engineered together to provide uncompromising
print quality, consistency, performance, durability, and value—with every print.

Replace the printhead cleaning roll, filters, and spittoon
WARNING!

This operation is limited to trained personnel only!

NOTE: During the installation of the printer, the designated personnel received training for safe operation and
maintenance of the printer. It is not allowed to use the printer without this training.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

When the cleaning roll reaches its end, it must be replaced, together with the aerosol filters, drying filters, and
left spittoon. All these parts are supplied together with the HP 881 Latex Cleaning Roll.
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1.

Printhead cleaning roll

2.

Aerosol filters

3.

Drying filters

4.

Left spittoon

The Internal Print Server provides instructions for all replacements. Go to the Internal Print Server and select
Printer > Replace cleaner roll. A wizard appears summarizing all the operations to be done:
●

Replace the aerosol filters.

●

Replace the drying filters.

●

Replace the left spittoon.

●

Replace the printhead cleaning roll.

TIP:

You are recommended to wear gloves.

Click Next at the bottom of the wizard window to start the replacement of the aerosol filters.

Replace the aerosol filters

1.

Ensure that the printer is not printing.

2.

Ensure that all windows, covers, and doors are closed and remain in their original position.
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3.

Open the service position window.

4.

Open one latch on the left side of each aerosol filter module.

5.

Open the lid of each filter.

6.

Remove both aerosol filters, using their handles.
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7.

Insert the two new filters. There is only one way to insert them that works. If you feel resistance, try to
insert the filter the other way round.

8.

Close the lids.

9.

Close the latches.

10. Click Next at the bottom of the wizard window to start the replacement of the drying filters.

Replace the drying filters

1.

Handling them by the plastic flaps, remove the two drying filters from each side of the carriage.
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2.

Insert the new filters.

3.

Attach the two plastic flaps to each filter.

4.

Close the service position window.

5.

Click Next at the bottom of the wizard window to start the replacement of the left spittoon.
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Replace the left spittoon
1.

Open the front door.

2.

Locate the left spittoon at the left side of the print area.

3.

Slide out the left spittoon foam with its frame.

IMPORTANT: HP Latex 3000/3600 Printers only: Depending on the serial number of your printer, there is
no need to put the foam on the spittoon frame because the housing has been designed to insert the foam
directly inside.
Call your HP representative for more information.
4.

Remove the foam from the frame.
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5.

Insert the new foam into the frame, making sure it is flat, and without wrinkles.

6.

Insert the frame into place in the left spittoon housing. Ensure that it is flat.

7.

Click Next at the bottom of the wizard window to start the replacement of the printhead cleaning roll.

Replace the printhead cleaning roll

1.
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Any unused portion of the roll is wound on to the takeup roll at this time. You will be warned if the unused
portion is more than 5% of the whole roll.
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2.

In order to replace the printhead cleaning roll, unlock and open the door on the front right of the printer.

3.

Grip the handle and pull the whole printhead cleaning roll assembly out through the door.
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4.

Pull the black knob on the upper left and move the pinch system aside.

5.

Clean the rubber blade with the end of the roll.

6.

Slide both rolls off their axles and dispose of the roll with the used cleaning material according to the
instructions provided with the new roll. Also consult your local authorities to determine the correct manner
in which to dispose of wastes. Keep the empty core to use as a takeup core.
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7.

Slide the new roll onto the upper axle.

8.

Insert the upper axle, placing the end cap on the side, and slide it all together until you hear a click.

9.

Pass the leading edge of the roll over the upper rollers, and thread the cleaning material through the rollers
on the left.

10. There is a strip of polyester film on the leading edge of the cleaning material. Insert it into the hole in the
takeup core, which takes hold of it.
11. Slide the takeup core onto the lower axle.

NOTE: If the cleaner roll has not been properly installed, you may see a message about clearing a
printhead cleaning roll jam. Pull the whole assembly out, wind a little of the roll forward, then slide it back in
again. The printer will check the roll again.
NOTE: Do not cut the cleaning material in order to reattach it to the lower roller. An unexpected roll radius
can produce errors on the cleaning roll system.
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12. Restore the pinch system by moving the black knob back into place. If you feel resistance because the
cleaning roll is too tight, turn the roll slightly counter-clockwise.
TIP: There is a green ring on the far side of the black knob, which should not be visible if the knob has
been correctly placed. If it is visible, try again.

13. Grip the handle and push the whole printhead cleaning roll assembly back into the printer. Ensure that you
push it as far as it will go.

14. Close and lock the door.
15. Click Finish in the wizard window.
The printhead cleaning roll length tracking is now reset to zero.
NOTE:

If you tamper with half-used rolls, the usage shown in the Internal Print Server will not be accurate.

Do not empty or remove the drain container: this is done by a service engineer during preventive maintenance.
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7

Printer calibration

Align the printheads
Precise alignment between printheads is essential for color accuracy, smooth color transitions, and sharp edges
in graphical elements.
NOTE: You are recommended to align the printheads only when using a single-roll-to-roll configuration. In
particular, printhead alignment with dual rolls is not recommended.
Printhead alignment is recommended in these situations:
●

After replacing or reseating a printhead.

●

When a new substrate is loaded and the printhead-to-paper spacing changes significantly.

●

When there are print-quality problems that could be caused by printhead misalignment.

To align the printheads, go to the Internal Print Server and select Printer > Printhead alignment.
Printhead alignment can be affected by wrinkles or other substrate deformations in the print zone. Therefore, if
the printer has recently been printing, you should wait for some minutes while it cools down. Just in case, the
printer advances the substrate before aligning the printheads.

Alignment procedure
The printer prints 21 series of patterns, each one named with a letter (A–U). You must choose the best result
from each of the series (for example, number 10 in the picture below).

The alignment procedure includes both the colored printheads and the optimizer printhead, and takes about 10
minutes. It consumes printed substrate of 84 cm width x 37 cm height (33.1 × 14.6 in).
NOTE: Depending on the firmware version, this pattern could be slightly different.

172 Chapter 7 Printer calibration

ENWW

The picture below shows the distribution of printheads in the carriage. It also shows the correspondence
between printhead and patterns, with guidance on the direction of the corrections (0–40) applied.

The following table summarizes the correction type controlled by each pattern.
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Pattern

Affected printheads

Correction type

A

Optimizer

Substrate axis

B

Optimizer

Scan axis

C

c1, m1

Scan axis

D

M1, Y1

Scan axis

E

K1, C1

Scan axis

F

K1, C1

Substrate axis

G

c1, m1

Substrate axis

H

M1, Y1

Substrate axis
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Pattern

Affected printheads

Correction type

I

K

Scan axis, bidirectional

J

M

Scan axis, bidirectional

K

C

Scan axis, bidirectional

L

C, M, Y, K, c, m, opt

Scan axis, bidirectional, 1200 dpi

M

c0, m0

Scan axis

N

M0

Scan axis

O

C0

Scan axis

P

Y0

Scan axis

Q

c0, m0

Substrate axis

R

M0, Y0

Substrate axis

S

c

Scan axis, bidirectional

T

m

Scan axis, bidirectional

U

Y

Scan axis, bidirectional

Take this into account when trying to compensate for any misalignment observed in the printhead alignment
diagnostics plot.
The central correction is 20 (15 for A), being the default value for each pattern in the Internal Print Server.

Aligning the optimizer printhead
The optimizer ink is transparent, so it is not easy to detect visually. To make it easier, a background of composite
ink has been added on top of it. It highlights the optimizer, making it visible most of the time.
The patterns A and B are intended to align the optimizer printhead to the colored printheads in both directions
(scan axis and substrate axis).
The image below shows the background with the optimizer lines on top of it.

Possible difficulties with printhead alignment
The optimizer ink is invisible or hardly visible
The composite background to highlight the optimizer ink works for most substrates, but occasionally, with some
substrates, there is not enough contrast to highlight the optimizer ink. In these cases there are two possible
solutions:
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●

Load a different substrate with more contrast to perform the alignment.

●

Insert an intermediate correction (A=15, B=20), assuming the optimizer is well aligned. In this case, take a
close look afterwards for associated defects, such as bleed, halo, or wicking (see Bleed, halo, wicking
on page 392).

Another possibility is that the optimizer printhead or the colored printheads may have too many clogged nozzles,
resulting in a poor background area fill, which makes it difficult to detect the optimizer bars. In this case, see
Check and clean the printheads on page 160.

The optimizer printhead is still misaligned in the substrate axis after alignment
The optimizer printhead is staggered and there is a gap between it and the other printheads, so in the patterns A
and B a substrate advance is needed to align it to the background and the reference black. If the substrate
advance is inaccurate, the optimizer correction for the substrate axis (pattern A) may not be valid. You may
detect some bleed in the boundaries between colors in the substrate axis direction, usually when passing from
high ink density areas to lower ink density areas. In this case, ensure that the substrate advance is accurate (see
Substrate-advance compensation on page 181) before performing alignment.

A pattern shows more than one good correction
Occasionally you may find that a pattern has two or more possible good corrections, separated by two or more
steps. This could be due to wrinkles on the substrate that change the printhead-to-paper spacing along the scan
axis. To avoid this, ensure that the substrate is cold before starting the alignment, and advance it at least 70 cm
to ensure that it is not deformed by the curing of the previous job.

Printhead alignment diagnostics plot
The printer offers a printhead alignment diagnostics plot, to assess the quality of the current printhead
alignment. To print it, in the Internal Print Server select Printer > Printhead alignment > Verify alignment > Print.
NOTE: You can use the diagnostics plot to check printhead alignment, then fine-tune the values by following
the instructions on the diagnostics plot. Also, if the substrate is similar to one that you already use, you can print
only the diagnostic plot (much faster than printhead alignment) and fine-tune the values in the Internal Print
Server.
The next picture shows an example of the diagnostics plot. Each part is described following the terminology of
the manual alignment. Row0 is the row of printheads closer to the substrate output, while Row1 is the row of
printheads closer to the substrate input. In the same plot there is an area in which the carriage layout is
described with the appropriate labels, just for reference.
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Zone 1: Printhead Row0 alignment check (closer to the substrate output)
This area shows the printhead-to-printhead alignment for the first row of color printheads. Each printhead has
crosses, where it is compared to a reference printhead. In this case the black printhead has been chosen as a
reference.
The colors are labeled C0, M0, Y0, c0, m0, where the ‘0’ specifies that it is the first row of printheads. In each
case, the inner cross should be aligned with the outer cross.

In case of misalignment the arrows indicate the pattern of the manual alignment that will correct the
misalignment. Also, the ‘20’ label indicates the direction towards where the line will be moved when a ‘20’ value
is applied. For example, imagine that in the manual alignment the chosen value for L is 12, and the chosen value
for O is 7. Imagine also a misplacement in the c0:

●

Scan axis misplacement: The c0 line is displaced to the right. Since the ‘20’ arrow points to the right, if you
apply values bigger than your actual value it will be moved further to the right. But, since the vertical c0 line
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is displaced to the right, you need to move it to the left. Therefore, a value lower than your actual selection
(L=12) is needed.
●

Substrate axis misplacement: The c0 line is displaced to the top. Since the ‘20’ arrow points to the bottom,
if you apply values bigger than your actual value it will be moved to the bottom. This is just what you want,
so a value higher than the actual selection (O=7) is needed.

Zone 2: Printhead to printhead Row1 (versus Row0) alignment check
This area shows the printhead-to-printhead alignment for the second row of color printheads. Each color is
referenced to the same color in Row0. The alignment is correct if no discontinuity or step is detected in any
direction.

As in the description of the previous area, in case of misalignment the arrows indicate the pattern of the manual
alignment that will correct the misalignment. Also, the ‘20’ label indicates the direction in which the line will be
moved if a ‘20’ value is applied. For example, imagine that in the manual alignment the chosen value for D is 12,
and the chosen value for H is 7. Imagine also a misplacement in the M:

As in the previous zone, increasing D and decreasing H will help to improve the results.

Zone 3: Optimizer printhead alignment check
This area shows the optimizer-to-color printhead alignment. The optimizer is referenced to the black ink. It works
exactly the same as Zone 1. However, there is a background color that highlights the presence of the optimizer.
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Zone 4: Scan-axis bidirectional alignment check
This area shows scan-axis bidirectional alignment between colors. As in the description of the previous areas, in
case of misalignment the bottom arrows indicate the pattern of the manual alignment that will correct the
misalignment (I, J patterns). Also, the ‘20’ label indicates the direction in which the line will be moved if a ‘20’
value is applied.

This pattern is formed by a series of vertical lines, printed unpaired as follows:

The correct bidirectional alignment has been found when the Fwd and Rev lines are perfectly aligned.
The following example shows a misalignment situation with an existing correction J=13, and how to correct it.

In this case, the diagram shows that we need to change the value corresponding to the J pattern. Also it indicates
that the correction needs to be moved towards lower values, because the ‘20’ value would move it in the wrong
direction.

Color calibration
Color calibration enables your printer to produce consistent colors with a particular substrate type, even if
printheads, ink cartridges, and environmental conditions change.
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Color calibration sets the ink restriction and linearization, which varies with the drop weight of the printhead. This
calibration has been designed to provide consistency as the printhead ages (drop-weight degradation) and from
one printer to another. For example, to reach a maximum cyan density of 0.6, one printhead may require 3 drops
while another one may require 3.5 drops (lower drop weight).
There are no factory-reference color-calibration values in the printer or within the presets: the first calibration for
each substrate sets the color reference for future calibrations. The future calibrations will therefore try to match
the colors of the first calibration. In this way you maintain consistency as the printhead ages.
Good nozzle health is important, and the printheads should also be as new as possible for best performance
when you make the first calibration.
It is also important to have the printheads well aligned (see Align the printheads on page 172), and to make sure
the substrate is advancing correctly (see Substrate-advance compensation on page 181), otherwise the color
pattern may appear blurry or with slightly different colors.
To start color calibration from the Internal Print Server, select Substrate > Color calibration, then click the
Calibrate button.
NOTE: Only non-porous substrates wider than 61 cm (24 in) can be calibrated. Porous substrates cannot be
calibrated.
NOTE:

Color calibration is not recommended when the carriage beam is in a higher position than normal.

The calibration process is fully automatic and can be performed unattended after you have loaded substrate of
the type you wish to calibrate. The process takes about 15 minutes and consists of the following steps:
1.

The color calibration test chart is printed, which contains patches of different densities of each ink used in
your printer.

2.

The test chart is scanned and color-measured using the embedded spectrophotometer. If the scan cannot
be completed successfully, a message is displayed by the Internal Print Server; see Color calibration fails
on page 407.

3.

From the measurements made by the spectrophotometer, the printer calculates the necessary correction
tables to apply to your print jobs for consistent color printing on that substrate type—except in the case of
the first calibration, which sets the reference for later ones.

Calibration should be done in any of the following circumstances:
●

Whenever a new substrate type is introduced that has not yet been calibrated: to set the reference.

●

Whenever you notice excessive color differences between prints. Such color differences can be caused by
aging and wear of the printheads, installing new printheads, changes in substrate characteristics between
one roll and another, changing environmental conditions, and so on.

You can check the color calibration status of your substrates with the Internal Print Server: select Substrate >
Color calibration > Show all.
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●

Default: Color reference not set.

●

Done: Color reference set.

●

Obsolete: Calibration obsolete.

Color calibration is based on the color measurement of printed color patches, using the embedded
spectrophotometer. Some characteristics of substrates, such as surface roughness or transparency, may make
reflective color measurement of some substrate types very inaccurate. Color calibration of these substrates may
fail or produce unacceptable printing results.
TIP:

If color calibration fails at the first attempt, it is worth trying again.

To delete the reference for a given substrate, so that you can create a new reference for that substrate, you must
reset the color calibration. In the Internal Print Server, select Substrate > Color calibration > Reset.
You should calibrate a substrate type before creating its color profile; however, you can later recalibrate without
needing to recreate the color profile.

Color consistency between different HP Latex 3000 printers
It is possible to print consistent colors on different HP Latex 3000 printers by exporting a calibrated substrate
preset (see Substrate presets on page 102) from one calibrated printer to another. This process ensures that
both printers use the same color references.
1.

Create the reference for the first printer: do at least the first color calibration with the substrate in question.

2.

Export the substrate preset from the first printer. The reference is also exported.

3.

Import the substrate preset to the second printer.

4.

Perform color calibration with the same substrate for the second printer, to make it consistent with the
reference imported with the preset.

Now both printers have the same reference for the same substrate, and all the consecutive color calibrations will
be trying to match this reference state.

Color profiles
Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For instance, if
your printer prints all colors as black, its colors may be consistent but they are not accurate.
In order to print accurate colors, it is necessary to convert the color values in your files to the color values that will
produce the correct colors from your printer, your inks, and your substrate. An ICC color profile is a description of
a printer, ink, and substrate combination that contains all the information needed for these color conversions.
These color conversions are performed by your Raster Image Processor (RIP), not by the printer. For further
information on the use of ICC profiles, see the documentation for your application software and for your RIP.
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Substrate-advance compensation
Accurate substrate advance is important to print quality because it is part of controlling the proper placement of
dots on the substrate. If the substrate does not advance the proper distance between printhead passes, light or
dark bands appear on the print, and there may be an increase in graininess.
The printer has a substrate-advance sensor and is calibrated to advance correctly with most of the substrates
that appear in the Internal Print Server. When the substrate is loaded, the substrate-advance sensor checks the
substrate and decides whether it can be adjusted automatically or not. If not, the automatic adjustment is
disabled.
If the substrate cannot be adjusted automatically by the substrate-advance sensor and the substrate advance is
not correct, you may wish to change the substrate-advance compensation manually. See Troubleshoot printquality issues on page 378 for steps to determine whether substrate-advance compensation will help you. In
general, substrate-advance calibration is recommended when you see print-quality problems related to
substrate advance, or when you define a new substrate.
NOTE: Manual substrate-advance compensation is available only when the substrate-advance sensor is
disabled—automatically, or manually through the Printing adjustments button in the Internal Print Server main
window.
The substrate-advance sensor may not work correctly if it is dirty. See Clean the substrate-advance sensor
on page 204.
If the sensor was dirty, after cleaning it the advance compensation already calculated may not be valid, so you
are recommended to set the advance compensation for this substrate to zero and check that the advance is
correct. If the advance is still not accurate, follow the advance compensation process, bearing in mind that the
sensor is not dirty and probably your substrate type is not compatible with it.

Manual substrate-advance compensation
While printing, you can view and change the substrate-advance compensation of the currently loaded substrate
at any time from the Internal Print Server by selecting the print job and then the Printing Adj. button, or by
selecting Printer > Printing adjustments.
Alternatively, you can use the Print adjustment button in the Internal Print Server main window. This opens a
dialog box with an advance compensation section, in which there are three main areas:
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1.

Check the box to enable the OMAS (substrate-advance sensor). If it is disabled automatically while loading,
you cannot enable it. However, if you disable it yourself, you can re-enable it.

2.

If the substrate-advance sensor is disabled, you can increase or decrease the substrate-advance
compensation.

3.

Three images of possible defects due to substrate-advance issues, to help to you decide whether the
substrate-advance compensation should be increased or decreased.

In order to apply and save the values, press the Apply button in the dialog box before closing it. Then the
substrate-advance compensation value is saved for that particular substrate. Other substrates are not affected.
If you are using a generic substrate preset, you are recommended to clone the preset (Substrate > Clone) and
work with that before adjusting the substrate-advance compensation, as the print adjustment is not available for
generic presets. See Edit a substrate preset on page 110.

Substrate-advance test print
The substrate-advance test print can help you to adjust the substrate advance more accurately. In the Internal
Print Server, select Printer > Advance calibration. The printer prints several repetitions of a special numbered
pattern that help you to apply the correct substrate-advance adjustment. Locate the pattern in the center of the
substrate.
NOTE: Printheads must be correctly aligned before the test.

The following steps describe the process to determine the IPS Printing adjustment dialog advance compensation
value.
1.

While the test is being printed, in the last 8–10 plots of the substrate central pattern (the sides might be
affected by skew), locate the value that corresponds to the lightest column.
TIP: If the test shows two possible values (two continuous columns), the value selected is the average of
both values. For example, if the test says the value could be +2.0/+3.0, then +2.5 is selected.

2.

Via IPS > Printer > Printing adjustments, look for the current advance value set and add to this number the
value chosen in step number 1. For example, if the value shown in the Printing adjustment dialog is -2.0
and the chosen value in the first step is +2.5, then the value chosen should be +0.5.
NOTE:

The print adjustments dialog is only enabled when printing with non-generic substrate presets.
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3.

Insert the chosen advance compensation value, and select Apply to implement the change.

By applying the correct advance compensation value, the lightest columns should be located at value 0. This
means the printer compensates for the substrate advance error, and provides good substrate feed.
NOTE: The manual substrate advance compensation obtained through this process is only usable for the
loaded substrate. It is important to note that this value cannot be used on another printer. If you planned to use
the same substrate on multiple printers you need go through the complete process on each printer.
TIP: The value used for the substrate advance depends directly on the thickness of the substrate, and needs to
be changed only when you are suffering print-quality issues that are caused by the substrate advance, as
explained in Substrate-advance sensor check on page 383. To obtain the right value faster and more accurately,
see the following table:
Normal substrate advance value based on substrate thickness
50 µm (2 mil)

150 µm (5.9
mil)

250 µm (9.8
mil)

400 µm (15.7
mil)

550 µm (21.7
mil)

700 µm (27.6
mil)

850 µm (33.5
mil)

1000 µm
(39.4 mil)

+1.8 ‰

+0.9 ‰

0

−1.0 ‰

−1.8 ‰

−2.7 ‰

−4.5 ‰

−6.8 ‰

Calibrations specific to one substrate preset
Some calibrations that the printer performs are specific to the substrate preset in use at the time the calibration
was performed and some are not. The calibrations that are specific to one substrate must be performed again if
the substrate or preset is changed. Shown below are the calibrations showing which ones are specific to one
preset and which ones are not:
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●

Printhead Alignment: This is applied to all presets and print modes. Usually, when switching from one
substrate to another, there is no need to realign the printheads. However, if the printhead-to-paper spacing
has changed significantly (different thickness, etc.), then the printheads should be realigned.

●

Substrate Advance Compensation: This is specific to each substrate preset.

●

Color Calibration: This is specific to each substrate preset.
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Recommended calibrations after particular events
Printhead
replacement

New substrate
created

New substrate
imported

New substrate
loaded

Print mode
changed

Printhead
alignment

Recommended

Not needed
unless new
substrate has
different
thickness

Not needed

Not needed
unless carriage
beam has moved

Not needed

Recommended if
relevant

Color calibration

Recommended

Recommended

Recommended

Not needed,
unless never
done before

Not needed

Recommended if
relevant

Substrate advance
compensation

Not needed

Not needed, as
long as the
substrateadvance sensor
is working

Not needed, as
long as the
substrateadvance sensor
is working

Not needed, as
long as the
substrateadvance sensor
is working

Not needed

Recommended if
relevant
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8

HP Print Care

Print Care is a program that helps you to maintain your printer in optimal condition and advises you how to solve
any problems that occur. It can also give you full information about the current status and past history of the
printer.
The program is already installed in the printer's built-in computer; you can run it by clicking its icon in the
Windows Quick Launch toolbar, or by double-clicking some parts of the Internal Print Server (for instance, Print
Care status).

Its functions are divided into the following categories..
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●

Production Information displays information about printer status and printing history (paper usage, ink
usage, jobs). The information can be displayed in graphical charts or text reports, all of which you can filter
to select different subsets of information.

●

Maintenance prompts you to perform maintenance tasks, and provides instructions on how to perform
them. It can also list the maintenance tasks that have been performed in the past, and the printer
messages that have been displayed in the past.

●

Diagnostics can run functional tests on printer systems and components to check for failures and
malfunctions. Each diagnostics run generates a report that provides detailed results and troubleshooting
instructions. It can also list the tests that have been run in the past. See Print Care diagnostics on page 186
for more details.
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NOTE:
●

Individual tests are not selectable: the whole series of tests is run automatically.

Printer Tools help you to perform maintenance operations without an Internet connection.

The Print Care program has online help that explains all its functions in detail.
To change the units of measurement in Print Care, select Edit > Preferences > Units.
Print Care uses the language selected in the Windows Regional and Language Options; to change the language,
see Change the language of the Internal Print Server on page 21.

Print Care diagnostics
The Print Care diagnostics help you to minimize downtime. When you call your support representative to report
an issue, pass on the results of any diagnostics that you ran.
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Most of these diagnostics can be run with the printer started normally. However, if you experience a severe error
in the start-up progress that prevents you from running the diagnostics, an extra start-up mode has been
provided for this situation. To use it, go to Print Care and select Printer Tools > Power options > Reboot in
diagnostic mode. Then the printer will start only a minimal set of components, so the progress bar in the Internal
Print Server will stop at around 20% and display Diagnostic mode. You can then go to the Diagnostics section
and run the diagnostic you need.
NOTE:

Read the descriptions of the diagnostics and follow the instructions.

IMPORTANT:

When the printer is started in diagnostic mode, it is unable to print.

When you have finished the diagnostics, select Printer Tools > Power options > Reboot to restart the printer
normally.
When you get a message from the printer with a numerical code in the form XX.XX.XX.XX:XX, we recommend
locating the first two digits in the following table to identify the correct diagnostic.
Number

Subsystem

01

E-box

10

E-cabinet

11

Printhead control link

15

Drying

16

Curing

21

Drop detector/Capping station

22

Ink distribution system

41

Substrate path mechanics

43

Substrate path vacuum system

46

Printhead primers

47

Printhead cleaning roll

48

Scan beam

49

Carriage aerosol

50

Substrate advance sensor

51

Safety interlocks

52

Drop detector

55

Carriage sensors

58

Carriage sensors

86

Scan axis

NOTE: Some of these subsystems may be available only to service engineers, because they require specific
knowledge or for safety reasons.
NOTE: In any case we recommend running the Safety Interlocks diagnostic to ensure that printing is not
disabled by a safety interlock.
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Update the Print Care software
While the printer is connected to the Internet, Print Care checks periodically for updates. An alert will pop up if an
update is available. When this happens, follow the instructions to update the software.
NOTE: This update applies only to the Print Care software engine. The maintenance wizards and other content
are accessed directly in the cloud every time they are needed. Therefore, they are automatically updated as soon
as the content in the cloud is updated.

Reinstall the Print Care software
If Print Care needs to be reinstalled, contact your service representative.
NOTE: Print Care needs to be reinstalled whenever the printer changes ownership.
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Hardware maintenance

WARNING! Hardware maintenance may be performed by trained personnel only. During printer installation, the
designated personnel received training for safe operation and maintenance of the printer. It is not allowed to use
the printer without this training.

Safety precautions
Read and follow the safety precautions section to make sure you use the equipment safely: see Safety
precautions on page 2.
You are expected to have the appropriate technical training and experience necessary to be aware of hazards to
which you may be exposed in performing a task, and to take appropriate measures to minimize the risks to
yourself and to others.

User maintenance kits
Maintenance resources
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Cleaning kit

When

Who

On demand
clean

User

X

X

Weekly
maintenance

User

X

X

125 liter
maintenance

User

X

X

500 liter
maintenance

User

1500 liter
maintenance

User

3000 liter
maintenance

Contact your
support rep.

Dual side
clean

User

Ink collector
daily
maintenance

User

Ink collector
40 liter
maintenance

User

User
maintenance
kit

Service
maintenance
kit

Textile
service
maintenance
kit

User up-time
kit

Reseller uptime kit

Inbox

X

X
X
X

X
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Maintenance resources

Cleaning kit

User
maintenance
kit

Service
maintenance
kit

Textile
service
maintenance
kit

User up-time
kit

Reseller uptime kit

Ink collector
500 liter
maintenance

User

X

Ink collector
1500 liter
maintenance

Contact your
support rep.

User repair

User

Service
repair

Contact your
support rep.

X

Full printer
inspection

Contact your
support rep.

X

X

HP Latex 3x00 Printer Series maintenance kits and tools
Name

Part number

Purpose

How to order

HP Latex 3x00 Series Cleaning Kit

CZ056-67390

Weekly maintenance, and the 125
liter maintenance routines (about 12
times)*

Provided with your printer and
included in the Printer Maintenance
Kit

For the 125 liter maintenance
routines*

Provided with your printer

Carriage Rail Cleaning Tool
HP Latex 3000 Series Printer
Maintenance Kit

1HA07-67008 /
1VT19A

For the 1500 liter maintenance
routines*

Through the usual channel

HP Latex 3x00 Series Standard
Uptime Kit

D4J02A /
CZ056-67421

Set of spare parts that can be
replaced by customers and resolve
the most common failures

Provided with your printer in most
locations worldwide. If necessary, you
can purchase the kit through the
usual channel.

HP Latex 3x00 Expert Kit

1HA07-67041

Set of spare parts that can be
replaced by expert/trained
customers

Through the usual channel

NOTE: For the latest information on kits available for your printer, and their contents, see http://www.hp.com.
*Frequencies are approximate and will depend on print mode usage.

HP Latex 3x00 Printer Cleaning Kit contents
Part

Quantity Use in maintenance

Flex cleaner and 12 flex sponges

1 Clean printhead contacts, printhead side (see The Internal Print Server
recommends replacing or reseating a printhead on page 401)

Brush

1 Clean printhead contacts, carriage side (see The Internal Print Server
recommends replacing or reseating a printhead on page 401)

Cotton swabs

Carriage rail cleaning wicks
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100 Clean the substrate advance sensor (OMAS) (see Clean the substrate-advance
sensor on page 204) and the line sensor (see Clean the bottom of the
carriage, the drying glasses, and the line and crash sensors on page 238)
6 bags of 20 Cleaning (see Clean the carriage rails and replace the oiler foams
on page 216)
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Part

Quantity Use in maintenance

Lubricant oil

3 bottles of 10 Lubrication (see Clean the carriage rails and replace the oiler foams
ml on page 216)

Oiler foams

6 bags of 2 Replacement (see Clean the carriage rails and replace the oiler foams
on page 216)

Oiler wicks

12 sets Replacement (see Clean the carriage rails and replace the oiler foams
on page 216)

Grease syringe

3 ml Grease small parts; but not for greasing carriage beam screws

Cleaning sponges

6 General cleaning

Plastic gloves
E-cabinet and e-box filters

6 sets General maintenance processes
6 sets of 2 Fan filters replacement (see Replace the e-cabinet fan filters on page 256)

HP Latex 3x00 Printer Maintenance Kit contents
Content

Quantity

Cabinet Ebox filters assembly

2

Printhead cleaning rubber assembly

3

HP Latex 3x00 Cleaning Kit

1

Upgrade 5 printhead cleaning rubber blades

1

Machine Grease and Oil kit

1

Pads

1

Diverter wheels

2

NOTE:

The contents of the kit may vary.

NOTE: Some keys are provided with the printer. See Safety precautions on page 2 to identify the one you may
require for maintenance operations.
Use the keys only for accessing the intended doors and keep them always under your control. Store them in a
safe and secure place.
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Maintenance tools recommended but not provided

Spiral steel scourer, for Clean the bottom of
the carriage, the drying glasses, and the line
and crash sensors on page 238; Clean the
drying module quartz glass and air outlet
on page 305; and Clean the drop-detector
ink deposits on page 242.

Absorbent all-purpose cloth, for cleaning
covers.

Isopropyl alcohol, for cleaning

Distilled water, for general cleaning

Vacuum cleaner, handy or normal, with
nozzle accessories; for Clean the rear scanaxis beam on page 264.

Flashlight, for general use.

Folding steps, for general use.

A flat screwdriver.

Torx screwdriver set

NOTE: If you are in an area (such as
California) that regulates VOC cleaning and
maintenance fluids, instead of isopropyl
alcohol use a VOC-certified cleaner such as a
properly diluted Simple Green All-Purpose
Cleaner.

How to perform maintenance operations
The Maintenance section of the Print Care program (see HP Print Care on page 185) reminds you when routine
hardware maintenance should be done.

Perform maintenance with Print Care wizards
If your printer is connected to the Internet, Print Care provides guidance (wizards) to help you to perform the
maintenance operations correctly. Click the maintenance operation and the wizard will appear; then follow its
instructions.
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IMPORTANT: Strictly follow all the recommended steps for safety reasons. For example, switching the printer
off protects you from electric shock and hazardous moving parts, among other risks; it may also be required for
other reasons.
IMPORTANT:

Follow the wizard to the end so that the appropriate alert is reset automatically.

The wizard has the necessary buttons so that all printer actions, such as moving the carriage beam, can be done
directly from the wizard when they are needed.
It also provides instructions to replace parts and resolve the most common failures.
Because this information is in the HP cloud, HP can update and improve it so that Print Care will always show the
latest version.

Perform maintenance without Print Care wizards
IMPORTANT: If your printer is not connected to the Internet, you must perform maintenance operations
manually with the help of this guide. Without a connection:
●

The alerts are never reset. Both the Internal Print Server and Print Care always show a red alert for
maintenance status.

●

Tracking the maintenances must be done manually, according to the time and ink usage thresholds shown
in the Summary of maintenance operations on page 198.

●

This guide appears in the Print Care window, for reference, instead of the list of maintenances.

HP strongly recommends an Internet connection as it makes it much easier to deal with the maintenance tasks
of the printer, in addition to providing auto-update of the maintenance procedure and automatic notification of
firmware upgrades. Contact your service representative for more information.
IMPORTANT: Strictly follow all the recommended steps for safety reasons. For example, switching the printer
off protects you from electric shock and hazardous moving parts, among other risks; it may also be required for
other reasons.
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The following printer-system movements and processes are required during maintenance operations. The
Printer tools menu in Print Care can be used when the printer is not connected to the Internet. Remember to
follow all the safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

●

●

To move the carriage beam, select Printer tools > Move the carriage beam.
–

Move up

–

Move down

To move the printhead carriage, select Printer tools > Move the printhead carriage.
–

Move to the service position

–

Move to the leftmost position

–

Move to the normal position
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●

To move the drive roller, select Printer tools > Move the drive roller.
–

Move (backwards)

–

Move (forwards)

–

Stop

Other warnings

●

–

Keep your clothing and all parts of your body away from the printer's moving parts.

–

Avoid wearing necklaces, bracelets, and other hanging objects.

–

If your hair is long, try to secure it so that it will not fall into the printer.

–

Do not touch gears or moving rolls during printing.

To move the rubber blade, select Printer tools > Move the rubber blade.
–

Move to service position

–

Move to normal position

How to turn the printer off and on for maintenance operations
IMPORTANT: When performing maintenance operations, always turn the printer off and on as described below.
Do not use the normal procedure.
IMPORTANT:

Strictly follow all the recommended steps, for safety reasons.

NOTE: If your printer is connected to the Internet, you do not need to remember these instructions, because
they are included in the maintenance wizards.

Turn the printer off
1.
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In Print Care, select Printer tools > Power options > Shutdown.

How to turn the printer off and on for maintenance operations 195

CAUTION: The shutdown process takes some time to complete. Wait until the green power light is off
before proceeding.
2.

Turn off the printer using the main switch at the front right of the printer.

CAUTION: With this procedure, the printhead carriage will not return to the normal position, and therefore
the printheads will remain uncapped. Make sure the maintenance operation is done quickly to minimize the
time in which the printheads are uncapped.

Turn the printer on
1.

Turn on the printer using the main switch at the front right of the printer.
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2.

Pay attention to the Internal Print Server and rearm the printer when requested, as usual.

CAUTION: In some maintenance procedures, the carriage beam is up when you turn on the printer, and the
carriage moves during initialization. Avoid putting any part of your body in the print area.
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Summary of maintenance operations
Maintenance operations for all substrates
Frequency

Maintenance operation

Cross-reference

Part number and/or description

Weekly

Clean the print zone

Clean the print zone on page 202

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Clean the substrate-advance sensor

Clean the substrate-advance sensor
on page 204

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Clean the aerosol filters

Clean the aerosol filters on page 206

Brush

Clean the pinchwheels and drive
roller

Clean the pinchwheels and drive
roller on page 209

Clean lint-free cloth and distilled
water

Clean the output platen

Clean the output platen on page 211

Clean lint-free cloth

Empty the condensation collector
bottle

Empty the condensation collector
bottle on page 213

Clean the carriage rails and replace
the oiler foams

Clean the carriage rails and replace
the oiler foams on page 216

Empty the oil collector caps

Empty the oil collector caps
on page 229

Clean the bottom of the carriage, the
drying glasses, and the line and crash
sensors

Clean the bottom of the carriage, the
drying glasses, and the line and crash
sensors on page 238

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Clean the drop-detector ink deposits

Clean the drop-detector ink deposits
on page 242

Scourer (not provided)

Clean the e-cabinet fan filters

Clean the e-cabinet fan filters
on page 245

HP Latex 3x00 Printer Cleaning Kit,
included in your printer

Clean the e-box fan filter

Clean the e-box fan filter
on page 247

HP Latex 3x00 Printer Cleaning Kit,
included in your printer

Clean substrate input/output gears
and spindle metal debris

Clean substrate input/output gears
and spindle metal debris on page 250

Brush

Replace the rubber blade

Replace the rubber blade
on page 252

1HA07-67008 or 1VT19A: Printer
Maintenance Kit

Every 125 liters
of ink

Every 500 liters
of ink

HP Latex 3x00 Printer Cleaning Kit
and Carriage Rail Cleaning Tool,
provided with your printer

Spare printhead cleaning blades
provided with your printer.
Every 1500 liters
of ink

Replace the e-cabinet fan filters

Replace the e-cabinet fan filters
on page 256

HP Latex 3x00 Printer Cleaning Kit,
included in your printer

Replace e-box fan filter

Replace e-box fan filter on page 258

HP Latex 3x00 Printer Cleaning Kit,
included in your printer

Clean the impinging plate

Clean the impinging plate
on page 261

Clean lint-free cloth and distilled
water

Clean the vapor removal external
filter

Clean the vapor removal external
filter on page 263

Brush and vacuum cleaner

Clean the rear scan-axis beam

Clean the rear scan-axis beam
on page 264

Vacuum cleaner and an absorbent
all-purpose cloth (not provided)

Clean and grease the substrate drive
transmission gears and rods

Clean and grease the substrate drive
transmission gears and rods
on page 267

Grease and oil kit, included in the
Printer Maintenance kit. Gloves (not
provided)

Grease the carriage beam screws

Grease the carriage beam screws
on page 268

1HA07-67008 or 1VT19A: Printer
Maintenance Kit
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Maintenance operations for all substrates (continued)
Frequency

Every 1500 liters
of ink: check and
replace if
required

Maintenance operation

Cross-reference

Part number and/or description

Clean and grease the service station
transmission and rods

Clean and grease the service station
transmission and rods on page 270

Grease and oil kit, included in the
Printer Maintenance kit. Gloves (not
provided)

Empty the drop detector ink vessel

Empty the drop detector ink vessel
on page 271

Replace the rubber blade

Replace the rubber blade
on page 252

Clean the carriage rails and replace
the oiler foams

Clean the carriage rails and replace
the oiler foams on page 216

HP Latex 3x00 Printer Cleaning Kit
and Carriage Rail Cleaning Tool,
provided with your printer

Grease the printhead primers

Grease the printhead primers
on page 273

Grease and oil kit, included in the
Printer Maintenance kit.

Replace the rocker pads

Replace the rocker pads on page 337

Replace curing fan and resistors
Replace substrate output spindle
lever
Replace bearings
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Every 3000 liters
(approx. once
every 5 years)

3000 liters can be reached by printing
480,000 m² with 4 passes, or
320,000 m² with 6 passes, or
190,000 m² with 8 passes

To be done by a service engineer. Call
your service representative (see
HP Customer Care Centers
on page 409).

When required

Check and clean printheads

Check and clean the printheads
on page 160

Check the printer for dust and
aerosol

Check the printer for dust and
aerosol on page 277

Clean lint-free cloth and distilled
water

Check the print output areas for ink
droplets or condensation

Check the printer for dust and
aerosol on page 277

Clean lint-free cloth and distilled
water

Clean and check the substrateadvance sensor

Clean the substrate-advance sensor
on page 204

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Replace a pinchwheel submodule

Replace a pinchwheel submodule
on page 278

CZ056-67097: Pinch assembly,
included in the HP Latex 3000 Series
Standard Uptime Kit (D4J02A)

Replace a primer

Replace a primer on page 280

CZ056-67396 for HP Latex
3000/3100/3500. 1HA07-67018 for
HP Latex 3200/3600: Primer and
latch, included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A)

Replace the aerosol module fans

Replace the aerosol fan module
on page 286

CZ056-67246: Aerosol top case
assembly, included in the HP Latex
3000 Series Standard Uptime Kit
(D4J02A)

Replace the drying fans array

Replace the drying fans array
on page 290

CZ056-67023: Drying fan case right
or CZ056-67024: Drying fan case
left, both included in the HP Latex
3000 Series Standard Uptime Kit
(D4J02A)

Replace the drying lamps

Replace the drying lamps
on page 295

When required, use CZ056-67322:
Drying NIR lamp, included in the
HP Latex 3000 Series Standard
Uptime Kit (D4J02A)
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Maintenance operations for all substrates (continued)
Frequency

Maintenance operation

Cross-reference

Part number and/or description

Clean the drying module quartz glass
and air outlet

Clean the drying module quartz glass
and air outlet on page 305

Clean lint-free cloth and distilled
water

Replace the drying quartz glass

Replace the drying quartz glass
on page 311

CZ056-67252: Drying quartz glass
right or CZ056-67253: Drying quartz
glass left, both included in the
HP Latex 3000 Series Standard
Uptime Kit (D4J02A)

Replace a curing fan and resistor
module

Replace a curing fan and resistor
module on page 315

CZ056-67054: Curing heater and fan
module, included in the HP Latex
3000 Series Standard Uptime Kit
(D4J02A)

Replace a service station cap

Replace a service station cap
on page 319

CZ056-67036: SVS Caps Kit, included
in the HP Latex 3000 Series Standard
Uptime Kit (D4J02A)

Replace an intermediate tank

Replace an intermediate tank
on page 322

CZ056-67073: ISM intermediate
tank, included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A)

Replace an e-cabinet fuse

Replace an e-cabinet fuse
on page 324

CZ056-67136: E-cabinet PCA Fuses
Kit, included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A)

Clean the printhead contacts

Clean the printhead contacts
on page 326

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Replace a spindle valve

Replace a spindle valve on page 331

Q6702-67025: Spindle air valve,
included in the HP Latex 3000 Series
Standard Uptime Kit (D4J02A)

Clean the roll-to-free-fall roller and
pinchwheels

Clean the roll-to-free-fall roller and
pinchwheels on page 333

Clean lint-free cloth, and possibly
isopropyl alcohol (for persistent dirt)

Clean the carriage rails manually

Clean the carriage rails manually
on page 334

Clean lint-free cloth and distilled
water

Grease the printhead primers

Grease the printhead primers
on page 273

Grease and oil kit, included in the
Printer Maintenance kit.

Pinch clamp replacement

Pinch clamp replacement
on page 336

Replace the rocker pad

Replace the rocker pads on page 337

Clean the scan axis encoder

Clean the scan axis encoder
on page 338

Replace the curing module side
rubber

Replace the curing module side
rubber on page 339

Clean the service station caps

Clean the service station caps
on page 340

Clean the vapor removal external
filter

Clean the vapor removal external
filter on page 263

Brush

Clean the bottom of the carriage, the
drying glasses, and the line sensor

Clean the bottom of the carriage, the
drying glasses, and the line and crash
sensors on page 238

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Empty the condensation collector
bottle

Empty the condensation collector
bottle on page 213

200 Chapter 9 Hardware maintenance

Gloves. Clean lint-free cloth and
distilled water
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Maintenance operations for all substrates (continued)
Frequency

Maintenance operation

Cross-reference

Part number and/or description

Empty printhead cleaning waste
bottle

Empty the printhead cleaning waste
bottle on page 342

Clean the perforated plate

Clean the perforated plate
on page 343

Clean lint-free cloth and distilled
water

Additional maintenance operations for porous substrates
Frequency

Maintenance operation

Cross-reference

Part number and/or description

Ink collector 3
liter/daily
maintenance

Clean the aerosol filters

Clean the aerosol filters on page 206

Dry aerosol and a brush

Wipe the protector

Wipe the protector on page 347

Clean lint-free cloth and distilled
water

Wipe the ribs of the ink collector
modules

Wipe the ribs of the ink collector
modules on page 348

Clean lint-free cloth and distilled
water

Clean condensation from the output
platen and output beams

Clean condensation from the output
platen and output beams
on page 213

Clean lint-free cloth

Clean the aerosol filters

Clean the aerosol filters on page 206

Dry aerosol and a brush

Wipe the protector

Wipe the protector on page 349

Clean lint-free cloth

Wipe the ink collector modules

Wipe the ink collector modules
on page 349

Clean lint-free cloth

Clean the curing module and airlet
plates

Clean the curing module and airlet
plates on page 350

Clean lint-free cloth dampened with
isopropyl alcohol

Clean the print zone

Clean the print zone on page 202

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Clean the substrate-advance sensor

Clean the substrate-advance sensor
on page 204

HP Latex 3x00 Printer Cleaning Kit,
provided with your printer

Replace the ink collector foams

Replace the ink collector foams
on page 353

Clean the curing module and airlet
plates

Clean the curing module and airlet
plates on page 350

Clean lint-free cloth dampened with
isopropyl alcohol

Clean condensation from the output
platen and output beams

Clean condensation from the output
platen and output beams
on page 213

Clean lint-free cloth

Clean the curing fan grid and internal
foam

Clean the curing fan grid and internal
foam on page 355

Clean lint-free cloth dampened with
isopropyl alcohol

Clean the curing module and airlet
plates

Clean the curing module and airlet
plates on page 350

Curing Heater and Fan Module Kit
(CZ056-67054), included in the
HP Latex 3000 Series Standard
Uptime Kit (D4J02A)

Replace a curing fan and resistor
module

Replace a curing fan and resistor
module on page 315

CZ056-67054: Curing heater and fan
module, included in the HP Latex
3000 Series Standard Uptime Kit
(D4J02A)

Ink collector:
after uninstalling
the ink collector
kit maintenance

Ink collector 40
liter maintenance

Ink collector 500
liter maintenance
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Additional maintenance operations for porous substrates (continued)
Frequency

Ink collector
1500 liter
maintenance

Maintenance operation

Cross-reference

Part number and/or description

Replace the protector and textile
substrate edge holder

Replace protector and textile
substrate edge holder on page 358

To be done by a service engineer. Call
your service representative (see
HP Customer Care Centers
on page 409).

Mandatory
You must perform an automatic printhead check and clean every morning. See Check and clean the printheads
on page 160.

Weekly
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required weekly:
●

Clean the print zone on page 202

●

Clean the substrate-advance sensor on page 204

●

Clean the aerosol filters on page 206

●

Clean the pinchwheels and drive roller on page 209

●

Clean the output platen on page 211

●

Empty the condensation collector bottle on page 213

Clean the print zone

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2
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The platen should be cleaned whenever it is visibly dirty, or when you notice marks on the back of the substrate.
Before cleaning the platen, take notice of the substrate-advance sensor in the middle of the platen: clean it, but
be careful to avoid scratching it.
If you sometimes print with very small side margins and with substrate edge holders, ink may accumulate on the
edge holders, which can cause smears on your prints and blocked nozzles in the printheads.
Check the substrate edge holder strips weekly for dried ink or any other defect. If necessary, replace the strip
with a new one. See Replace an edge holder strip on page 46.
Prepare to clean the print zone
1.

Ensure that you have the HP Latex 3x00 Printer Cleaning Kit, provided with your printer.

2.

Ensure that the printer is not printing.

3.

Unload the substrate.

4.

Ensure that all windows, covers, and doors are closed and remain in their original positions.

5.

Move the carriage beam to its highest position (this takes about 2 minutes).

6.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

7.

Open the front door.

Remove the edge holders (if they are in use)
1.

Remove the two substrate edge holders from the platen.

2.

Replace the edge holder strips if necessary. See Replace an edge holder strip on page 46.

Clean the platen
▲

ENWW

Clean the platen with a clean cloth dampened with distilled water, and make sure that the platen is dry
before printing.
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Clean the substrate-advance sensor
▲

See Clean the substrate-advance sensor on page 204.

Clean the substrate-advance sensor

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Remember that porous substrates, or substrates with porous liners, are not supported and should not be used
with your printer. However, under normal printing conditions with non-porous substrates, some dirt, dust, and
ink aerosol can reach the substrate-advance sensor window and impair the performance of the sensor.
Prepare to clean the substrate-advance sensor
1.

Ensure that you have the HP Latex 3x00 Printer Cleaning Kit, provided with your printer.

2.

Ensure that the printer is not printing.

3.

Unload the substrate.

4.

Ensure that all windows, covers, and doors are closed and remain in their original position.

5.

Move the carriage beam to its highest position (this takes about 2 minutes).
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6.

Open the front door.

Clean the substrate-advance sensor

ENWW

1.

Find the sensor in the middle of the platen.

2.

Clean the platen area around the sensor thoroughly with a clean cloth dampened with distilled water.
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3.

Wipe the sensor window with one of the cotton swabs provided in the Printer Cleaning Kit, slightly
dampened (not soaked) with isopropyl alcohol, to remove dried ink. If the sensor window is heavily coated
with dry ink, you may need to apply some pressure while wiping, helping the cotton to absorb the ink.

4.

Continue cleaning with fresh swabs until the cotton stays clean and the sensor window looks clean.
TIP: When reflecting ambient light, a clean sensor window shows a blue-colored reflection that should
extend uniformly across its whole surface. You can see this reflection by moving closer and slightly
changing your angle of view.

Finish off cleaning the substrate-advance sensor
1.

Wait 3 or 4 minutes, so that the alcohol can evaporate completely.

2.

Close the front door.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage beam back to its normal position (this takes about 2 minutes).

5.

Run a diagnostic test to check that the sensor is now working correctly.

Clean the aerosol filters

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

The aerosol filters should be kept clean for optimal performance and reliability.
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1.

Ensure that the printer is not printing.

2.

Ensure that all windows, covers, and doors are closed and remain in their original positions.

3.

Open the service position window.

4.

Open one latch on the left side of each aerosol filter module.
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5.

Open the lid of each filter.

6.

Remove both aerosol filters, using their handles.

7.

Use a flat screwdriver to remove the dry aerosol and then a brush to remove any remaining dirt. Try to
avoid loose dirt falling into the filter.
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8.

Reinsert both filters. There is only one way to insert them that works. If you feel resistance, try to insert the
filter the other way round.

9.

Close the lids.

10. Close the latches.
11. Close the service position window.

Clean the pinchwheels and drive roller

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

For more safety information, see Safety precautions on page 2

The drive roller should be cleaned whenever it is visibly dirty, or when you notice that substrate advance is no
longer smooth and regular.
Prepare to clean the pinchwheels and drive roller
1.

Ensure that the printer is not printing.

2.

Unload the substrate.

Clean the pinchwheels
1.

ENWW

Open the latches.
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2.

Pull the pinchwheel module to its lowest position.

3.

Clean the pinchwheels carefully with a cloth dampened with water; do not use petroleum-based cleaning
liquids.

Clean the drive roller
1.

Start the drive roller moving slowly backwards.
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2.

Clean the roller with a clean cloth dampened with distilled water; do not use petroleum-based cleaning
liquids.
CAUTION: Take care not to allow the roller to trap your hands while cleaning (this is less likely if it is
moving backwards).

3.

Stop the drive roller.

4.

Wait until the roller is dry.

5.

Return the pinchwheel module to its original position and close the latches.

Clean the output platen

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

The output platen is made of plain sheet metal with two rows of plastic ramps.
Prepare to clean the output platen
1.

Ensure that the printer is not printing.

2.

Unload the substrate.

3.

Turn off the printer in the correct manner for maintenance operations: see Turn the printer off on page 195.

4.

Wait for the curing modules to cool down (approx. 5min).

Pull out the curing assembly
1.

ENWW

Open the front door.
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2.

Open the curing module latches.

3.

Pull out the curing assembly.

Clean the output platen
▲

In order to clean the output platen, access it from the top of the curing module.
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Clean condensation from the output platen and output beams
1.

If working with the ink collector, extra action is required to the clean condensation from the output platen
and output beams when removing the ink collector. Make sure that no condensation is left on the output
platen, the bottom plate sides, or the paper path.

2.

Check that the window rubber is not broken.

3.

Clean the underneath part of the printer. Sitting or lying on the floor, clean the printer with a lint-free cloth
dampened with distilled water.

4.

Make sure there is no condensation or dirt in the following parts:

5.

●

Under the print zone and the structure beam sides

●

Roll-to-free fall and/or diverters

●

Drive roller

Open the printhead cleaning door and remove condensation or dirt from the substrate input drive motor.

Finish off cleaning the output platen
1.

Push the curing assembly back to its working position.

2.

Close the curing latches.

3.

Put the spindle back in position.

4.

Ensure that the cleaned parts are completely dry and all vapor has completely evaporated.

Empty the condensation collector bottle
TIP:

You are recommended to wear gloves for this operation.

The condensation collector bottle is stored behind the left cover at the front of the printer. You can see the level
of liquid in the bottle through a narrow window at the bottom of the cover.

ENWW
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The bottle should be emptied before it is full, which will typically be after about 60–70 liters of ink have been
used. You should check the bottle periodically, depending on your usage of the printer.
Empty the bottle
1.

To remove the bottle, first open the two locks on the left, then open the cover; the hinges are on the right.

2.

Remove the bottle.
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3.

Empty the bottle.

NOTE: The bottle collects a mixture of ink additives and water. Dispose of it according to local regulations.
The waste-profile datasheet contains the required information for correct disposal. This document is
located here: https://hplatexknowledgecenter.com/applications/wasteprofiles/.

ENWW

4.

Put back the empty bottle.

5.

Take care that the mouth of the bottle is well positioned to receive the liquid falling from above.

6.

Close the door.
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Every 125 liters of ink
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required every 125 liters of ink:
●

Clean the carriage rails and replace the oiler foams on page 216

●

Empty the oil collector caps on page 229

●

Clean the bottom of the carriage, the drying glasses, and the line and crash sensors on page 238

●

Clean the drop-detector ink deposits on page 242

●

Clean the e-cabinet fan filters on page 245

●

Clean the e-box fan filter on page 247

●

Clean substrate input/output gears and spindle metal debris on page 250

Clean the carriage rails and replace the oiler foams

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

For the latest information, see http://www.hp.com/go/latex3000/manuals/.
Prepare to clean the carriage rails
1.

Ensure that you have the Carriage Rail Cleaning Tool provided with your printer.
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2.

Ensure that you have the cleaning wicks (one bag of 20) and a 10 ml bottle of lubricant oil from the
HP Latex 3x00 Printer Cleaning Kit, also provided with your printer.

3.

Ensure that the printer is not printing.

4.

You are recommended to wear gloves.

5.

Ensure that all windows, covers, and doors are closed and remain in their original positions.

Clean the carriage rails
1.

ENWW

Insert the cleaning wicks into each of the sections of the Carriage Rail Cleaning Tool.
●

Front section: 5 wicks on each side (total 10)

●

Rear sections: 5 wicks in each section

Every 125 liters of ink 217

2.

Moisten the surface of the wicks with the lubricant oil until it turns yellow. A fifth of the bottle should be
enough for all 20 wicks.

3.

Run the diagnostic test to clean the carriage rail.
The carriage will perform a series of movements and will stop at the service position.
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4.

Open the service position window.

5.

Insert the Carriage Rail Cleaning Tool front section.
CAUTION:
printer.

ENWW

If you cancel the process before completion, remember to remove the tool from inside the
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6.

Insert the Carriage Rail Cleaning Tool rear sections.

7.

Close the service position window and click Continue.

8.

When prompted, open the service position window.

9.

Remove the three Carriage Rail Cleaning Tool sections.
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10. Close the service position window. The carriage returns to its normal position.
11. Remove the cleaning wicks from the Carriage Rail Cleaning Tool sections and dispose of them appropriately,
according to local regulations.
NOTE: If this carriage rail cleaning process fails, there is an alternative procedure: see Clean the carriage rails
manually on page 334.
Prepare to replace the oiler foams
1.

Ensure that you have the Oiler Foams Kit included in the HP Latex 3x00 Printer Cleaning Kit, provided with
your printer.

2.

Take the replacement oiler foams and wicks from the kit.

3.

Move the carriage to the service position.

4.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

5.

Open the service position window.

Replace the front oiler foam and wicks
1.

ENWW

Locate the front oiler foam in the carriage.
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2.

Slide off the cover of the front oiler foam.

3.

Remove the old foam.
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4.

Remove the old wicks.

5.

Insert the new wicks.

6.

Insert the new foam.
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7.

Put back the cover.

Replace the rear oiler foam and wicks
1.

Locate the rear oiler foam in the carriage.

2.

Slide off the cover of the rear oiler foam.
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3.

Remove the old foam.

4.

Loosen the two screws that attach the black oiler holder to the carriage, and pull the holder out of the
carriage
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5.

If the oiler also has a felt retainer fitted, remove it, and the 2 used felts. If not, skip this step.

6.

Remove the used wicks.
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7.

Insert the new wicks.

Check that the wicks are inserted correctly.

8.

ENWW

If the oiler had the felt retainer fitted, insert 2 new felts, one on each side. If not, go to step 10.

Every 125 liters of ink 227

9.

Insert the felt retainer.

Check that the wicks and retainer are inserted and fitted correctly.

10. Put the black oiler holder back into position. The holder has two pins to locate it properly.

11. Check again that the new wicks are inserted correctly.
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12. Tighten the screws.

13. Insert the new foam.

14. Slide in the cover.
15. Close the service position window.
Finish off replacing the oiler foams
1.

Ensure that all windows, covers, and doors are closed and remain in their original position.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Empty the oil collector caps

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to empty the oil collector caps
1.
ENWW

Ensure that you have a flashlight (not provided) as recommended in the maintenance tool set.
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2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to the service position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Empty the oil collector caps
1.

Open the front door.

2.

Check all of the front collectors at the center of the printer.

230 Chapter 9 Hardware maintenance

ENWW

ENWW

3.

Open the loading table latches.

4.

Open the loading table.

5.

Check all of the back collectors at the center of the printer.
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6.

Open the printhead cleaning roll door at the front right of the printer.

7.

Check the front and back collectors visible from the door.
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8.
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Unscrew and remove the cover to access the capping station.
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9.

Check the front and back collectors visible from the opened cover.

Also check the trays on the right; clean them if necessary by absorbing the oil with a cloth or other
absorbent material.
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10. Unscrew the pointed screws and remove the left cover.
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11. Check the front and back collectors visible from the opened cover. One of the back screws has no collector,
as indicated below.

Also check the tray on the left; clean it if necessary by absorbing the oil with a cloth or other absorbent
material.
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12. In each case, remove and empty the collectors that are full, as shown below, and dispose of the oil
according to local regulations.
Maximum oil level

Remove collector

ENWW
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13. Put the emptied collectors back into place.

14. Recheck that all the emptied collectors in the each accessed area are back in place.
Finish off after emptying the oil collector caps
1.

Close the loading table and secure the latches.

2.

Close the front door.

3.

Put back the covers and screw them into place.

4.

Close the printhead cleaning roll door.

5.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Clean the bottom of the carriage, the drying glasses, and the line and crash sensors

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2
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Prepare to clean the carriage bottom
1.

Ensure that you have the HP Latex 3x00 Printer Cleaning Kit, provided with your printer.
NOTE:

A steel scourer is not provided but will also be needed.

2.

Ensure that the printer is not printing.

3.

Unload the substrate.

4.

Wait for the drying modules to cool down (about 10 min).

5.

Ensure that all windows, covers, and doors are closed and remain in their original positions.

6.

Move the printhead carriage to the service position.

7.

Move the carriage beam to its highest position (this takes about 2 minutes).

8.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

9.

Open the front door.

NOTE: For some operations, there is better access from the back of the printer. Open the loading table
too if you find it useful.
Clean the carriage bottom
▲

ENWW

Clean the carriage bottom with a lint-free cloth dampened with distilled water. Be very careful not to touch
the printheads.
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Clean the aerosol nozzles
▲

Clean the aerosol nozzles with a dampened cloth.

Clean the drying glasses
1.

Clean the drying glasses with a dampened cloth.
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2.

Clean the drying glasses with a steel scourer.

3.

Continue cleaning the drying glasses with cloth and scourer until they are completely clean.

Clean the line and crash sensors
1.

Wipe the line sensor and two crash sensors with one of the cotton swabs provided in the Printer Cleaning
Kit, slightly dampened with distilled water.

2.

Wipe the crash sensor emitter and receiver lenses located at both sides of the carriage with one of the
cotton swabs (provided in the Printer Cleaning Kit) slightly dampened with water. Once cleaned, ensure the
parts are completely dry.

Finish off cleaning the carriage bottom

ENWW

1.

Close the front door.

2.

Ensure that the cleaned parts are completely dry and all vapor has completely evaporated.
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3.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

4.

Ensure that all windows, covers, and doors are closed and remain in their original positions.

5.

Move the carriage beam back to its working position (this takes about 2 minutes).

6.

Move the carriage back to its working position.

Clean the drop-detector ink deposits

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

NOTE: These ink deposits are dried and cured onto surfaces and may be difficult to remove.
Prepare to clean the ink deposits
1.

Ensure that you have a steel scourer (not provided).

2.

Ensure that the printer is not printing.

3.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Clean the ink deposits
1.

Unscrew and open the right front cover to access the capping station.
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2.

There are seven ink deposits to be cleaned.

3.

Dampen the surface of each ink deposit with a cloth dampened with isopropyl alcohol.
NOTE: If you are in an area (such as California) that regulates VOC cleaning and maintenance fluids,
instead of isopropyl alcohol use a VOC-certified cleaner such as a properly diluted Simple Green All-Purpose
Cleaner.

ENWW
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4.

Scrub the surface of each ink deposit with the steel scourer, taking care to move it from the inside of the
printer towards the outside, to avoid pushing dirt into the drop detector.

TIP: If access or visibility is not good enough, remove the upper section of the right front cover by
unscrewing the screws shown below.

5.

Clean the surface of each ink deposit with a cloth dampened with isopropyl alcohol.

Finish off after cleaning the ink deposits
1.

If you removed it earlier, put back the upper section of the right front cover and screw it into place.

2.

Close the right front cover and screw it into place.

3.

Ensure that the cleaned parts are completely dry.

4.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.
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Clean the e-cabinet fan filters
Prepare to clean the e-cabinet fan filters
1.

Ensure that the printer is not printing.

2.

Locate the fan filters on the printer.

Clean the e-cabinet fan filters
1.

ENWW

Pull off the plastic fan filter cover.
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2.

For each fan, take the fan filter and clean by blowing it with the air gun. Be careful to locate it back correctly:
it must cover the fan’s square surface.
WARNING! The air gun provided with the printer is only intended to inflate the spindle. When
recommended to use for cleaning purposes, make sure to do so according to local regulations since
additional safety provisions may apply.
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3.

Put back the fan cover.

Clean the e-box fan filter

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

Moving fan blades

For more safety information, see Safety precautions on page 2

Prepare to clean the e-box fan filter

ENWW

1.

Turn off the printer and the power-enable switch.

2.

Locate the rear right panel assembly.
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3.

Remove the two pointed T-20 screws that attach the rear right panel assembly.

4.

Remove the rear right panel assembly.

5.

Remove the two T-20 screws from the e-box support and pull it out carefully.
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Clean the e-box fan filter
1.

Pull off the plastic fan filter cover.

2.

Take the fan filter and clean by blowing it with the air gun. Be careful to locate it back correctly: it must cover
the fan’s square surface.
WARNING! The air gun provided with the printer is only intended to inflate the spindle. When
recommended to use for cleaning purposes, make sure to do so according to local regulations since
additional safety provisions may apply.

ENWW
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3.

Put back the fan cover.

Clean substrate input/output gears and spindle metal debris

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

1.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

2.

Remove the spindle.
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3.
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Clean any metal debris from the bearings with a brush.
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Every 500 liters of ink
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required every 500 liters of ink:
●

Replace the rubber blade on page 252

Replace the rubber blade

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to replace the rubber blade
1.

Ensure that you have the Printhead Cleaning Roll Rubber Blade Kit (CZ056-67046), which is included in the
Printer Maintenance Kit (1HA07-67008 or 1VT19A) but can also be purchased separately.

2.

Ensure that the printer is not printing.
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3.

Unlock and open the printhead cleaning roll door.

4.

Pull out the printhead cleaning roll carriage.

5.

Put on gloves to protect your hands.
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6.

Open the pinchwheel (pull out and rotate the black plastic knob).

7.

Move the printhead cleaning material aside in order to uncover the rubber blade.

Replace the rubber blade
1.

Move the rubber blade to the replacement position.
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2.

Use a torx 15 screwdriver to remove the two screws shown below. While you unscrew them, you must hold
the two spacers shown on the right (otherwise, they will fall and might get lost).

3.

Remove the spacers.

4.

Remove the rubber blade and place the new one in position.

5.

Replace the screws. Screw them in with one hand while holding the spacer in place.

Finish off after replacing the rubber blade

ENWW

1.

Push the printhead cleaning material back into place and close the pinchwheel (using the black plastic
knob).

2.

Carefully push the printhead cleaning roll carriage back into its working position.

3.

Close and lock the door.
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Every 1500 liters of ink
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required every 1500 liters of ink:
●

Replace the e-cabinet fan filters on page 256

●

Replace e-box fan filter on page 258

●

Clean the impinging plate on page 261

●

Clean the vapor removal external filter on page 263

●

Clean the rear scan-axis beam on page 264

●

Clean and grease the substrate drive transmission gears and rods on page 267

●

Grease the carriage beam screws on page 268

●

Clean and grease the service station transmission and rods on page 270

●

Empty the drop detector ink vessel on page 271

●

Replace the rubber blade on page 252

●

Clean the carriage rails and replace the oiler foams on page 216

●

Grease the printhead primers on page 273

●

Replace the rocker pads on page 337

Replace the e-cabinet fan filters
Prepare to replace the e-cabinet fan filters
1.

E-cabinet fan filters are provided with your printer in the HP Latex 3x00 Printer Cleaning Kit: the necessary
sets of two filters are provided; only one set is needed for this operation.
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2.

Ensure that the printer is not printing.

3.

Locate the fan filters on the printer.

Replace the e-cabinet fan filters
1.

ENWW

Pull off the plastic fan filter cover.

Every 1500 liters of ink 257

2.

For each fan, change the fan filter for the new one provided. Be careful to locate it correctly: it must cover
the fan’s square surface.

3.

Put back the fan cover.

Replace e-box fan filter

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

Moving fan blades

For more safety information, see Safety precautions on page 2
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Prepare to replace the e-box fan filter
The e-box fan filter is provided with your printer in the HP Latex 3x00 Printer Cleaning Kit.

ENWW

1.

Turn off the printer and the power-enable switch.

2.

Locate the rear right panel assembly.

3.

Remove the two pointed T-20 screws that attach the rear right panel assembly.

4.

Remove the rear right panel assembly.
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5.

Remove the two T-20 screws from the e-box support and pull it out carefully.

Replace the e-box fan filter
1.

Pull off the plastic fan filter cover.
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2.

Change the fan filter for the new one provided. Be careful to locate it correctly: it must cover the fan’s
square surface.

3.

Put back the fan cover.

Clean the impinging plate

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

The perforated plate is a drilled metallic sheet located in the curing assembly. Through its holes the curing fans
blow hot air onto the substrate.

ENWW
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Prepare to clean the impinging plate
1.

Ensure that the printer is not printing.

2.

Unload the substrate.

3.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

4.

Wait for the curing modules to cool down (approx. 5 min).

5.

Remove the spindle.

Pull out the curing assembly
1.

Open the front door.

2.

Open the curing module latches.
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3.

Pull out the curing assembly.

Clean the impinging plate
▲

Lying on the floor as shown in the picture, clean the perforated plate of the curing modules with a lint-free
cloth dampened with distilled water.

Finish off cleaning the impinging plate
1.

Push the curing assembly back to its working position.

2.

Close the curing latches.

3.

Put the spindle back in position.

4.

Ensure that the cleaned parts are completely dry and all vapor has completely evaporated.

5.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Clean the vapor removal external filter

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

Moving fan blades

For more safety information, see Safety precautions on page 2
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Process
1.

Switch off the printer.

2.

Unscrew and open the back cover.

3.

Using a brush and vacuum cleaner, clean the metal filter.

4.

While here, check the fans to see if they also need cleaning.

5.

Reinstall the cover.

6.

Switch on the printer.

Clean the rear scan-axis beam
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Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to clean the rear scan-axis beam
1.

Ensure that you have a vacuum cleaner and an absorbent all-purpose cloth (not provided).

2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to its leftmost position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Clean the rear scan-axis beam
1.

ENWW

Open the service position window.
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2.

Remove the pointed screws indicated below and open the transparent cover at the right of the service
position window.
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3.

Clean the dust from the rear scan-axis beam, using a vacuum cleaner.

Alternatively, use an absorbent cloth, moistened with deionized water, to wipe off the dust. Ensure that the
dust adheres to the cloth and does not fall into the printer.

4.

Use the absorbent cloth, moistened with deionized water, to wipe off any other dirt stuck to the scan-axis
beam.

Finish off after cleaning the rear scan-axis beam
1.

Lower the transparent cover and screw it into place.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Clean and grease the substrate drive transmission gears and rods

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

NOTE:

ENWW

Use gloves when applying grease to the gears.
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Clean and grease the substrate drive transmission gears
1.

Ensure you have the machine grease and oil kit, included in the Printer Maintenance kit.

2.

Unload the substrate.

3.

Turn off the printer and the power-enable switch.

4.

Open the pinch clamps.

5.

Clean the exposed part of the substrate drive roller gear with a lint-free cloth dampened with isopropyl
alcohol.

6.

Using gloves put some grease on your finger.

7.

Apply some grease to the exposed part of the substrate drive roller gear by moving your finger up and
down the gear, filling the threads with grease.
WARNING! Do not remove the gear’s plastic cover to grease it, as it would uncover the encoder disc too,
allowing it to get dirty.

8.

Hand spin drive roller motor coupling, applying grease to all the gear threads.
NOTE:

Do not put grease on the outside of the threads or on the bottom or top of the screw.

Clean and oil the rods
1.

Clean both rods with a lint-free cloth dampened with isopropyl alcohol.

2.

Put a few oil drops along both the capping and the drop detector rods.

Finishing off greasing the substrate drive transmission gears
1.

Remove any extra grease.

2.

Make sure that no other parts of the printer have any grease that may prevent it from working correctly.

3.

Turn on the printer.

Grease the carriage beam screws

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to grease the carriage beam screws
1.

Ensure that you have the Machine Grease and Oil Kit (Q6702-60546), which is included in the Printer
Maintenance Kit (1HA07-67008 or 1VT19A).

2.

Ensure that the printer is not printing.
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3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage beam to its highest position (this takes about 2 minutes).

5.

Open the front door.

Grease the carriage beam screws
1.

Put some grease on your finger.

2.

Apply the grease to the exposed, middle part of the carriage beam screw by moving your finger up and
down the screw, filling the threads with grease.

3.

Continue applying the grease until the whole middle section of the screw, all the way around the screw, is
greased.
NOTE:

ENWW

Do not put grease on the outside of the threads or on the bottom or top of the screw.
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4.

Repeat the above steps for each screw.

Spread the grease
1.

Move the carriage beam back to its normal position so that the grease spreads along the screw (this takes
about 2 minutes).

2.

Move the carriage beam to its highest position (this takes about 2 minutes).

3.

Repeat the above steps twice more to spread the grease fully.

Finish off greasing the carriage beam screws
1.

Remove any extra grease.

2.

Make sure that the platen and the carriage beam low switch does not have any grease that will prevent it
from working correctly. If grease is interfering with the switch, remove the switch, and gently clean the
grease from it.

3.

Close the front door and ensure that all doors and covers are back in place.

4.

Move the carriage beam back to its normal position (this takes about 2 minutes).

Clean and grease the service station transmission and rods

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

NOTE: Use gloves when applying grease to the gears.
Clean and grease the service station transmission
1.

Ensure you have the machine grease and oil kit, included in the Printer Maintenance kit.

2.

Move the carriage beam to its highest position (it takes around 2 minutes).
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3.

Move the carriage to service position.

4.

Turn off the printer and the power-enable switch.

5.

Remove the 2 screws holding the rear right panel.

6.

Clean the helical gear with a lint-free cloth dampened with isopropyl alcohol.

7.

Using gloves put some grease on your finger.

8.

Apply some grease to the helical gear by moving your finger backward and forward.

9.

Continue applying grease until the whole transmission is greased.

10. Repeat the process with the other helical gear.
Clean and oil the rods
1.

Clean both rods with a lint-free cloth dampened with isopropyl alcohol.

2.

Put a few oil drops along both the capping and the drop detector rods.

Finishing off greasing the service station transmission
1.

Remove any extra grease.

2.

Make sure that no other parts of the printer have any grease that may prevent it from working correctly.

3.

Place the 2 screws holding the rear right panel.

4.

Turn on the printer.

Empty the drop detector ink vessel

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to clean the ink vessel
1.

Ensure that the printer is not printing.

2.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Clean the ink vessel
1.

ENWW

Unscrew and open the right front cover to access the capping station.

Every 1500 liters of ink 271

2.

There are seven ink vessels to be cleaned.

3.

Remove the screws that fix the ink vessel.

4.

Move the ink vessel enough to clean the dry ink that is deposited underneath.
TIP:

Use a vacuum cleaner to do so easily.
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TIP: If access or visibility is not good enough, remove the upper section of the right front cover by
unscrewing the screws shown below.

5.

Reinstall the ink vessel.

Finish off after cleaning the ink vessels
1.

If you removed it earlier, put back the upper section of the right front cover and screw it into place.

2.

Close the right front cover and screw it into place.

3.

Ensure that the cleaned parts are completely dry.

4.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Grease the printhead primers

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2
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NOTE: Perform this procedure when the system error 46.02.0Y:06 appears.
Prepare to grease the printhead primers
1.

Ensure that the printer is not printing.

2.

Ensure that all windows, covers, and doors are closed and remain in their original position.

3.

Move the printhead carriage to the service position.

4.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

5.

Stand on the folding steps and open the service position window.

Grease the printhead primers
1.

After lifting the printhead covers, two 'O' rings can be seen that seal the joints between the printhead cover
and printhead.
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2.

With a finger, apply a little grease to the 'O' rings to improve their performance. A suitable grease is
available in a syringe from the cleaning kit.

The grease should be applied to the black rubber part only. If grease gets into the central hole, remove it
with a toothpick or similar tool.

3.

ENWW

Close the printhead cover, the carriage cover, and the printhead access door.

Every 1500 liters of ink 275

When required
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are needed when required:
●

Check and clean the printheads on page 160

●

Check the printer for dust and aerosol on page 277

●

Clean the substrate-advance sensor on page 204

●

Replace a pinchwheel submodule on page 278

●

Replace a primer on page 280

●

Replace the aerosol fan module on page 286

●

Replace the drying fans array on page 290

●

Replace the drying lamps on page 295

●

Clean the drying module quartz glass and air outlet on page 305

●

Replace the drying quartz glass on page 311

●

Replace a curing fan and resistor module on page 315

●

Replace a service station cap on page 319

●

Replace an intermediate tank on page 322

●

Replace an e-cabinet fuse on page 324

●

Clean the printhead contacts on page 326

●

Replace a spindle valve on page 331

●

Clean the roll-to-free-fall roller and pinchwheels on page 333

●

Clean the carriage rails manually on page 334

●

Grease the printhead primers on page 273

●

Pinch clamp replacement on page 336

●

Replace the rocker pads on page 337

●

Clean the scan axis encoder on page 338
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●

Replace the curing module side rubber on page 339

●

Clean the service station caps on page 340

●

Clean the vapor removal external filter on page 263

●

Clean the bottom of the carriage, the drying glasses, and the line and crash sensors on page 238

●

Empty the condensation collector bottle on page 213

●

Empty the printhead cleaning waste bottle on page 342

●

Clean the perforated plate on page 343

Check the printer for dust and aerosol
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Check the printer for dust and aerosol on covers, windows, computer screen, and so on.
If you see condensation on the inside of the transparent cover over the middle of the printer, wipe it with a dry
cloth. To reach the inside of the cover, unscrew the pointed screws and lift the cover.
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Check the print output areas for ink droplets, aerosol, or condensation, especially the area around and below the
diverter wheels and the tension roller.
If you find dust or ink, wipe it off with a lint-free cloth, moistened with distilled water.
Reinstall all removed covers and ensure all doors are closed before turning on the printer.

Replace a pinchwheel submodule
Prepare to replace a pinchwheel submodule
▲

Ensure that you have the Pinchwheel Assembly (CZ056-67097), which is included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A).

Replace a pinchwheel submodule
1.

Open the loading table.

2.

Locate the pinchwheeel submodule that needs replacement.
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3.

Remove the screws shown below.

4.

Remove the pinchwheel cover.
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5.

Remove the screws that attach the pinchwheel submodule.

6.

Remove the broken submodule.

7.

Place the new submodule and attach the screws.

8.

Place the cover and insert the screws.

9.

Close the loading table.

Replace a primer
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Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to replace a primer
1.

Ensure that you have the Primer and Latch Kit (CZ056-67396 for HP Latex 3000/3100/3500 or
1HA07-67018 for HP Latex 3200/3600), which is included in the HP Latex 3000 Series Standard Uptime Kit
(D4J02A).

2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to the service position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

6.

Stand on the folding steps and open the service position window.

Replace a primer (HP Latex 3000, 3100, 3500 only)

ENWW

1.

Disconnect the primer cable. You have to disconnect a white connector that you can find at the back of the
printhead whose primer is to be replaced.

2.

Open the latch. It is not usually necessary to remove the printhead.
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3.

Remove the latch of the printhead whose primer is to be replaced. To remove it, you have to push open the
printhead pocket wall to the right while pulling the latch up.

4.

Stick the corresponding printhead color label on the latch. Be careful with the orientation.

5.

Install the new latch with primer.

6.

Replace the printhead, if it was removed, and close the latch.

Replace a primer (HP Latex 3200, 3600 only)
1.

Disconnect the two primer cable connectors at the back of the printhead that needs the primer replaced.
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2.

Release the handle. It is not usually necessary to remove the printhead.

3.

Loosen the T10 screw (do not remove the screw, just loosen it) and release the sheet metal tab.
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4.

Remove the latch.

5.

Stick the corresponding printhead color label on the latch. Be careful with the orientation.

6.

Install the new latch with primer. Do not close the handle yet.
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7.

Close the sheet metal tab and tighten the T10 screw.

8.

Close the handle.

9.

Connect the two primer cable connectors.
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Finish off replacing a primer
1.

Close the service position window.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

3.

Run a diagnostic test to check that the new primer is working correctly, and calibrate it.

4.

Dispose of the old primer.

Replace the aerosol fan module

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to replace the aerosol fans module
1.

Ensure that you have the Aerosol Fan Module (CZ056-67246), which is included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to the service position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

6.

Stand on the folding steps and open the service position window.
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Replace the aerosol fan module
1.

ENWW

Open the aerosol fan cover, as if you were going to replace the filters.
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2.

Remove the three screws that attach the cover, and remove the cover.

3.

Disconnect the two aerosol fan cable connectors.
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4.

Remove the main cable harness from the cover slot.

5.

Close the cover.

6.

Remove the nuts from the hinges. You must hold the nuts to prevent them from falling and get lost inside
the carriage.

When required 289

7.

Remove the aerosol fan module and insert the new one.

8.

Put the hinges back in place, put back the nuts and tighten them.

9.

Open the new aerosol fan cover.

10. Remove the three screws that attach the new fan cover, and remove the cover.
11. Connect the two aerosol fan cable connectors.
12. Route the main cable harness and insert the grommet in the cover slot. Make sure the cables are not tight
inside the cover.
13. Install the aerosol fan cover and attach the three screws.
14. Close the cover.
Finish off replacing the aerosol fan module
1.

Close the service position window.
CAUTION:

Do not leave anything in the way of the carriage.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

3.

Run a diagnostic test to check that the aerosol fans are working correctly.

4.

Dispose of the old aerosol module fans.

Replace the drying fans array

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

290 Chapter 9 Hardware maintenance

ENWW

Prepare to replace the drying fan array
1.

Ensure that you have the necessary Drying Fans Array Kit: for the left drying module (CZ056-67024) or the
right drying module (CZ056-67023). Both kits are included in the HP Latex 3000 Series Standard Uptime
Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to the service position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

6.

Stand on the folding steps and open the service position window.

Drying lamps emitter—safety precautions
CAUTION: Disregard of the safety precautions or improper operation of the infrared emitter can lead to injuries
and material damage.
CAUTION:

The IR heating device must be operated only by specialists or trained personnel.

The operator of the system must compile specific operating instructions for the training of operating personnel.
CAUTION: The safety and functional reliability of the IR heating device are guaranteed only in the event of use
of original accessories and spare parts from Heraeus Noblelight.
WARNING!

After an emitter break, a dangerous voltage may be exposed to contact by the heating spiral.

Remove the drying module
1.

ENWW

Remove the electrical connector latch.
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2.

Unplug the connector.
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3.

Unscrew the three screws shown below in order to remove the drying module (the left module is shown).

4.

Pull the drying module carefully out of the carriage and lay it gently on a table.

Replace the drying fans array
1.

ENWW

Remove the drying filter.
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2.

Disconnect the drying fans array connector.

3.

Remove the screw attaching the drying fans array to the drying module.

4.

Remove the drying fans array and place the new array. There are two pins on each side of the drying
module to ensure that it is placed in the correct position.
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5.

Put back the screw that you removed earlier.

6.

Reconnect the drying fans array connector.

7.

Reinstall the drying filter.

Reinstall the drying module
1.

Reinstall the drying module into the carriage and tighten the three screws that attach it to the carriage.

2.

Reconnect the electrical connector and close the latches.

Finish off replacing the drying fans array
1.

Close the service position window.
CAUTION:

Do not leave anything in the way of the carriage.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

3.

Dispose of the old drying fans array according to local regulations.

Replace the drying lamps
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Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to replace the drying lamps
1.

Ensure that you have the Drying Filter Lamps Kit (CZ056-67322), which is included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to the service position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

6.

Stand on the folding steps and open the service position window.

7.

Perform the following processes for both drying modules (left and right).

Remove the drying module
1.

Remove the electrical connector latch.
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2.

Unplug the connector.

3.

Unscrew the three screws shown below in order to remove the drying module (the left module is shown).
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4.

Pull the drying module carefully out of the carriage and lay it gently on a table.

Drying lamps emitter—safety precautions
CAUTION: Disregard of the safety precautions or improper operation of the infrared emitter can lead to injuries
and material damage.
CAUTION:

The IR heating device must be operated only by specialists or trained personnel.

The operator of the system must compile specific operating instructions for the training of operating personnel.
CAUTION: The safety and functional reliability of the IR heating device are guaranteed only in the event of use
of original accessories and spare parts from Heraeus Noblelight.
WARNING!

After an emitter break, a dangerous voltage may be exposed to contact by the heating spiral.

Transport and handling
Transport the IR emitter, in the packaging provided, to the place of installation.
CAUTION: If the IR emitter must be transported without its packaging, wear linen gloves. Fingerprints on the
quartz tube will cause devitrification, which leads to radiation losses and mechanical failure.

Always carry the emitter with both hands. Carry it so that the cross section faces up, to avoid bending and
breaking.
●

Grip the emitter only by the glass tube, and not by the connection cable, pinches, or ceramics.

●

Avoid any pressure on the flat base.

When installing IR emitters
CAUTION: We recommend that you wear protective goggles when installing or replacing emitters, to protect
yourself from broken glass that you may come into contact with.
CAUTION: Pulling the connection cable must not cause any tension on the flat base. Bending radius of
connection cable: > 30 mm.
After installation, the quartz glass tube of the IR emitter must be cleaned of any soiling or perspiration. For this
purpose, use the cleaning cloth included in our delivery, or a clean linen cloth (without textile finishing agents)
soaked in methylated spirit, to remove any impurities and soiling or fingerprints from the surface.
CAUTION:

The reflector side must not be cleaned.
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Replace the drying lamps

ENWW

1.

To separate the drying glass and air outlet from the rest of the module, remove the three screws shown
below.

2.

Take out the drying lamps section of the drying module.
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3.

Remove the two screws shown below.

4.

Pull out the two clamps.

5.

Disconnect the four dryer lamp cables.

6.

Locate the lamp latches.
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7.

Release the screws that secure the lamp latches, and rotate the latches 180° to set the lamp free.

8.

Rotate and pull out the old lamp.
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9.

Carefully install the new lamp. Leave the golden side down towards the interior of the module; when
correctly installed, the internal wires of the lamp are visible.

NOTE:

The lamp is symmetrical lengthwise and both orientations are correct.

10. Rotate the latches back to the normal position and insert the screws.
11. Connect the cables of the new lamps. There is no mandatory orientation of the cables (top or bottom).
12. Ensure that the fast-on connectors are well assembled. Push them into the ‘click’ position for proper
retention. Check that the plastic insulation covers the whole terminal after assembly.
13. Add and screw in both clamps.
Clean the drying quartz glass and the air outlet
1.

Take the drying quartz glass and air outlet, which you have already removed.
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2.

Moisten both sides of the glass with a lint-free cloth dampened with distilled water.

3.

Scrub both sides of the glass with the steel scourer.

4.

Repeat the above two steps as many times as needed to remove any visible ink stains on the glass.
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5.

Clean the air outlet using the same damp cloth.

Reassemble the drying module
1.

Reassemble the drying lamps with the drying quartz and air outlet. Check that the cables are properly
routed inside the module before assembly.

2.

Insert the three screws.

3.

Ensure that the cleaned parts are completely dry and all vapor has completely evaporated before turning
on the printer.

Reinstall the drying module
1.

Install the drying module into the carriage and tighten the three screws that attach it to the carriage.

2.

Reconnect the electrical connector and close the latches.

Finish off replacing the drying lamps
1.

Close the service position window.
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CAUTION:

Do not leave anything in the way of the carriage.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

3.

Dispose of the old lamps according to local regulations.

Clean the drying module quartz glass and air outlet

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to replace the drying lamps
1.

Ensure that the printer is not printing.

2.

Ensure that all windows, covers, and doors are closed and remain in their original position.

3.

Move the carriage to the service position.

4.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

5.

Stand on the folding steps and open the service position window.

6.

Perform the following processes for both drying modules (left and right).

Remove the drying module
1.

ENWW

Remove the electrical connector latch.
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2.

Unplug the connector.
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3.

Unscrew the three screws shown below in order to remove the drying module (the left module is shown).

4.

Pull the drying module carefully out of the carriage and lay it gently on a table.

Drying lamps emitter—safety precautions
CAUTION: Disregard of the safety precautions or improper operation of the infrared emitter can lead to injuries
and material damage.
CAUTION:

The IR heating device must be operated only by specialists or trained personnel.

The operator of the system must compile specific operating instructions for the training of operating personnel.
CAUTION: The safety and functional reliability of the IR heating device are guaranteed only in the event of use
of original accessories and spare parts from Heraeus Noblelight.
WARNING!
CAUTION:

ENWW

After an emitter break, a dangerous voltage may be exposed to contact by the heating spiral.
The reflector side must not be cleaned.
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Remove the drying quartz
1.

To separate the drying glass and air outlet from the rest of the module, remove the three screws shown
below.

2.

Take out the drying lamps section of the drying module.

Clean the drying quartz glass and the air outlet
1.

Take the drying quartz glass and air outlet, which you have already removed.
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2.

Moisten both sides of the glass with a lint-free cloth dampened with distilled water.

3.

Scrub both sides of the glass with the steel scourer.

4.

Repeat the above two steps as many times as needed to remove any visible ink stains on the glass.
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5.

Clean the air outlet using the same damp cloth.

Reassemble the drying module
1.

Reassemble the drying lamps with the drying quartz and air outlet. Check that the cables are properly
routed inside the module before assembly.

2.

Insert the three screws.

3.

Ensure that the cleaned parts are completely dry and all vapor has completely evaporated before turning
on the printer.

Reinstall the drying module
1.

Install the drying module into the carriage and tighten the three screws that attach it to the carriage.

2.

Reconnect the electrical connector and close the latches.

Finish off replacing the drying lamps
1.

Close the service position window.
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CAUTION:
2.

Do not leave anything in the way of the carriage.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Replace the drying quartz glass

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to replace the drying quartz glass
1.

Ensure that you have the necessary Drying Quartz Glass Kit: for the left drying module (CZ056-67253) or
the right drying module (CZ056-67252). Both kits are included in the HP Latex 3000 Series Standard
Uptime Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to the service position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

6.

Stand on the folding steps and open the service position window.

Remove the drying module
1.

ENWW

Remove the electrical connector latch.
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2.

Unplug the connector.

312 Chapter 9 Hardware maintenance

ENWW

3.

Unscrew the three screws shown below in order to remove the drying module (the left module is shown).

4.

Pull the drying module carefully out of the carriage and lay it gently on a table.

Replace the drying quartz glass
1.

ENWW

To separate the drying glass and air outlet from the rest of the module, remove the three screws shown
below.
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2.

Assemble the drying lamps section and the new drying glass and air outlet.

3.

Insert the three screws.

Reinstall the drying module
1.

Reinstall the drying module into the carriage and tighten the three screws that attach it to the carriage.
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2.

Reconnect the electrical connector and close the latches.

Finish off replacing the drying quartz glass
1.

Close the service position window.
CAUTION:

Do not leave anything in the way of the carriage.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

3.

Dispose of the old quartz glass according to local regulations.

Replace a curing fan and resistor module

Risk of burns

Crush hazard

Risk of trapped
fingers

Hazardous moving
part

Light radiation
hazard

Electric shock
hazard

Moving fan blades

For more safety information, see Safety precautions on page 2
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Prepare to replace a curing fan and resistor module
1.

Ensure that you have the Curing Heater and Fan Module Kit (CZ056-67054), which is included in the
HP Latex 3000 Series Standard Uptime Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

4.

Wait for the curing modules to cool down.

Replace a curing fan and resistor module
1.

Open the front door.

2.

Use a flat screwdriver to remove the screws of the curing module.
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3.

Raise the metal sheet in order to reach the interior of the module.

4.

Disconnect the two cables shown in the picture. You have to press the retention clip on each of the two
connectors, and gently pull the cable. The black one is for the DC fans supply and the white one is for AC
power to the curing heaters.

5.

Use a flat screwdriver to remove the screws of the fan-resistor module.
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6.

Remove the fan-resistor module.

7.

Put the new fan-resistor module into position.

8.

Screw in the screw and connect the two cables to each fan-resistor module.

9.

Close the metal sheet and replace the screws to secure it.
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Finish off after replacing a curing fan and resistor module
1.

Close the front door.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Replace a service station cap

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to replace a service station cap
1.

Ensure that you have the Service Station Caps Kit (CZ056-67036), which is included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage to the service position.

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Replace a service station cap
1.

ENWW

Unscrew and remove the cover as shown below, to access the capping station.

When required 319

320 Chapter 9 Hardware maintenance

ENWW

2.
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Remove the service station cap, using three movements as shown below.
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3.

Remove the spring that holds the cap from below.

4.

Attach the spring to the new service station cap and place it in position.

Finish off after replacing a service station cap
1.

Put back the cover and screw it into place.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Replace an intermediate tank

Risk of burns

Risk of trapped fingers

Hazardous moving part

For more safety information, see Safety precautions on page 2

You will need to replace an intermediate tank if the bag breaks.
Prepare to replace an intermediate tank
1.

Ensure that you have the Intermediate Tank Kit (CZ056-67073), which is included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Replace an intermediate tank
1.

Unscrew the pointed screws and remove the cover to access the intermediate tanks.
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2.

Remove the intermediate tank with the broken bag.

3.

Put a piece of cloth in its place.
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4.

Unplug the air tube from each bottle shown below.

5.

From the air tube, inject air (using the air pressure gun, for example) to clean the interior of the tube. The
ink accumulated in the interior of the tube should be ejected onto the piece of cloth that you have put in
place of the intermediate tank.

6.

If air is not enough to clean it, use water, and then air again to remove the water and dry the tube.

7.

Remove the cloth.

8.

Plug in the air tubes.

9.

Insert the new intermediate tank.

10. Put back the cover and screw in the screws.
Finish off after replacing an intermediate tank
1.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

2.

Run a diagnostic test to refill the intermediate tank.

Replace an e-cabinet fuse

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

CAUTION: Do not attempt to replace fuses other than those in this specific area of the e-cabinet. These are the
only ones you are allowed to replace. Call your service representative in all other cases.
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Prepare to replace an e-cabinet fuse
1.

Ensure that you have the E-cabinet PCA Fuses Kit (CZ056-67136), which is included in the HP Latex 3000
Series Standard Uptime Kit (D4J02A).

2.

Check the Print Care error message log to find out which fuse needs to be replaced.

3.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Replace an e-cabinet fuse
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1.

Ensure that the printer is not printing.

2.

Remove the screws shown below, then remove the rear right cover.

When required 325

3.

Locate the e-cabinet fuses.

4.

Locate the failing fuse identified by the Print Care error message logs.

5.

Pull out the fuse and insert a new one. Ensure that the new fuse matches the old one in size, rating, and
color.

6.

Run a diagnostic test to check that the new fuse is working correctly.
CAUTION: Fire risk! A blown fuse may indicate malfunctioning electrical circuits within the system. If a fuse
trips repeatedly, call your service representative and do not attempt to replace the fuse with one with a
higher current rating.

7.

Dispose of the old fuse.

8.

Put back the rear right cover and screw it into place.

9.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Clean the printhead contacts
WARNING!

This operation is limited to trained personnel only!

NOTE: During the installation of the printer, the designated personnel received training for safe operation and
maintenance of the printer. It is not allowed to use the printer without this training.
WARNING! Read and follow the safety precautions section to make sure you use the equipment safely: see
Safety precautions on page 2. You are expected to have the appropriate technical training and experience
necessary to be aware of hazards to which you may be exposed in performing a task, and to take appropriate
measures to minimize the risks to yourself and to others.
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Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to clean the printhead contacts
1.

Ensure that you have the HP Latex 3x00 Printer Cleaning Kit, which is provided with your printer.

2.

Ensure that the printer is not printing.

3.

Identify which printheads need cleaning, usually after the Internal Print Server recommends replacing or
reseating them.

4.

Ensure that all windows, covers, and doors are closed and remain in their original position.

5.

Move the printhead carriage to the service position.

6.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

7.

Stand on the folding steps and open the service position window.

Clean the printhead contacts (in the carriage slot)
1.

Carefully remove the printheads that may need cleaning from the carriage and protect them using their
orange sealing caps.
CAUTION: Ensure that each printhead uses its own color cap. This is especially important with the
Optimizer printhead caps as there is a high risk of nozzle damage if they are used with the color printheads
and vice-versa. The optimizer caps are labeled as shown below.
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TIP: Remember which printhead came from which slot; the printer will report an error if you later replace
a printhead in the wrong slot.
2.

Illuminate the printhead slot in the carriage and check the electrical connections to the printhead for dirt.
TIP: Placing some white paper behind the electrical connections will improve contrast and may help you
to check for dirt.

3.

Clean the dirty connections gently but thoroughly using the brush provided in the HP Latex 3x00 Printer
Cleaning Kit. A piece of paper or cloth can be used to collect the dirt.

328 Chapter 9 Hardware maintenance

ENWW

4.

Remove the piece of paper or cloth to prevent the dirt from spreading.

5.

Use the pneumatic air gun to dislodge any remaining dirt.
WARNING! The air gun provided with the printer is only intended to inflate the spindle. When
recommended to use for cleaning purposes, make sure to do so according to local regulations since
additional safety provisions may apply.

6.

Illuminate the printhead slot again to check that the electrical connections are now clean and undamaged.

Clean the printhead contacts (on the printhead)

ENWW

1.

Take the printhead interconnect wiper provided in the HP Latex 3x00 Printer Cleaning Kit. Prepare the
handle and one pre-moistened sponge in its pouch.

2.

Take a sponge out of its pouch.

When required 329

3.

Open the handle.

4.

Load the sponge and close the handle as shown below.

5.

Remove the printhead cap and locate the contacts.
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6.

Clean the contacts.

CAUTION:

Do not use the printhead interconnect wiper to clean the nozzles!

Finish off cleaning the printhead contacts
1.

Wait until the contacts are dry.

2.

Put back the printheads, each in the same slot from which it came.

3.

Close the service position window.

4.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Replace a spindle valve

Risk of trapped fingers
For more safety information, see Safety precautions on page 2
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Prepare to replace a spindle valve
1.

Ensure that you have the Spindle Air Valve (Q6702-67025), which is included in the HP Latex 3000 Series
Standard Uptime Kit (D4J02A).

2.

Ensure that you have an 11 mm (7/16 inch) tube wrench key and the pneumatic gun.

3.

Ensure that the printer is not printing.

4.

Press the valve to deflate the spindle.

Replace a spindle valve
1.

Remove the spindle valve with the tube wrench key.

NOTE:

2.

Remember that the dual-roll spindle has two valves; identify the one that needs replacement.

Insert the new valve and tighten it. The valve must be well seated in position and firm, but do not force it
with the key.

332 Chapter 9 Hardware maintenance

ENWW

Finish off replacing a spindle valve
▲

Test the new valve by inflating and deflating the spindle.

Clean the roll-to-free-fall roller and pinchwheels

Risk of burns

Crush hazard

Risk of trapped fingers

For more safety information, see Safety precautions on page 2

The roll-to-free-fall roller should be cleaned whenever it is visibly dirty (for instance, whenever ink has not cured
properly when using the roller), or when you notice that substrate advance is no longer smooth and regular (for
instance, if you notice that the roller often slips when trying to keep the substrate under tension).
Prepare to clean the roll-to-free-fall roller and pinchwheels
1.

Check that the printer is not printing.

2.

Unload the substrate.

3.

Raise the pressure roller lever if it was previously lowered.

Clean the roll-to-free-fall roller
1.

Clean the roller with a clean cloth dampened with water (for persistent dirt you may use isopropyl alcohol,
but do not use petroleum-based cleaning liquids).

2.

Turn the roller manually and keep cleaning to make sure the rubber surface of the roller is cleaned all
around.
WARNING!

3.

Take care not to trap your finger when turning the roller.

Ensure that the cleaned parts are completely dry and the vapors have completely evaporated.

Clean the pinchwheels
1.

ENWW

Open the roller latches at both sides and move the roller to the front.
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2.

Lower the pressure roller lever so that the pinchwheels are accessible.

3.

Clean the pinchwheels carefully with a cloth dampened with water (for persistent dirt you may use
isopropyl alcohol, but do not use petroleum-based cleaning liquids).

4.

Once the pinchwheels are clean, raise the pressure roller lever.

5.

Roll the roller backwards by pushing it (not by grabbing it).
WARNING! Take special care when moving the roller backwards not to hit your fingers against the black
substrate guide behind and under the roller.

6.

Once the roller is in position, close the latches at both sides.

7.

Ensure that the cleaned parts are completely dry and the vapors have completely evaporated.

Clean the carriage rails manually

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2
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NOTE:

Perform this procedure only if the automatic cleaning procedure fails.

Prepare to clean the carriage rails manually
1.

Ensure that the printer is not printing.

2.

You are recommended to wear gloves.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage beam to its highest position (this takes about 2 minutes).

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

6.

Open the front door.

Clean the carriage rails manually
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1.

Standing at the front of the printer, clean the front rail using a lint-free cloth dampened with distilled water.

2.

Close the front door.

3.

Go to the rear of the printer and open the loading table.
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4.

Standing at the rear of the printer, clean the rear rail in the same way. You can access the rail from below,
through the gap between the platen and the beam.

CAUTION:

Be careful not to stain the encoder strip. Keep the cloth well away from the encoder housing.

5.

Ensure that the cleaned parts are completely dry and all vapor has completely evaporated.

6.

Close the loading table.

Finish off cleaning the carriage rails manually
1.

Ensure that all windows, covers, and doors are closed and remain in their original position.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Pinch clamp replacement

Crush hazard

Risk of trapped fingers

Hazardous moving part

Risk of cutting fingers

For more safety information, see Safety precautions on page 2

Removal
1.

Ensure that the printer is not printing.

2.

Turn off the printer and the power-enable switch.

3.

Locate the pinch clamp to be replaced and open it.
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4.

Remove the four T-30 screws and the pinch clamp.

1.

Install the new pinch clamp and attach it with the screws.

2.

Perform the safety interlock diagnostic (51001).

Installation

Replace the rocker pads

Risk of trapped fingers
For more safety information, see Safety precautions on page 2

Removal (same for all four sides)
1.

Unload all the spindles from both sides of the printer.

2.

Open the latch.

3.

Unscrew the 2 hexagonal cap screws with a wrench and remove the rocker pad.

▲

Install the new rocker pad and replace the 2 screws.

Installation
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Clean the scan axis encoder

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

NOTE: Perform this procedure only if the automatic cleaning procedure fails.
Prepare to clean the scan axis encoder
1.

Ensure that the printer is not printing.

2.

You are recommended to wear gloves.

3.

Ensure that all windows, covers, and doors are closed and remain in their original position.

4.

Move the carriage beam to its highest position (this takes about 2 minutes).

5.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

6.

Open the front door.

Clean the scan axis encoder
1.

Go to the rear of the printer and open the loading table.
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2.

Standing at the rear of the printer, clean the scan axis encoder with a lint-free cloth dampened with distilled
water. You can access the encoder from below, through the gap between the platen and the beam.

3.

Ensure that the cleaned parts are completely dry and all water has completely evaporated.

4.

Close the loading table.

Finish off cleaning the scan axis encoder
1.

Ensure that all windows, covers, and doors are closed and remain in their original position.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Replace the curing module side rubber

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

Moving fan blades

For more safety information, see Safety precautions on page 2

Removal
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1.

Open the latches and pull the curing module out.

2.

Remove any remaining bits of foam from both sides.
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Installation
1.

Insert new foams. Tape them in to insure they are well sealed between the curing module and front bottom
plate to avoid any vapor condensation leakage.

2.

Push the curing module in and close the latches.

Clean the service station caps

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving
part

Light radiation hazard

Electric shock hazard

For more safety information, see Safety precautions on page 2

Prepare to clean the service station caps
1.

Ensure that the printer is not printing.

2.

Ensure that all windows, covers, and doors are closed and remain in their original position.

3.

Move the carriage to the service position.

4.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

Clean the service station caps
1.

Unscrew and remove the cover as shown below, to access the capping station.
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2.
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Clean the zone around the service station caps.
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Finish off after cleaning a service station cap
1.

Put back the cover and screw it into place.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Empty the printhead cleaning waste bottle

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Removal
1.

Turn off the printer and the power-enable switch.

2.

Unlock and open the printhead cleaning roll door.
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3.

Remove two screws.

4.

Remove the waste bottle.
TIP:

5.

You are recommended to wear gloves for this operation.

Empty the bottle.
NOTE: The bottle contains a mixture of ink additives and water. Dispose of this mixture according to local
regulations. You can find the Material Safety Data Sheets (MSDS) for the ink at http://www.hp.com/go/
msds.

Installation
1.

Put the empty bottle back in place.

2.

Take care that the mouth of the bottle is well positioned to receive the liquid falling from above.

3.

Insert and tighten the screws that fix the position of the bottle.

4.

Close the printhead cleaning roll door.

5.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Clean the perforated plate
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Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

The perforated plate is a drilled metallic sheet located in the curing assembly. Through its holes the curing fans
blow hot air onto the substrate.
Prepare to clean the perforated plate
1.

Ensure that the printer is not printing.

2.

Unload the substrate.

3.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

4.

Wait for the curing modules to cool down (approx. 5 min).

5.

Remove the spindle.

Pull out the curing assembly
1.

Open the front door.
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2.

Open the curing module latches.

3.

Pull out the curing assembly.

Clean the perforated plate
▲

ENWW

Lying on the floor as shown in the picture, clean the perforated plate of the curing modules with a lint-free
cloth dampened with distilled water.
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Finish off cleaning the perforated plate
1.

Push the curing assembly back to its working position.

2.

Close the curing latches.

3.

Put the spindle back in position.

4.

Ensure that the cleaned parts are completely dry and all vapor has completely evaporated.

5.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.
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Ink collector 3 liter/daily maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required every 3 liters/daily:
●

Clean the aerosol filters on page 206

●

Wipe the protector on page 347

●

Wipe the ribs of the ink collector modules on page 348

●

Clean condensation from the output platen and output beams on page 213

Wipe the protector
The protector should be kept clean for optimal performance and reliability.
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1.

Ensure that the printer is not printing.

2.

Unload the substrate.

3.

Open the front door.

Ink collector 3 liter/daily maintenance 347

4.

Open the curing module latches.

5.

Open the curing module.

CAUTION:

Wait for the curing modules to cool down.

6.

Wipe both the visible part of the protector and the underneath with a lint-free cloth dampened with distilled
water.

7.

Close the curing module and latches.

Wipe the ribs of the ink collector modules
1.

Wipe the ribs of the ink collector modules with a lint-free cloth dampened with distilled water.

2.

Close the front door.
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Ink collector: after uninstalling the ink collector kit maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required after uninstalling the ink collector kit:
●

Clean the aerosol filters on page 206

●

Wipe the protector on page 349

●

Wipe the ink collector modules on page 349

●

Clean the curing module and airlet plates on page 350

●

Clean the print zone on page 202

●

Clean the substrate-advance sensor on page 204

Wipe the protector
While you have the protector out of the printer, wipe all surfaces and check the ribs.

Wipe the ink collector modules
While you have the ink collector modules out of the printer, wipe all dirty surfaces. If necessary, replace the
foams: see Replace the ink collector foams on page 353.
CAUTION: Proper maintenance and genuine HP consumables are required to ensure that the printer operates
safely as designed. The use of non-HP consumables (foams, filters, printhead cleaner roll, or inks) may present a
risk of fire.
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Clean the curing module and airlet plates
First ensure that you have turned the printer off, and be careful to follow the appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

After using the ink collector kit, the following parts of the printer may be dirty. Check them as follows.
Curing lip
1.

Open the front door.

350 Chapter 9 Hardware maintenance

ENWW

2.

Open the curing module latches.

3.

Open the curing module.

CAUTION:

4.

Wait for the curing modules to cool down.

Wipe the curing lip with a lint-free cloth dampened with isopropyl alcohol, and make sure that the platen is
dry before printing.
NOTE: If you are in an area (such as California) that regulates VOC cleaning and maintenance fluids,
instead of isopropyl alcohol use a VOC-certified cleaner such as a properly diluted Simple Green All-Purpose
Cleaner.

Bottom plate
▲
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Wipe the bottom plate with a lint-free cloth dampened with distilled water, and make sure that the platen is
dry before printing.
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Diverter interwheels
1.

Wipe the diverter interwheels with a lint-free cloth dampened with distilled water, and make sure that the
platen is dry before printing.

2.

Close the curing module and the front door.
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Ink collector 40 liter maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required every 40 liters:
●

Replace the ink collector foams on page 353

●

Clean the curing module and airlet plates on page 350

●

Clean condensation from the output platen and output beams on page 213

Replace the ink collector foams
TIP:

Do this away from the printer to avoid ink dripping on the printer.

1.

Slide out the dirty old foams.

NOTE:
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Consult your local authorities to determine the correct manner in which to dispose of them.
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2.

Slide in the new foams.
CAUTION: Proper maintenance and genuine HP consumables are required to ensure that the printer
operates safely as designed. The use of non-HP consumables (foams, filters, printhead cleaner roll, or inks)
may present a risk of fire.
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Ink collector 500 liter maintenance
Before any cleaning maintenance, ensure that you have turned the printer off, and be careful to follow the
appropriate safety precautions.

Risk of burns

Crush hazard

Risk of trapped fingers

Hazardous moving part

Electric shock hazard

For more safety information, see Safety precautions on page 2

Introduction
The following maintenance procedures are required every 500 liters:
●

Clean the curing fan grid and internal foam on page 355

●

Clean the curing module and airlet plates on page 350

●

Replace a curing fan and resistor module on page 315

●

Replace protector and textile substrate edge holder on page 358

Clean the curing fan grid and internal foam

Risk of burns

Crush hazard

Risk of trapped
fingers

Hazardous moving
part

Light radiation
hazard

Electric shock
hazard

Moving fan blades

For more safety information, see Safety precautions on page 2

Prepare to replace the curing fan grid and internal foam
1.

Ensure that you have the Curing Heater and Fan Module Kit (CZ056-67054), which is included in the
HP Latex 3000 Series Standard Uptime Kit (D4J02A).

2.

Ensure that the printer is not printing.

3.

Turn off the printer in the correct way for maintenance operations: see Turn the printer off on page 195.

4.

Wait for the curing modules to cool down.

Clean the curing fan grid
1.
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Open the window.
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2.

Use a flat screwdriver to remove the screws of the curing module.
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3.

Raise the metal sheet in order to reach the interior of the module.

4.

Remove the grid from the fan.

5.

Clean the dirt with a brush or with the air supply gun.

6.

Place the grid back into place and fix it with the four screws.
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7.

Clean the foams from the inner face of the metal sheet module cover.

8.

Close the metal sheet and replace the four screws to secure it.

Finish off after cleaning the curing fan grid and internal foams
1.

Close the front door.

2.

Turn on the printer in the correct way for maintenance operations: see Turn the printer on on page 196.

Replace protector and textile substrate edge holder
After using 500 liters with the ink collector, you need to replace the protector and the edge holders if they are
damaged.
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10 Troubleshoot substrate issues

Loading issues
The substrate cannot be loaded successfully
●

A substrate cannot be loaded unless all printer subsystems (e.g. the ink system) are ready.

●

Check that the spindle is correctly inflated.

●

Try using the Internal Print Server to advance the substrate at least 3 m (10 ft), then move it back and try to
load it again. If it will not load, perhaps the substrate is not attached to the input core: try a different roll.

●

If the Internal Print Server displays a message 'The carriage beam height is not suitable for loading
substrate', call your service representative (see HP Customer Care Centers on page 409).

The substrate has jammed
If the printer reports a substrate jam, follow these steps.
1.

Press an emergency stop button as quickly as possible to minimize damage to the printheads.
NOTE:
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The printer may shut itself down automatically.

2.

Wait about 10 minutes for the printer to cool down.

3.

Open the front door.

4.

Remove all substrate and pieces of substrate from the printing zone and from any other parts of the printer
into which they may have fallen. Check the curing zone in particular. Make sure that nothing remains on the
substrate path. If you are unable to remove all obstructions, call your service representative (see
HP Customer Care Centers on page 409).

5.

Use Print Care to start the printer in service mode.

6.

Use the Print Care diagnostic menu to raise the carriage beam, and check underneath for any pieces of
substrate.
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7.

Use the same menu to lower the carriage beam to its normal position.

8.

Before restarting the printer, check that all circuit breakers are on and all emergency stop buttons released.

9.

Use Print Care to restart the printer in normal mode.

10. Reload the substrate.

The substrate is not attached to the core and/or spindle
If the printer detects a lack of tension during the substrate check after loading, it will ask you to confirm the
winding direction.
If the roll is not firmly attached during printing, you may see banding on your prints, or hear metallic noises.
If you see an error message numbered 41.00.00.62 or 41.00.01.62 while printing, it means that the substrate
may have become detached from the spindle, or the core is slipping on the spindle. This could mean that you
have reached the end of the roll, or the spindle is not correctly inflated, or the dual-roll differential hub is locked.
The substrate is automatically unloaded when this error occurs.
You should respond to this error in the following ways.
●

Check whether you have reached the end of a roll.

●

Check that the spindle is correctly inflated: one valve for the single-roll spindle, and both valves for the
dual-roll spindle.
NOTE:

If you are using only one half of the dual-roll spindle, only that half needs to be inflated.

●

For dual-roll printing, check that the differential hub is unlocked.

●

Check that the inner diameter of each substrate core is not too large for the spindle.

If the roll is not firmly attached to the input core, proceed as follows.
1.

Unload the roll from the input spindle and load it onto the output spindle. Take care to avoid telescoping.

2.

Raise the pinches and, using the Internal Print Server, raise the carriage beam to its maximum height.

3.

Unload substrate from the roll and pass it backwards through the printer towards the input spindle. Attach
it to the empty core on the input spindle, securing it with adhesive tape. Wrap a couple of turns of substrate
around the input core. Take care to align the substrate with the output roll.

4.

Lower the pinchwheels.

5.

Go to the Internal Print Server and select Substrate Load/Unload, then select the printer configuration and
press Load.

6.

Select the correct substrate in the Internal Print Server.

7.

Press Move substrate in the Internal Print Server, then Back, and wait until all the roll has been wound onto
the input spindle.

8.

You may decide to cancel rewinding when the substrate is detached from the output roll. Then attach it to
the output core to print immediately, or rewind it completely onto the input core if you want to remove the
roll.

The substrate is not flat
If the substrate does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see
defects in the printed image, such as vertical stripes. This can happen when you use thin substrate that becomes
saturated with ink; it can also be caused by the combination of heat and vacuum pressure that is applied to the
substrate.
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1.

Check that the substrate type you have loaded corresponds to the substrate type selected in the Internal
Print Server and in your software.

2.

If you are using a paper-based substrate, try changing to a thicker substrate, or reduce the amount of ink.

Printing issues
A spindle latch suddenly opens during printer operation
If a spindle latch is not closed before starting the substrate load, or it is opened by someone after the spindle
was already moving or while the substrate was under tension, the spindle can move out of place. Closing the
latch in those conditions can cause an incomplete latch engagement, and then at some point the latch may
spontaneously open completely.
The best solution is to eliminate substrate tension, avoid spindle movement, and then close the latch properly.
To do this, return to the substrate load/unload menu, ensure that the spindle is properly in place (in case of
doubt, extract it a bit and then push it back fully inside again), then close the latch (the blue part should now go
down completely).

The substrate advances with a loud continuous sound of vibration
A loud continuous sound of vibration during the substrate advance can be caused in the following ways:
●

The input spindle is not applying tension.

●

Wrong tension or vacuum settings result in an incorrect balance of forces on the main roller.

If you hear this sound, here are some suggestions:
1.

Check that the substrate you are using is the same as the one you have selected in the Internal Print Server.

2.

Check that you are using the generic substrate presets for the category. The use of incorrect values may
result in incorrect substrate behavior.
NOTE: Only substrates with high friction along the platen or substrates that easily wrinkle with
temperature need high output tension values. Check that your output tension is recommended for your
substrate.

3.

Check that there is no telescoping of the input roll.

4.

If you are using the roll-to-roll configuration with dual-roll spindles and you see smears, or the substrate is
not adhering to the platen, mainly at the outer sides of both rolls, you are recommended to use the center
support with both spindles.
Once installed, you can try to move it up slightly from its calibrated position if you are suffering from
wrinkles or the substrate is not adhering to the platen at the outer edges. This could mean that the support
has been calibrated below the correct position.
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Otherwise, you can try to move the support down a bit if you are suffering from wrinkles or the substrate is
not adhering to the platen at the inner edges near the center of the printer. This could mean that the
support has been calibrated above the correct position.
NOTE: Although the center support can be installed while printing, you are recommended to stop the job,
unload the substrate, and reload completely, even unwinding the substrate from the output spindle. See
Load a roll (dual roll-to-roll configuration) on page 77.
5.

Reload the substrate and try to minimize skew while loading. Check that you using the correct loading
procedure.

6.

Increase the input tension in steps of +5 N/m from the recommended setting for each category until you
eliminate the issue.

There is skew or telescoping on the output spindle
Extreme skew (approximately 10 mm peak to peak) and telescoping in the output spindle while it winds can be
caused in three main ways:
●

The substrate has not been correctly loaded and aligned during the loading procedure.

●

The roll loaded on the input spindle is skewed, and this skew is transferred to the output spindle.

●

The roll loaded on the input spindle has been wound with different tensions at its two ends.
Printing on rolls that are not wound accurately during manufacturing may lead to wrinkles and skew
problems and, generally, this problem can be identified easily because you can see a loss of tension at one
side of the substrate between the input roll and the main roller. In that case, see the relevant information
provided in the section There are wrinkles and ink smears on the substrate on page 363.

●

If printing with dual roll split spindle see Check center support alignment to solve this issue on page 369.

NOTE: When printing with dual rolls, you are more likely to notice skew on the output spindle. However, it is not
necessarily a problem. If it becomes a problem, proceed in the same way as for a single-roll configuration and
consider the use of the recommended center support for dual-roll spindle in both input and output.
NOTE: When printing with dual roll split spindles, you are more likely to notice skew on the output spindle. If it
becomes a problem, see HP Latex 3500/3600 dual-roll split spindles center support on page 63.
TIP: If you notice that one of the substrate edges is not as well tensioned as the other between the platen and
the main roller, showing a wave-like shape as it enters the platen, then you are likely to have skew, and you
should consider the use of the center support for dual-roll spindle in both input and output.
TIP: When suffering from extreme skew that tends to increase (normally with highly temperature-sensitive
substrates), try to use a thicker core that is not deformed by the rubber traction grooves on the spindle when
inflated. Then follow the guidelines below for reducing skew.
Generally, the main contributor to skew is an imprecise substrate load, and the effects of that are worse with
wide rolls. However, if you have some skew or telescoping but this does not affect your print quality, and does
not generate wrinkles in the substrate (see There are wrinkles and ink smears on the substrate on page 363),
there is no need to take any action. However, you are recommended to reload the substrate in order to eliminate
any potential problem.
Some substrate rolls already come with skew; in that case the recommendations are as follows:
1.

Try to load the substrate following the correct procedure, taking as a reference of the roll’s width the
average between peaks of skew.
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2.

Start with the recommended configuration and increase vacuum and tensions step by step (i to iv),
following the table below.

There are wrinkles and ink smears on the substrate
Wrinkles in the substrate indicate that the substrate settings that control the substrate shape are not optimized.
This can cause various printing defects.
●

Colored bands in area fills in the vicinity of the wrinkles

●

Ink smears if the printhead touches the substrate

●

Cockle

●

A substrate crash if the printhead's movement over the substrate is impeded

There are various reasons why wrinkles and other consequent effects could appear while printing:
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●

Incorrect loading of the substrate

●

Incorrect routing of the substrate through the printer

●

Incorrectly positioned edge holders

●

Drying and curing temperatures too high for the substrate

●

Differential expansion of the substrate due to variations in temperature

●

Insufficient tension settings

●

Non-uniform tension across the substrate when loading

●

The roll loaded on the input spindle has been wound with different tensions at its two ends.

●

Wrong alignment of the center support split spindles (HP Latex 3500/3600 only).
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NOTE: When printing with rolls that have not been precisely wound with the same tension along their
width during manufacturing, you may notice that, while printing, one of the sides of the substrate between
the input spindle and the main roller loses all tension. This may cause wrinkles on the platen or telescoping
on the output spindle.
TIP: If you notice that you are suffering wrinkles on the platen and that the substrate between the input
spindle and the main roller has lost all tension at one side, try printing in the roll-to-floor configuration, and
using the substrate collector if required. If you still see some problems, try to increase tension by following
the recommendations below.
TIP: When suffering from wrinkles and extreme skew with a self-adhesive vinyl, calendered materials are
typically more sensitiive to temperature. Try to use a thicker core to reduce the effects of the spindle’s
rubber traction grooves, and increase tension as recommended below, using configuration iii, iv, or v in the
table.
If your prints suffer from any of the defects caused by wrinkles, here are some suggestions.
1.

Check that the substrate you are using is the same type as the one you have selected in the Internal Print
Server.

2.

Check that you are using the generic substrate preset for the substrate category. The use of incorrect
values may cause incorrect substrate behavior.

3.

Check that there is no telescoping of the input roll.

4.

If you are using the roll-to-free-fall configuration, check that the knob is released to ensure substrate
tension.
When printing in the roll-to-free-fall configuration and you see diagonal smears of ink, the substrate may
have been badly loaded; or the tension roller may be causing wrinkles in the substrate. In the latter case,
you can try using the tension roller knob to reduce the pressure that the roller exerts on the substrate, as
shown below:

To restore the tension roller pressure to normal, pull the knob and turn it as shown below.
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5.

Reload the substrate and try to minimize skew while loading. Check that you are loading the substrate
using the correct procedure.

6.

If you have experienced a substrate crash because the lateral edge of the substrate in the print zone is not
flat enough, and is raised or even partially cut because you are not using edge holders, then you are
recommended to use them.

NOTE: If you are already using edge holders, check that they are correctly positioned (see The substrate
edge holders on page 43).
7.

Try reducing the drying power and curing temperature.

8.

Start with the recommended configuration and increase vacuum and tensions step by step (i to iv),
following the table below.

TIP: If you have suffered a substrate crash, try starting with step iv and moving backwards up the table
until you find settings that work.
9.
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Try reducing the curing temperature and ink quantity, and raise the curing airflow to help in reducing the
substrate’s thermal contraction.
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10. Consider changing the printer configuration. Use the roll-to-free-fall configuration as it is least prone to
wrinkles.
11. If you cannot get rid of the wrinkles, try raising the carriage beam slightly, so that the printhead is not so
close to the substrate.
For information on how to adjust printer settings, see Edit a substrate preset on page 110.

There are ink marks on the substrate
This problem can occur if any component in contact with the substrate is dirty. Check the pinchwheels, diverters,
print platen, curing module plates, and roller, and clean them if necessary.
If the ink marks occur at the sides of the substrate and not in the center, and you are using the substrate edge
holders, check that they are correctly placed and clean.

The substrate sticks to the platen
When the substrate sticks to the platen, the most likely causes are excessive heat applied by the drying system,
excessive vacuum, or a dirty platen, which increases friction and can impede the substrate advance. In the latter
case, the substrate may rise up in a bubble or wave before reaching the platen.
Here are some suggested ways to correct the problem:
1.

Check that the substrate you are using is the same type as the one you have selected in the Internal Print
Server.

2.

Check that you are printing on the correct side of the substrate.

3.

Check that you are using the generic substrate preset for the substrate category. The use of incorrect
values could cause incorrect substrate behavior.

4.

Reload the substrate and try to minimize skew while loading. Check that you are loading the substrate
using the correct procedure.

366 Chapter 10 Troubleshoot substrate issues

ENWW

5.

Increase vacuum and tensions step by step (i to v) following the table below, until you find settings that
work.

There are physical marks on the substrate
This only can occur when substrates sensitive to permanent deformation are used. These marks are usually seen
in isolated areas and mainly caused by high curing temperature or substrate tensions.
Here are some suggested ways to correct the problem:
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1.

Check that the substrate you are using is the same type as the one you have selected in the Internal Print
Server.

2.

Check that you are using the generic substrate preset for the substrate category. The use of incorrect
values could cause incorrect substrate behavior.

3.

Reload the substrate and try to minimize skew while loading. Check that you are loading the substrate
using the correct procedure.

4.

Try to reduce curing temperature and ink quantity if possible, and raise the curing airflow to help in
reducing the substrate deformation.
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5.

Reduce tensions and modify vacuum settings, following the table below step by step (a to c), until you find
settings that work.

There are drops of ink on the substrate

NOTE: In the above example, the distance between the drops is about 1 cm (0.4 in).
1.

If you are using the substrate edge holders, clean them.

2.

Clean the sides of the printheads and the sides of the printhead slots.

3.

Clean the electrical connections to the printheads. See The Internal Print Server recommends replacing or
reseating a printhead on page 401.
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Dual roll printing issues
When printing with an HP Latex 3500/3600 and its dual roll center support, the following issues could appear if
misalignment of the center support Split spindles occurs:
●

Wrinkles

●

Ink smears

●

Uneven performance between the two rolls

●

Telescoping due to Skew convergence

Check center support alignment to solve this issue
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1.

Install laser pointer onto the latch laser support provided, and place it on the ISM latch support.

2.

Place the target on the latch at the IPS side of the printer.

3.

Use the laser pointer to reach the target at the IPS side of the printer.

4.

Take the center support and place it in the middle of the printer.

5.

Install targets on the center support.

Dual roll printing issues 369

6.

Regulate the height of the center support in order that the laser beam crosses the center support targets
and reaches the target installed on the IPS side of printer. Once the desired height is reached, fix it.

IMPORTANT: If you can’t realign the center support with the adjustment done using the screws located in the
rear side of the center support base, the misalignment has to be fixed following the installation process. Contact
your support representative.

Calibrate the dual-roll center support
1.

Load a single-roll spindle into the printer.
TIP: Use a single-roll spindle to calibrate the height of the dual-roll center support accurately. Do not use
the dual-roll spindle, as it is heavier and it may not be level along its length.

2.

Place the dual-roll center support under the center of the spindle.

3.

Pull the lever down.
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4.

Adjust the height of the support by turning it counterclockwise. The bearings at the top of the dual-roll
center support must touch the spindle.

5.

Manually turn the spindle 360 degrees. Make sure there is full contact between the bearings on the support
and the face of the spindle except along the ruler groove and pneumatic groove. Turn the bearings on the
support. If you cannot turn them, lower the height of the support.

NOTE: If a red groove is visible in the thread of the support shaft, it has reached its maximum limit. Do not
turn. Adjust the height using the three height screws under the support base. Tighten the three hexagonal
nuts on the top of the support base to lock the three height screws.
6.
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Pull the small lever down.
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7.

Lift the base nut one extra turn by rotating counterclockwise. There are two red dots in the central shaft for
your reference.

8.

Tighten the base nut.

9.

Tighten the two screws to fix the final position of the dual-roll center support.
NOTE:

Hold the support shaft firmly in position when tightening the screws.
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10. Insert the screw into the support base.

11. Remove the single-roll spindle.
12. Repeat the process for calibration of the front dual-roll spindle.
IMPORTANT: If you can’t realign the center support with the adjustment done using the screws located in the
rear side of the center support base, the misalignment has to be fixed following the installation process. Contact
HP.

Periodic noise on the center support latch when the substrate is moving
To solve this problem, readjust the center support latch on the spindle. To do this it is important to check the
following requirements:
●

Center supports installed

●

Spindles loaded

●

Central support latch closed

To adjust the central support latch on the spindles:
1.
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Loosen the two lateral central support latch screws.
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2.

Loosen the 2 top nuts (if needed), then proceed to screw the top set screws with an Allen key until both
bearings of the latch are in contact with the spindle surface.

3.

Tighten the top nut and the lateral screws to fix the position.

NOTE: Screwing the set screws is easy until the spindle is reached. Do not over tighten the set screws;
when the spindle is reached, please proceed to tighten the top nuts instead.

Print length issues
The print is shorter than expected
Some substrates naturally contract when they are printed on and cured, this can mean the total length of the
print is shorter than expected. If this is the case, you can expand the length of the print from the RIP, which will
compensate for the contraction of the substrate. Alternatively, change to a less thermal-dependent substrate to
reduce the contraction.

How to achieve better consistency between jobs of the same length
The printer has been designed to maximize consistency in the length of the printed substrate. However, there are
external variables that can contribute to variability: substrate variations and enviromental conditions.
1.

Select a substrate which is less susceptible to expansion when being printed on. Most paper-based
substrates have a tendency to expand.
●

If you need to print on a substrate susceptible to expansion:
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●

–

Ensure that the density of ink is similar between each tile (if not, the tile with less ink might be
shorter).

–

If possible, decrease the heating temperature.

–

Reduce the ink restrictions as much as possible.

Make sure that the roll is left within the room where the printer is located for at least 24 hours, this is
to ensure the complete roll has the same temperature as the printer.

2.

Do not touch the print adjustments (no change of substrate advance compensation) between tiles.

3.

Print all the tiles at once.
●

Do not split the jobs at different times (1 tile one day, and the 2nd tile the 2nd day)

●

Do not change the print mode or the substrate width between tiles.

To print the tiles all at once, we recommend the following:
a.

Create the tiles from the Internal Print Server.

b.

If you are creating the tiles from the RIP, ensure that you send all the tiles within the same jobs sent to
the printer/Internal Print Server.

The objective is to make sure that there is no pause between the tiles. When using the Queue mode in the
Internal Print Server, there is still a small time between jobs, which could add more variability between the
lengths of the tiles.
4.

In order to make sure that even the first tile has less difference in length compared with the other ones, add
a top margin of 50 cm.
In case you have to reprint one tile, in order to ensure the length will be as close as the previous jobs:
●

Make sure that the substrate and also the ambient temperature of the printer are the same as when
the previous job was printed.

●

Add a top margin of 50 cm.

But in any case, when having to reprint a tile later, there is a higher probability that the length will be
different from the other tile length. The total length repeatability depends on the substrate, the changes in
environmental conditions, and the contents of each job (mainly when the substrate is reacting differently
depending on the ink density).

Collector issues
The collector stops winding
The collector has a safety timer that will stop rewinding substrate if it is not fully collected after 30 seconds, and
will stop unwinding substrate after 5 seconds if the substrate loop is not detected by the collector sensor. If you
have a lot of substrate to be collected lying on the floor, you will have to restart the collector by clicking the
corresponding icon.
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●

If the collector keeps stopping, and collector movement causes the substrate to be tight between pressure
roller and collector when winding, there could be an object blocking the collector sensor path, or the
winding direction may not have been selected correctly when restarting the collector.

●

If the collector keeps stopping, and collector movement makes substrate loops accumulate on the ground
when unwinding, it is possible that the winding direction has not been selected correctly when restarting
the collector, or that the collector sensor or electronics are broken and should be replaced.
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The collector occasionally fails to work correctly
The collector may fail to work correctly if its optical sensor is dirty or blocked by some obstacle.

The collector winds in the wrong direction
1.

Check that the winding direction is set correctly in the Internal Print Server.

2.

Check that there is no obstacle blocking the collector's optical sensor.

The substrate is detached or winds around the collector in the wrong direction
Here are some possible explanations.
●

The winding direction has been set wrongly.

●

The collector has been loaded wrongly.

There is skew or telescoping on the collector
This may happen if the substrate was not properly aligned when attaching it to the collector core. You are
recommended to follow the loading instructions; in particular, align the substrate well.
TIP: If you have a lot of substrate lying on the ground after printing in roll-to-free-fall mode, and you want to
attach it to the core, you are recommended to choose a core that is the same width as the substrate, so that a
good length of substrate can be aligned around the core before you attach it.
If you cannot resolve the problem satisfactorily, you are recommended to use the roll-to-roll configuration
instead, which has better winding performance.

The substrate has jammed on the collector
Here are some possible explanations.
●

Too much substrate on the collector. The maximum diameter of the output roll is 300 mm (11.8 in) for the
recommended outwards winding, or 200 mm (7.9 in) for inwards winding.

●

The substrate is misaligned.

●

The loop shaper is the wrong length.

Slitter poor cutting quality
If the in-line slitters do not cut the substrate properly, the main reasons could be:
●

Unsupported substrate: look for a compatible blade if using unsupported substrates.

●

Blade worn out: use the other side of the cutter blade or replace it by removing the lateral blue screw that
fixes it.

For use with the in-line-slitters, provided with the printer are standard slotted 2.25 inch (57mm) x 0.75 inch
(19mm) blades, with a thickness of up to 0.025 inches (0.6mm). Different blade coating or finishing can affect cut
performance and blade life duration. Based on the specific application; please take this into account when
replacing blades.
●

The slitter is not properly adjusted: check if the slitter is properly installed, that it is in contact with the
diverter wheels, and that the blade reaches the paper. Check on the images below for the correct position,
and adjust the blade's position accordingly if necessary.
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To adjust the cutter blade positions, untighten the two lateral screws with an Allen key, then adjust the
position as shown in the image. To fix the correct position; tighten the screws.
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General advice
The HP Latex 3000 printer series has been designed and qualified to the highest standards to provide the
optimal compromise between print quality and productivity. Prints for outdoor use can accommodate more
visible defects as they are viewed from a long distance. For shorter distances, as in indoor advertising, defects
need to be less visible. To decide whether a defect is considered acceptable, as a rule of thumb, the table below
shows the appropriate viewing distances.
Print mode

m²/h

ft²/h

4 pass (outdoor)

98

1050

6 pass (indoor)

77

828

To view output at…

>3m

1–3 m

You are recommended to review the acceptability of a defect according to this table before proceeding to
diagnose it to make sure the selected print mode is the most appropriate for the purpose of the job. Increasing
the number of passes to 8 or more enables higher ink quantities if needed and/or the use of difficult printing
materials thanks to the longer drying and curing times. Print modes with more passes are more resistant to
banding. In general, follow these recommendations:
●

Avoid touching the substrate while printing is in progress.

●

Judge the print quality after the print has completely emerged from the printer. In some cases, defects
seen while printing disappear after the image is completely cured.

●

Check that the environmental conditions (room temperature and humidity) are in the recommended range.
See Environmental specifications on page 414.

Before troubleshooting, check the following points:
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●

To achieve the best performance from your printer, use only genuine HP supplies and accessories, whose
reliability and performance have been thoroughly tested to give trouble-free performance and best-quality
prints.

●

Check that the substrate type selected in the Internal Print Server is the same as the substrate type loaded
into the printer.
CAUTION: If you have the wrong substrate type selected, you could experience poor print quality and
incorrect colors, and perhaps even damage to the printheads.

●

Check that you are printing on the right side of the substrate.

●

Check that you are using in the RIP software the correct substrate preset, which includes the ICC profile for
your substrate and print mode.

●

Check whether there are any outstanding printer alerts in the Internal Print Server. React to the alert as
instructed in this guide.

In particular:
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●

Make sure the substrate is flat and has no wrinkles. See Troubleshoot substrate issues on page 359.

●

Check that the substrate has no skew or telescoping. Check that you are loading the substrate using the
correct process. See Load a roll into the printer on page 65.

●

For color consistency issues, check that the color calibration was performed when the substrate was added
to the Internal Print Server. See Use a new substrate on page 103.

●

Make sure it has also been performed in the current conditions, especially considering substrate batch and
printheads. See Color calibration on page 178.
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Image quality inspection plot
The Image Quality Inspection Tool is designed to provide a guided troubleshooting process for users facing
banding issues, especially horizontal banding. The tool consists of two parts: an image to print, and a guide for
the troubleshooting process.
The image consists of 12 solid area fills of 7.62 cm x 22.86 cm (3 x 9 in). The six rectangles in the top row are
printed by a single ink each, and the six rectangles in the bottom row are secondary or tertiary colors printed
using more than one ink. Note that colors in this image may differ from the ones expected. This is a desired
behavior, since this image is not used to verify color accuracy.
This plot can be printed from the Internal Print Server in the Printer menu.

When facing banding issues, print the Image Quality Inspection Plot from the Printer menu: go to Printer > IQ
Inspection > Add New Job. This will add a job to the print queue. To print it, edit the details of the job to select the
substrate and print mode you want to check. Once the plot has printed, start the troubleshooting process. See
the Image Quality Troubleshooting Process image at the end of this section for a summary diagram of the
troubleshooting process.
1.

Determine if the banding in the image is caused by aeroworms. Aeroworms are thin bands with higher
density than the surrounding area that appear randomly and are not continuous across the substrate.

To correct this kind of non-uniformity:

2.

●

Increase the number of passes

●

Reduce the ink density

●

Check the carriage beam position

●

Check the aerosol filters

If the banding is not caused by aeroworms, continue with the following procedure:
a.

Horizontal banding
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i.

Banding present in all colors:
▲

ii.

iii.

b.

Banding in one or more colors of the top row:
a.

Execute a check and clean routine, print the printhead status plot and check the number of
blocked nozzles.

b.

If the number of blocked nozzles is roughly greater than 300 in any printhead, perform a
hard cleaning routine, selecting the colors affected.

c.

After executing the cleaning routines, reprint the printhead status plot, the image quality
troubleshooting plot, and check the current state of the printheads (expect to see less
nozzles clogged) and of the banding. If banding is still visible, increase the number of
passes.

d.

If none of the above work, replace the printhead that caused the banding (the one with
most nozzles clogged).

e.

If the problem persists after replacing the printhead, consider it may be a substrate
compatibility issue.

Banding in one or more colors of any row:
a.

Execute printhead alignment and recheck uniformity with the Image Quality
Troubleshooting Plot.

b.

Execute check and clean, print the Printhead Status Plot, and check the number of blocked
nozzles. If the number of blocked nozzles is greater than 300 in any printhead, perform a
hard cleaning routine, selecting the colors affected.

c.

Check the Substrate-Advance Compensation and calibrate if necessary.

d.

Change the type of mask and/or increase the number of passes.

e.

Reduce the ink density.

f.

If the problem persists after all the corrective actions, consider it may be a substrate
compatibility issue.

Vertical Banding
i.

ii.

Wide bands:
a.

Execute printhead alignment.

b.

Check carriage beam position.

c.

Decrease curing temperature to reduce deformation.

d.

Change from 4 to 6 colors to reduce grain.

e.

Check substrate settings (vacuum and tension).

Microbanding (vertical high-frequency lines, less than 2mm [0.08 in] wide):
▲

3.

Check the Substrate-Advance Compensation and calibrate if necessary. (Printer menu >
Advance calibration …)

Print the Printhead Alignment Plot to see the printhead responsible, and replace it.

After finishing the troubleshooting process, delete the image quality inspection job from the queue, and
keep the files on the disk.

NOTE: For more information on print quality troubleshooting, see the Advanced print-quality troubleshooting
on page 384.

ENWW

Image quality inspection plot 381

Image Quality Troubleshooting Process

After finishing the troubleshooting process, delete the image quality inspection job, and keep the files on disk.

Basic and advanced troubleshooting
The print-quality troubleshooting process is divided here, for convenience, into two levels: basic and advanced.
●

Basic troubleshooting will help to resolve the majority of the typical print-quality issues related to banding,
graininess, and printhead alignment.

●

Advanced troubleshooting helps to resolve the above issues when the basic steps did not work, but it also
covers other possible print-quality defects, diagnosis, and resolution.

Basic print-quality troubleshooting
1.

Identify the defect. This basic procedure applies to the following defects:
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2.

●

Horizontal banding

●

Graininess

●

Color misalignment
–

Blurred lines, edges, and text, horizontally and vertically

–

Halo of a different color around color lines and at the edges of color areas or text

–

Ink bleeding or wicking or different gloss at the edges of color areas

Perform the actions described in the following table.

Defect

Image quality inspection
plot procedure

Banding

Substrate-advance
sensor check

X

Isolated bands (usually of
different texture or grain)

X

Graininess

X

Blurry edges or text lines,
horizontally

Printhead alignment

X

X

X

Possible causes (for
reference only)
●

Blocked nozzles

●

Substrate advance
accuracy

●

Intra-color
alignment

●

Substrate-advance
accuracy and
navigability

●

Substrate advance
accuracy

●

Color alignment

●

Substrate advance
accuracy

●

Color alignment

Blurry edges or text lines,
vertically

X

●

Color alignment

Color halo on objects
(e.g., magenta shows up
under a blue line)

X

●

Color alignment

Ink bleeding, wicking, or
different gloss at the
edges of color areas

X

●

Optimizer
alignment

Printhead check and clean
See Check and clean the printheads on page 160. The check and clean process will check the printheads, recover
the ones with blocked nozzles, and replace the nozzles that are not recovered with healthy ones for printing.

Substrate-advance sensor check
Run the OMAS Diagnostic Test from the HP Print Care window.
NOTE: OMAS stands for Optical Media Advance Sensor, usually known as the substrate-advance sensor in this
guide.
The test will tell you whether the substrate-advance sensor is working correctly or not (either dirty or damaged).
If the substrate-advance sensor is dirty, clean the sensor. See Clean the substrate-advance sensor on page 204.
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Even if the sensor is working correctly, the substrate may not be navigable, meaning that the substrate-advance
sensor cannot see it properly (as in the case of transparent substrates or substrates with very smooth back side).
In this case, the substrate-advance sensor disables itself automatically. You are then recommended to adjust the
substrate-advance compensation: see Substrate-advance compensation on page 181.
For best results, cleaning the substrate-advance sensor is included in the printer’s weekly maintenance.

Printhead alignment
Perform a manual printhead alignment. See Alignment procedure on page 172.
The result of the alignment can be verified with the printhead alignment diagnostics plot. See Printhead
alignment diagnostics plot on page 175.

Advanced print-quality troubleshooting
If the basic print-quality troubleshooting does not solve the problem, here are some further procedures that you
can try.
One of the most important parts of print-quality troubleshooting is to ensure that the printheads are healthy.
See Printhead health troubleshooting on page 403.

Print-quality artifacts troubleshooting
Horizontal banding
Horizontal banding means that your print suffers from added horizontal lines or bands, in a regular pattern. They
can look different depending on the cause.
Thin dark lines
These are thin dark lines across the entire image with certain frequency, more easily seen in solid area fills. There
are two likely causes:
●

Printhead alignment. This is a clear contributor to banding. If printheads are not correctly aligned, the
misplaced dots could correlate directly with the severity of the banding, by putting more ink in the same
place and thus creating darker lines.
To check printhead alignment, print the printhead alignment diagnostics plot (see Printhead alignment
diagnostics plot on page 175). As a general rule, the biggest contributors to thin-dark-line banding caused
by printhead alignment are (in this order):
–

Intra-color alignment (alignment between the two printheads of the same color)

–

Inter-color alignment (alignment between different colors)

Here are some tips for solving this problem:

●

–

If the printhead alignment was done with a different substrate of different thickness, probably a new
printhead alignment is needed.

–

Fine-tune the alignment by identifiying the offenders in the printhead alignment diagnostics plot. See
Alignment procedure on page 172.

Substrate advance. Before trying to adjust any parameter, make the following checks:
–

Check that no substrate-advance factor was set earlier that could prevent the substrate-advance
sensor from working correctly.

–

Run the diagnostics to check that that the substrate-advance sensor is not dirty.
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If the substrate advance is not well adjusted, particularly if it is under-advancing, a dark line can appear
between passes.
A clear symptom of this is when the dark lines appear across all colors, because the cause is common to all
of them. To confirm it, in the Internal Print Server, select Printer > Advance Calibration to check the
substrate advance. See Substrate-advance test print on page 182.
You can usually correct this problem by adjusting the substrate advance compensation (see Substrateadvance compensation on page 181). However, you are recommended to run the OMAS Diagnostic Tests
from the Print Care window as soon as the substrate is unloaded, to avoid having the same problem with
other substrates. See Clean the substrate-advance sensor on page 204.
If the problem persists, try adjusting tension and vacuum settings according to the table below, step by
step (a to c), until you find settings that work.

Thin white lines
These are thin white/light lines across the entire image at regular intervals, more easily seen in solid area fills.

There are three likely causes:
●
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Nozzle clogging. A printhead nozzle can be sealed temporarily, by some fibers or dirt in the ink bore. Then
not all the ink is fired and a lighter horizontal band appears. Sometimes a bigger drop with all the

Advanced print-quality troubleshooting 385

accumulated ink appears at the end of this light thin line, meaning that the bore is clear then. See Printhead
health troubleshooting on page 403.
●

Printhead alignment. This is a clear contributor to banding. If printheads are not correctly aligned, the
misplaced dots could correlate directly with the severity of the banding, by leaving lighter bands where the
ink should have been placed.
To check printhead alignment, print the printhead alignment diagnostics plot (see Printhead alignment
diagnostics plot on page 175). As a general rule, the biggest contributors to thin-white-line banding caused
by printhead alignment are (in this order):
–

Intra-color alignment (alignment between the two printheads of the same color)

–

Inter-color alignment (alignment between different colors)

Here are some tips for solving this problem:

●

–

If the printhead alignment was done with a different substrate of different thickness, probably a new
printhead alignment is needed.

–

Fine-tune the alignment by identifiying the offenders in the printhead alignment diagnostics plot. See
Alignment procedure on page 172.

Substrate advance. Before trying to adjust any parameter, make the following checks:
–

Check that no substrate-advance factor was set earlier that could prevent the substrate-advance
sensor from working correctly.

–

Run the diagnostics to check that that the substrate-advance sensor is not dirty.

If the substrate advance is not well adjusted, particularly if it is over-advancing, a white line can appear
between passes.
A clear symptom of this is when the white lines appear across all colors, because the cause is common to
all of them. To confirm it, in the Internal Print Server, select Printer > Advance Calibration to check the
substrate advance. See Substrate-advance test print on page 182.
You can usually correct this problem by adjusting the substrate advance compensation (see Substrateadvance compensation on page 181). However, you are recommended to run the OMAS Diagnostic Tests
from the Print Care window as soon as the substrate is unloaded, to avoid having the same problem with
other substrates. See Clean the substrate-advance sensor on page 204.
If the problem persists, try adjusting tension and vacuum settings according to the table below, step by
step (a to c), until you find settings that work.
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Bands of light and dark zones
These are periodic horizontal bands formed of a lighter band and a consecutive darker band. This pattern is
mostly seen in solid color area fills (such as light purple or gray).

There are three likely causes:
●

Coalescence. This is due to an excessive amount of ink, and the ink being misplaced as it is deposited on the
substrate, generating bands with more ink than other alternate bands. It can also be caused by firing too
much ink in a short time. Coalescence is most likely to be seen in areas of high ink density.
Here are some tips for solving this problem:

●

–

Use lower ink density.

–

Increase the number of passes.

–

Change the type of mask (Large mask / Uniformity).

Printhead alignment. This is a clear contributor to banding. If printheads are not correctly aligned, the
misplaced dots could correlate directly to the severity of the banding.
To check printhead alignment, print the printhead alignment diagnostics plot (see Printhead alignment
diagnostics plot on page 175). As a general rule, the biggest contributors to light-and-dark banding caused
by printhead alignment are (in this order):
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–

Bidirectional alignment

–

Intra-color alignment (alignment between the two printheads of the same color)

–

Inter-color alignment (alignment between different colors)

Here are some tips for solving this problem:

●

–

If the printhead alignment was done with a different substrate of different thickness, probably a new
printhead alignment is needed.

–

Fine-tune the alignment by identifiying the offenders in the printhead alignment diagnostics plot. See
Alignment procedure on page 172.

Substrate advance. Before trying to adjust any parameter, make the following checks:
–

Check that no substrate-advance factor was set earlier that could prevent the substrate-advance
sensor from working correctly.

–

Run the diagnostics to check that that the substrate-advance sensor is not dirty.

When the substrate advance is incorrect, some light and dark horizontal bands can appear from the
misplacement of the ink.
To confirm it, in the Internal Print Server, select Printer > Advance Calibration to check the substrate
advance. See Substrate-advance test print on page 182.
You can usually correct this problem by adjusting the substrate advance compensation (see Substrateadvance compensation on page 181). However, you are recommended to run the OMAS Diagnostic Tests
from the Print Care window as soon as the substrate is unloaded, to avoid having the same problem with
other substrates. See Clean the substrate-advance sensor on page 204.
If the problem persists, try adjusting tension and vacuum settings according to the table below, step by
step (a to c), until you find settings that work.

Gloss banding
This appears in dark, high-density areas as horizontal gloss or matte bands about 1 cm wide. It can happen
when the curing system settings are not correct for the substrate.
If the bands are more apparent when tilting the print or changing your viewing position, then it is likely to be
gloss banding.
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To solve the problem, check your curing settings (airflow, curing temperature). You could also try using a different
print mode.
Aeroworms
Aeroworms consist of thin bands with higher density than the surrounding area. They are about 6 cm long and
have a horizontal tendency, but they tend to curve like worms. They are not continuous across the substrate, and
seem to appear at random.

When the ink is being fired, there are airflow turbulences under the carriage that can affect the positioning of the
drops. Therefore, some waves of ink can be formed and deposited on the substrate to create this effect.
Here are some tips for solving this problem:
●

Increase the number of passes.

●

Reduce the ink density.

●

Check the printhead-to-ribs spacing in the Internal Print Server. If it is higher than normal, try reducing it.

●

Check that the aerosol filters are not saturated or broken (see Replace the aerosol filters on page 162).

Vertical banding
Vertical banding means that your print suffers from added vertical lines or bands, in a regular pattern.
Microbanding
This consists of vertical lines less than 2 mm (0.08 in) wide, of very high frequency, that appear in some area fills.
Often they are hardly visible.

Microbanding is probably caused by a faulty printhead. Print the printhead alignment diagnostics plot (see
Printhead alignment diagnostics plot on page 175) to find which printhead is responsible, and replace the
printhead.
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Wide bands 2 cm apart
If the bands are about 2 cm (0.8 in) apart, it means that the substrate is well controlled in the print zone and is in
contact with all the ribs in the platen as intended. However, if the suction is too high, a difference in grain can be
seen, and bands appear 2 cm apart.
Here are some tips for solving this problem:
●

Align the printheads.

●

Check the scan-beam height in the Internal Print Server. If it is higher than normal, try lowering it.

●

Decrease the curing temperature to reduce deformation.

●

Change from 4 to 6 colors to reduce grain.

●

Decrease vacuum and tension settings according to the table below, step by step (a to c), until you find
settings that work.

Wide bands at least 4 cm apart
A small amount of vertical banding (like waves) can be seen, with a frequency from about 4 cm (1.6 in) to 10 cm
(3.9 in), when printing large area fills of the same color.
The substrate is not in contact with all the ribs in the platen, which means that it is not fully controlled, so wide
wrinkles appear on the print zone. As the height of the printhead above the substrate varies, there are local
differences in grain that can be seen as lighter or darker wide bands (see picture). To solve this, it is important to
improve substrate control in this zone and reduce the wrinkles.
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Here are some tips for solving this problem:
●

Check the scan-beam height in the Internal Print Server. If it is higher than normal, try lowering it.

●

Align the printheads.

●

Decrease the curing temperature to reduce deformation.

●

Change from 4 to 6 colors to reduce grain.

●

Increase vacuum and tension settings according to the table below, step by step (i to iv), until you find
settings that work (by improving control in the print zone).

Color misalignment
Colors appear misaligned. Typically, lines and text are most affected by this issue.

It can happen in both axes: the substrate axis and the scan axis.
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Color misalignment is most likely to be caused by printhead misalignment. To check printhead alignment, print
the printhead alignment diagnostics plot (see Printhead alignment diagnostics plot on page 175).

Bleed, halo, wicking
Sometimes a small color migration may be observed at the border between different colors (bleed). It may also
happen at the border between a color and blank substrate (no ink), reducing the sharpness of the shape. On
some substrates, a gloss halo can be observed at the border between colors.

There are three likely causes:
●

Optimizer misalignment: There may be misalignment between the optimizer printhead and the other
printheads. To check the printhead alignment, print the printhead alignment diagnostics plot (see Printhead
alignment diagnostics plot on page 175). If necessary, perform a manual alignment, then reprint the
printhead alignment diagnostics plot.
If the problem is in the substrate axis direction, it may also be caused by incorrect substrate advance. See
Substrate-advance test print on page 182 and Substrate-advance compensation on page 181.

●

Optimizer level, which may be too low for this substrate and ink density. Other associated defects may also
appear, such as coalescence or grain in the area fills due to low wetting of the ink on the substrate. You can
correct this problem by increasing the optimizer percentage in the substrate preset.

●

Drying power, which may be too low for this substrate and ink density. Other associated defects may also
appear, such as coalescence or grain in the area fills due to low wetting of the ink on the substrate. You can
correct this problem by increasing the drying power leading/trailing percentages in the substrate preset.

Low gloss, haze
On glossy substrates, the print may have lower gloss than expected, which is probably due to the optimizer level.
To investigate and correct this problem, try increasing and decreasing the optimizer percentage in the substrate
preset.
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Color accuracy
Ideally, the colors that you see on the screen should match the colors in the print. In practice, you may find that
the colors are not sufficiently accurate. There are three possible causes:
●

Color calibration provides consistent colors, but consistent colors are not necessarily accurate. However, if
the combination of substrate and printheads has not been calibrated recently (or ever), that is a possible
source of color inaccuracy. You can eliminate the possibility by performing a color calibration (see Color
calibration on page 178).

●

ICC profile. If you are using the wrong profile, your colors are likely to be inaccurate. Check which profile you
are using. If necessary, you can make your own ICC profile for the printer, printheads, print mode, and
substrate that you are using.

●

Ink density, which affects color saturation. If the color saturation of your print seems wrong, try changing
the ink density in the substrate preset; you may need to change the number of passes at the same time.

Local color variations
In some cases, at the edges of area fills, a small number of ink drops may be missing or slightly darker, producing
a local color variation.

These defects are due to the printheads travelling from side to side without printing.
●

In each pass, the first 1 or 2 drops of a color are missing or smaller.

●

In each pass, the first 1 or 2 drops of a color are darker because they are more concentrated with pigment.

To resolve these defects, add color bars at each side of the image, to make sure nozzles are refreshed before
printing each pass. If possible, you could also rotate the image to avoid situations such as shown in the example.

Color variations when tiling
When tiling, it is important that all tiles have the same length and that the colors of the mating edges match. This
section focuses on color variations; for recommendations about length consistency, see How to achieve better
consistency between jobs of the same length on page 374.
To achieve better color consistency it is recommended to optimize tiling performance via the IPS (Substrate >
Tiling optimization). See Optimize for tiling on page 104.
Also check step 5 of Edit a substrate preset on page 110.
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Possible causes
●

Uniform variations from tile to tile. When color changes uniformly it must be within the color consistency
specification; see Color consistency on page 41 for more details. Usually grays are much more sensitive:
differences of much less than 2 dE 2000 may be visible, although other colors would not show a difference.

●

Small color variation left to right. The tile itself looks uniform, but when putting it beside the adjacent tile
the differences become visible.

●

Local color variations. See Local color variations on page 393. Sometimes these defects become visible
only when printing tiles, showing in one of the tiles but not in the adjacent. They are also more visible when
printing grays.

Possible solutions
●

Try to ensure uniform printing of all tiles, and all tiles printed in the same run.

●

Rotate every other tile, to compensate for left to right differences.

●

Adding color bars at both sides of the image helps overall, especially when there are local color variations.

Edge roughness, text quality
The edges of objects may appear rough or blurred; this is especially noticeable in text.

There are five possible causes:
●

Bleed: see Bleed, halo, wicking on page 392.

●

Printhead alignment. As each ink is deposited by two printheads of the same color, it is important that the
two printheads are correctly aligned. When a color is formed by a combination of inks, which is often the
case, it is also important that printheads of different colors are correctly aligned.
To check printhead alignment, print the printhead alignment diagnostics plot (see Printhead alignment
diagnostics plot on page 175), and fine-tune the alignment by identifiying the offenders in the plot.

●

Substrate advance. Before trying to adjust any parameter, make the following checks:
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–

Check that no substrate-advance factor was set earlier that could prevent the substrate-advance
sensor from working correctly.

–

Run the diagnostics to check that that the substrate-advance sensor is not dirty.

If the substrate advance is incorrectly adjusted, particularly if it is under-advancing, a dark line can appear
between passes. When the problem of line roughness or text quality applies to all colors and appears in the
substrate axis direction, it is likely to be related to incorrect substrate advance. Another clue that could
point to substrate advance as a cause is to observe that the defect is not constant, appearing and
disappearing along the print in the substrate axis.
To confirm it, go to the Internal Print Server and select Printer > Advance Calibration to check the substrate
advance. See Substrate-advance test print on page 182.
To correct the substrate advance, see Substrate-advance compensation on page 181. In most cases, this
will solve the problem. However, you are recommended to run the OMAS Diagnostic Tests from the Print
Care window as soon as the substrate is unloaded, to avoid having the same problem with other
substrates. See Clean the substrate-advance sensor on page 204.
If the problem persists, try adjusting tension and vacuum settings according to the table below, step by
step (a to c), until you find settings that work.

●
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Printhead-to-ribs spacing. Check the printhead-to-ribs spacing in the Internal Print Server. If it is higher
than normal, try reducing it.
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●

Vacuum. In some thin substrates, if the vacuum is too high, the substrate follows the shape of the platen
ribs, modifying the printhead-to-substrate spacing and causing vertical line roughness. In this case, as the
substrate advances, vertical lines get wider after each pass, while horizontal lines are not affected.
To correct this problem, try adjusting tension and vacuum settings according to the table below, step by
step (a to c), until you find settings that work.

Graininess
The print shows a higher level of grain than expected, either throughout the print or in some specific areas. The
example below shows more grain in the lower half than in the upper half.

This can occur for various different reasons.
●

Coalescence. Some substrates, in some particular conditions, can produce a type of grain due to wetting
issues. For example, in high humidity or low temperature environments, the ink may not dry fast enough in
fast print modes, producing a grainy effect on the print. The example below shows worse coalescence on
the right-hand side.
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It is difficult to decide whether this kind of problem is due to wetting or to dot placement error (described
below). The type of grain could be a clue: in the case of wetting issues, dots tend to aggregate into bigger
dots, with empty spaces in between. A magnifying glass can be useful to examine the print in more detail.
Here are some tips for solving this problem:

●

–

Increase the optimizer level.

–

Increase the drying power.

–

Increase the number of passes.

–

Change from 6 to 4 colors (less ink on the substrate).

Printhead alignment. This is a clear contributor to grain. If printheads are not correctly aligned, the
misplaced dots could correlate directly with the severity of the graininess.
To check printhead alignment, print the printhead alignment diagnostics plot (see Printhead alignment
diagnostics plot on page 175). As a general rule, the biggest contributors to grain caused by printhead
alignment are (in this order):
–

Bidirectional alignment

–

Intra-color alignment (alignment between the two printheads of the same color)

–

Inter-color alignment (alignment between different colors)

Here are some tips for solving this problem:

●

–

If the printhead alignment was done with a different substrate of different thickness, probably a new
printhead alignment is needed.

–

Fine-tune the alignment by identifiying the offenders in the printhead alignment diagnostics plot. See
Alignment procedure on page 172.

Substrate advance. Before trying to adjust any parameter, make the following checks:
–

Check that no substrate-advance factor was set earlier that could prevent the substrate-advance
sensor from working correctly.

–

Run the diagnostics to check that that the substrate-advance sensor is not dirty.

Grain in a print can be increased by incorrect substrate advance, due to mispositioning of the dots.
To check the substrate advance, go to the Internal Print Server and select Printer > Advance Calibration. See
Substrate-advance test print on page 182.
To correct the substrate advance, see Substrate-advance compensation on page 181. In most cases, this
will solve the problem. However, you are recommended to run the OMAS Diagnostic Tests from the Print
Care window as soon as the substrate is unloaded, to avoid having the same problem with other
substrates. See Clean the substrate-advance sensor on page 204.
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If the problem persists, try adjusting tension and vacuum settings according to the table below, step by
step (a to c), until you find settings that work.

●

Substrate wrinkles. If you see patches of high grain in some local areas of the print, this could be caused by
wrinkles in the substrate. See There are wrinkles and ink smears on the substrate on page 363.

●

Color usage. In general, 4-color printing produces more grain than 6-color printing.

●

Dual-roll printing. If you see a different level of grain in dual-roll printing, a uniformity mask is
recommended to equalize the grain. See Edit a substrate preset on page 110.

Physical deformation marks
You may occasionally see physical deformation of the substrate. This issue is not a mispositioning of the dots,
but a physical deformation of the substrate that usually occurs after the dots have been printed. There are
various kinds of deformation that may occur:
●

Diverter horizontal marks: Deformations of the substrate in the shape of straight lines (about 6 cm long)
towards the printed side of the substrate. They are separated about 2 cm vertically and 1 cm horizontally.

●

Diverter vertical marks: These physical marks have the appearance of a braid. They consist of small
wrinkles just below the curing module, forming a vertical line of small deformations.

Both kinds of deformations can be the result of an excessive curing temperature. See There are physical marks
on the substrate on page 367.

Poor curing
When the heat applied to the printed substrate is not enough for the quantity of ink laid down, the print may
appear wet or with some gloss marks. The heat needed to cure is directly dependent to the combination of: ink
density, time under the curing module (printmode), curing temperature, airflow, and drying power. These are the
defects you may see:
●

Perforated plate gloss marks: The print suffers from an added matte pattern over the areas with more ink
density. You can see small circles scattered over the picture with different levels of gloss.
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●

Wet print: The ink comes out of the curing module not perfectly dry, and in severe cases the ink can be
smudged by touching it.

Here are some tips for solving both problems:
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●

Increase the curing temperature.

●

Increase the curing airflow.

●

Increase the curing temperature and airflow.

●

Decrease the ink density.

●

Reduce throughput.

●

Repeat the Add New Substrate procedure in case you had wrong settings in the substrate preset.
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12 Troubleshoot ink cartridge and printhead
issues

Ink cartridges
Cannot insert an ink cartridge
1.

Check that the cartridge (type and capacity) is the correct one for the printer. See http://www.hp.com for
the latest information on printer supplies.

2.

Use the correct procedure to change ink cartridges, through the Internal Print Server. See Remove an ink
cartridge on page 150.

3.

Check that there is no obstruction in the ink cartridge connector.

4.

Check that the ink cartridge is of the correct color. A connector will refuse to connect to a cartridge of the
wrong color.

5.

Check that the ink cartridge is correctly oriented (compare with the others).

The Internal Print Server does not recognize an ink cartridge
1.

Ensure that you have inserted the cartridge correctly and fully. You should hear a click.

2.

Ensure that the tabs on each side of the cartridge connector are opened but in place, showing a successful
connection.

3.

If the problem persists, check the ink cartridge connector (see Bent ink cartridge connector on page 400).

4.

If the problem still persists, call your service representative (see HP Customer Care Centers on page 409).

The Internal Print Server recommends replacing or reseating an ink cartridge
1.

Disconnect the ink cartridge.

2.

Reconnect the ink cartridge and check the Internal Print Server message.

3.

If the problem persists, check the ink cartridge connector (see Bent ink cartridge connector on page 400).

4.

If the problem persists, insert a new ink cartridge.

5.

If the problem still persists, call your service representative (see HP Customer Care Centers on page 409).

Bent ink cartridge connector
You may find that the ink cartridge connectors have become bent while the cartridge was disconnected (see
Remove an ink cartridge on page 150). This means that they cannot connect properly, and you will see a reseat
message.
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To correct this problem, use pliers to straighten the connectors so that they will fit into their slots.

Printheads
Cannot insert a printhead
1.

Check that you are inserting the printhead into the correct slot.

2.

Use the correct procedure to change printheads, through the Internal Print Server. See Remove a printhead
on page 154 and Insert a printhead on page 157, bearing in mind the special tips for the optimizer
printhead.

3.

Check that there is no obstruction in the printhead slot.

4.

Check that the printhead is correctly oriented (compare with the others).

The Internal Print Server recommends replacing or reseating a printhead
General recommendations
1.

Remove the printhead.

2.

Reinsert the printhead into the carriage and check the Internal Print Server message.

3.

If the problem persists, exchange the printhead with the printhead of the same color in the other row.

4.

If the problem persists, check the printhead contacts for dirt or aerosol and clean them if necessary. See
Clean the printhead contacts on page 326.

5.

Find more troubleshooting information in the following sections, Problem due to overheating on page 401
and Problem due to the primer system on page 401.

6.

If the problem persists, insert a new printhead.

7.

If no printhead works in that slot, call your service representative (see HP Customer Care Centers
on page 409).

Problem due to overheating
A printhead may overheat for several reasons:
●

The room temperature may be too high.

●

The printhead may be suffering from blocked nozzles. You may be able to cure this problem by cleaning the
printheads (see Check and clean the printheads on page 160).

●

The printhead may be faulty, in which case it should be replaced.

Problem due to the primer system
Primers are important to the printheads’ nozzle health. When there is a problem with a primer, the Internal Print
Server displays the following messages.
During a printhead replacement
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●

A reseat message for a particular printhead

●

A printhead replacement incomplete message

●

A numerical error code starting with 46 (46.0X.0Y:ZZ)

Printheads 401

During a printhead servicing routine
●

A reseat message for a particular printhead

●

A numerical error code starting with 46 (46.0X.0Y:ZZ)

The message 46.02.0Y:06 – Primer 0Y leakage detected indicates that one of the primer systems leaks. The
number 0Y, where Y ranges from 1 to 7, indicates which primer is leaking.

You are recommended to:
●

Run the primer diagnostic test from the Print Care window to confirm the cause of the error.

●

Reseat the printhead. Make sure to push the primer into position before securing the latch. While running
the test, you will already have done it at least once.
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●

Check that the O-rings in the primer ports are not broken or damaged. Replace the primer if any O-ring is
missing or dented.

●

Replace the primer. See Replace a primer on page 280.

●

Grease the printhead primers. See Grease the printhead primers on page 273.

If none of these actions resolve the problem, call your service representative.
If you see the message 46.01.0Y:01 – Primer 0Y signal fail, run the primer diagnostic test from the Print Care
window to confirm the cause of the error.
If the test instructs you to replace the primer, replace it. See Replace a primer on page 280. Otherwise, call your
service representative with the test results at hand.

Printhead health troubleshooting
There are two diagnostics to check the status of the printheads: the printhead status plot and the drop detector
diagnostics in Print Care. Always use both, as they provide complementary information.

Printhead status plot
To print the printhead status plot, go to the Internal Print Server, select Printer > Printhead cleaning and press the
Print button.

The following image is printed.
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▲

The image below shows plainly which nozzles in each printhead are printing and not printing.

For reference, each one of the 5 areas (square in the picture and 1 to 5) of each color corresponds to
approximately 1000 nozzles.

Drop detector diagnostics
Execute the Drop Detector diagnostics from the Print Care window. This will identify blocked nozzles in each
printhead.

Decision table
The following table summarizes the data that can be seen in each diagnostic, the possible causes, and the
decisions.
Mid-tones (section 1)

Nozzle health (sectiion 2)

Drop detector

Possible cause

Action

No banding

< 300 blocked (all colors)

< 300 blocked (all colors)

Other

Continue banding
troubleshooting.

Banding in all colors

< 300 blocked (all colors)

< 300 blocked (all colors)

Substrate advance, or
other

Check the substrateadvance sensor.
Continue banding
troubleshooting.

Banding in one color

< 300 blocked (that color)

< 300 blocked (that color)

Other

Continue banding
troubleshooting.

> 300 blocked

> 300 blocked

Printhead failure

Hard-clean the printhead,
twice if necessary.
Replace the printhead.

N/A

< 300 blocked (at least
one color)

> 300 blocked (at least
one color)

Drop detection failure

Call your service
representative.

Hard clean
To perform a hard cleaning routine, go to the Internal Print Server, select Printer > Printhead cleaning, select the
printhead(s) to clean and press the Hard clean button.
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Sometimes, when the printhead is quite damaged, running the hard-clean routine twice helps to recover its
performance.

New printhead is rejected
If the printer will not accept a new printhead, try the following steps in sequence:
1.

Ensure that the printhead was correctly stored in its orange cap.

2.

Ensure that the electrical contacts are clean.

3.

Run the primer system diagnostic.

4.

Exchange the printhead with the printhead of the same color in the other row.

5.

Assume that the printhead is faulty, and try another one.

6.

If no printhead works in that slot, call your service representative.

Printhead cleaning roll errors
You should not touch the printhead cleaner roll except when you need to replace it.
When the printhead cleaning roll reaches its end, it should be replaced. Always do this by following the Internal
Print Server wizard. See Replace the printhead cleaning roll, filters, and spittoon on page 161.
Any handling of the roll may prevent the printer from keeping track of roll usage, in which case you may see
spurious error messages, and a printing job may be cancelled unnecessarily.
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13 Troubleshoot other issues

The printer does not start
1.

Check that the power supply to the printer is working.

2.

Check that the main power switch and PC switch are both on.

3.

Check that the main power lights are on and the circuit breakers are all up.

4.

Check that the IPS is working with no alerts showing.

5.

Try turning the main switch off (not the PC switch) and turning it on again after 10 seconds.

6.

If any of the circuit breakers trip (from up to down) while the printer is operating, switch off the printer and
call your service representative (see HP Customer Care Centers on page 409).

The printer does not print
If all is in order (substrate loaded, all ink components installed, and no file errors), there are still reasons why a
file you have sent from your computer may not start printing when expected:
●

You may have an electrical power problem. If there is no activity at all from the printer, nor from its built-in
computer, check that the power cables are connected correctly and that there is power available at the
source.

●

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this
case, turn off the printer, wait until the electromagnetic environment has returned to normal, then turn it on
again. If you still experience problems, call your service representative (see HP Customer Care Centers
on page 409).

The printer cannot be restarted from the Internal Print Server
In rare cases, the printer may be unresponsive to the Shutdown and Wake up buttons. If this happens, turn off
the main switch, then turn it on again after 10 seconds and restart the built-in computer.

The printer seems slow
You may experience a temporary delay while the printer's drying and curing modules are warming up.
In some circumstances, the printer will deliberately print more slowly than usual to prevent the printheads from
overheating. There are several possible reasons why a printhead may start to overheat:
●

The room temperature is too high.

●

The printhead is suffering from blocked nozzles (see Check and clean the printheads on page 160).

●

The printhead is faulty and should be replaced.
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Request to reinitialize the carriage
In some cases you may be asked to reinitialize the carriage. This operation restarts some mechanical
subsystems, avoiding the need to restart the whole printer.

The Internal Print Server cannot detect the printer
If the Internal Print Server cannot establish communication with the printer, without apparent reason of after
modifying Windows properties, follow these steps:
1.

Use the Wake up button in the Tools menu to try to reactivate the printer.

2.

Turn off the printer’s main switch, then turn it on again after 10 seconds and restart the built-in computer.

3.

Check the cable connecting the built-in computer to the printer.

4.

Check that the Internal Print Server is correctly set up.

5.

Contact your service representative.

Print Care spontaneously restarts
The Print Care software may restart itself when it detects that the printer’s firmware or the Internal Print Server
or some of their components have been updated, so this can happen from time to time.

Color calibration fails
Automatic color calibration may fail occasionally. You may see the alert Color calibration cancelled because of
scanning errors, which can be caused by various different problems.
●

Reflective color measurements of the printed target cannot be performed reliably on the current substrate.
Reflective color measurement can be unreliable or impossible on substrates that are non-white,
transparent or translucent, very glossy, or have a very rough or punched surface. For these substrates,
automated color calibration using the embedded spectrophotometer may not be possible.

●

Some of the color measurements of the color calibration test chart are defective due to:

●
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–

Stains or printhead crash marks on the substrate, that can be easily seen by visual inspection of the
printed chart. Make sure the substrate has no stains before running color calibration. Printhead crash
marks may occur when the substrate is wrinkled. See There are wrinkles and ink smears on the
substrate on page 363.

–

Wrinkles or bubbles in the substrate, even when there has been no printhead crash.

–

Generally poor print quality (such as banding). See Troubleshoot print-quality issues on page 378.

Either the embedded spectrophotometer or the line sensor is not working properly. If the problem persists,
call your service representative (see HP Customer Care Centers on page 409).
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14 When you need help

HP Support is available from the IPS Help Menu. There are two options to contact support:
●

●

Help > HP Remote Support: use this option to launch the HP Customer support portal, there are two
options:
–

Chat: the fastest way to contact HP remote support agents.

–

Create a case: submit and manage support cases for your printer.

Help > Remote Control: use this option to allow HP support to take control of your Computer. Call your
remote support assistant and follow his instructions. Enter the 6 digit code when provided by the operator
to allow remote connection: Webcam streaming is now possible. The call can include chat, remote desktop
access, and the sharing of files, images, and video.

NOTE: Remote support may not be available if you are not directly supported by HP or if you have not accepted
the Data Transfer Agreement. To enable HP Support, go to the Internal Print Server, select Tools > Preferences >
Remote assistance, and ensure that the Enable Remote Assistance checkbox is ticked.

HP Proactive Support
HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and resolving
printer issues before they become problems for you. HP's Proactive Support tool is designed to help businesses
of all sizes reduce support costs and maximize productivity—all with the click of a mouse.
A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your
printing environment—with a clear focus on maximizing the value of your investment, increasing printer uptime
and reducing printer management costs.
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HP recommends that you enable Proactive Support right away to save you time and prevent problems before
they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware
updates.
You can enable Proactive Support in the Internal Print Server by selecting Tools > Proactive Support, where you
can specify the frequency of connections between your computer and HP's Web server, and the frequency of
diagnostic checks. You can also choose to run the diagnostic checks at any time.
If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and
recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be
asked to perform some procedure to solve the problem.

HP Customer Care
HP Customer Care offers award-winning support to ensure you get the most from your printer, providing
comprehensive, proven support expertise and new technologies to give you unique end-to-end support. Services
include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone
and Web support, software updates and self-maintenance services. To find out more about HP Customer Care,
visit us at:
http://www.hp.com/go/graphic-arts/
or call us on the telephone (see HP Customer Care Centers on page 409). To register your warranty:
http://register.hp.com/

HP Customer Care Centers
Help is available to you by telephone. For the right telephone numbers in your location, see http://www.hp.com/
go/LatexCareCenters.
What to do before you call
●

Review the troubleshooting suggestions in this guide.

●

Review your RIP's documentation, if relevant.

●

Ensure that you have the following information available:
–

The printer you are using: the product number and the serial number, found on the label on the door
of the electrical compartment

–

If there is an error code in the Internal Print Server window, note it down; see Printer messages
on page 415

–

The printer's Service ID

–

The RIP you are using, and its version number

–

The software application you are using, and its version number

–

If you have a problem directly related to an ink supply component (printhead, ink cartridge), take note
of the product part number and warranty end date.

–

The text displayed by the Internal Print Server when you select Help > About

Service information
The printer can produce on request a list of many aspects of its current status, some of which may be useful to a
service engineer trying to fix a problem. There are two different ways to request this list:
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●

In the Internal Print Server, select Information > Service information.

●

From any computer with Internet access, enter the URL of your printer into a Web browser, followed
by /hp/device/webAccess/allServicePlot.htm. For instance, if the URL of your printer is
http://123.123.123.123, enter http://123.123.123.123/hp/device/webAccess/
allServicePlot.htm.

You can request the whole list, which takes a significant time to generate; or you can request specific parts of it. If
in doubt, you are recommended to request the whole list (select All pages).
If you need to send the list by e-mail, you can save the page as a file from your Web browser, and later send the
file. Alternatively, from Internet Explorer you can send the page directly: select File > Send > Page by E-mail.
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15 Printer specifications

Functional specifications HP Latex 3100/3200/3500/3600
Ink supplies
Printheads

Cyan and black, light magenta and light cyan, yellow and magenta, HP Latex Optimizer

Ink cartridges

Cyan, magenta, yellow, black, light cyan, light magenta, HP Latex Optimizer

Substrate sizes
Minimum

Maximum (HP Latex
3000/3100/3200 Printer only)

Maximum (HP Latex 3500/3600
Printer only)

Roll width

635 mm (25 in)

3.20 m (126 in)

3.20 m (126 in)

Dual roll width

635 mm (25 in)

2 × 1.60 m (2 × 63 in)

2 × 1.55 (2 × 61 in)

Roll diameter

80 mm (3.15 in)

300 mm (11.8 in)

400 mm (15.7 in)

Roll weight

160 kg (350 lb)

300 kg (656 lb)*

Dual roll weight

2 × 70 kg (2 × 154 lb)

2 × 200 (2 × 440 lb)

(core diameter)

(*) It is advised not to overload the single spindle in the HP Latex 3500/3600 according to the following weight vs
width table:
Max weight VS substrate width recommendations for HP Latex 3500/3600
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Substrate width (inches)

Max weight (kg)

126

300

110

270

100

250

90

240

80

230

70

220

63

200

61 or less

200

Comments

Single roll spindle in HP Latex 3500/3600

Recommended to use Dual Roll spindle
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NOTE: Narrow substrates can be damaged during printing if they are very weak.
Passes, resolutions, and speeds
Resolution (ppi)

Printing speed (m²/h)

Printing speed (ft²/h)

Passes

Ink density

Rendering

Printing

3.2 m roll

3.2 m roll

1

≤ 40%

300 × 300

600 × 1200

315

3391

2

≤ 60%

300 × 300

600 × 1200

180

1938

3

≤ 80%

300 × 300

600 × 1200

120

1292

4

≤ 100%

300 × 300

600 × 1200

98

1055

6

≤ 150%

600 × 600

600 × 1200

77

829

8

≤ 170%

600 × 600

600 × 1200

59

635

10

≤ 300%

600 × 600

600 × 1200

44

474

14

≤ 300%

600 × 600

600 × 1200

35

377

18

131–300%

600 × 600

600 × 1200

27

291

18

≤ 130%

600 × 600

1200 × 1200

22

237

Standard print modes
Print mode name

Viewing distance

Print mode

Printing speed (m²/h)

Printing speed (ft²/h)

High-saturation backlit

1–3 m

18p 6c 230%

27

290

Backlit and textile

1–3 m

14p 6c 200%

35

375

Textile and canvas

1–3 m

10p 6c 170%

44

470

Canvas and wall covering

1–3 m

8p 6c 120%

60

630

Indoor high-quality

1–3 m

6p 6c 100%

77

830

Outdoor plus

3–5 m

4p 6c 90%

98

1050

Outdoor

3–5 m

3p 6c 80%

120

1290

Billboard

>5m

2p 4c 70%

180

1950

NOTE: Printing speed is measured using rolls 3.2 m (126 in) wide.

Physical specifications
Printer physical specifications
HP Latex 3000

HP Latex 3100/3200/3500/3600

Weight

1500 kg (3307 lb) without crate

1740 kg (3836 lb)/1870 kg (4122 lb)
without crate

Width

5.98 m (235 in)

5.98 m (235 in)

Depth

1.72 m (68 in)

1.72 m (68 in)

Height

1.67 m (66 in)

1.87 m (74 in)
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Memory specifications
Memory specifications for the Internal Print Server computer
Memory (DRAM) supplied

8 GB

Hard disk

500 GB

SSD (HP latex 3100/3200/3500/3600 only)

500 GB

Power specifications
The drying and curing components are powered with a three-phase line that requires a power distribution unit
(PDU).
Power specifications for drying and curing components
HP Latex 3000

HP Latex 3100/3200/3500/3600

3-phase (line-to-line voltage)

200–240 V AC, 50/60 Hz, 48 A max

200–240 V AC, 50/60 Hz, 56 A max

3-phase (line-to-line voltage)

380–415 V AC, 50/60Hz, 30 A max

380–415 V AC, 50/60Hz, 35 A max

240 V AC, 50/60Hz, 63 A max

240 V AC, 50/60Hz, 72 A max

1-phase

100–127 V AC, 50/60Hz, 6 A max

100–127 V AC, 50/60Hz, 10 A max

1-phase

200–240 V AC, 50/60Hz, 6 A max

200–240 V AC, 50/60Hz, 10 A max

Mains power, input rated current

High-current 1-phase
PC power (optional), input rated current

Air supply requirements (pneumatic spindle)
Air pressure supply
The pneumatic spindle requires an air compressor or a pressurized air line, not supplied with the printer.
TIP:

You are recommended to use a pressure gauge that indicates the pressure in bars.

Air supply specifications
Air pressure

5.5 bar (80 psi)

Minimum airflow

Recommendation: 30 l/min

Lubricator

Not recommended

Air filter (recommended)

Recommendation: 5 µm, auto-drain, 99.97% coalescing efficiency

Regulator (required)

Regulator with pressure gauge

Pneumatic connector
The printer comes with an air gun that you must attach to your air supply. In order to connect your air supply to
the air gun, you must meet the following requirements:
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●

9.84-mm (0.25-in) female connector, BSP or NPT thread

●

Tape to secure the connection and prevent air leaks
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Ecological specifications
For the up-to-date ecological specifications of your printer, go to http://www.hp.com/ and search for “ecological
specifications”.

Environmental specifications
Printer environmental specifications
Temperature range

Humidity range

Temperature gradient

Operating for optimal print
quality

20 to 25°C (68 to 77°F)

30 to 60% relative humidity

10°C/h (18°F/h) or less

Operating for standard printing

15 to 30°C (59 to 86°F)

20 to 70% relative humidity

10°C/h (18°F/h) or less

Not operating, in transport or
storage, ink in tubes

5 to 55°C (41 to 131°F)

90% relative humidity at 55°C
(131°F)

10°C/h (18°F/h) or less

Not operating, in transport or
storage, no ink in tubes *

–25 to 55°C (–13 to 131°F)

90% relative humidity at 55°C
(131°F)

10°C/h (18°F/h) or less

* If the printer is going to be kept at a temperature of less than 5°C, call your service representative to empty the
ink from the tubes.
Maximum operating altitude: 3000 m (10000 ft)
The printer should not be exposed to direct sunlight or any other strong light source, and it should not be used in
a dusty environment.

Acoustic specifications
Printer acoustic specifications (declared according to ISO 9296).
Printer acoustic specifications
Idle sound power level

8.8 B (A)

Operating sound power level

8.2 B (A)

Idle sound pressure at bystander position

< 60 dB (A)

Operating sound pressure at bystander position

< 67 dB (A)
< 75 db (A) during cool-down

414 Chapter 15 Printer specifications

ENWW

A

Printer messages

Occasionally you may see messages such as the following in the Internal Print Server window.
There are two types: text messages, which are more informative, and messages containing numerical codes,
which mean that the printer has detected a problem or malfunction.
When one of these messages appears, follow any instructions provided by the printer, and consult the tables
below. If you feel in doubt about the correct response, or if you have followed the recommendation but the
problem persists, call your service representative. See HP Customer Care Centers on page 409.
Text messages
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Message

Recommendation

{Color} cartridge has expired

You are advised to replace the ink cartridge. See Remove an ink
cartridge on page 150.

{Color} cartridge is altered

You are advised to replace the ink cartridge. See Remove an ink
cartridge on page 150.

{Color} cartridge is low on ink

Be ready to replace the ink cartridge soon.

{Color} cartridge is missing

Install the correct ink cartridge. See Insert an ink cartridge
on page 151.

{Color} cartridge is non-HP ink

You are recommended to install an HP ink cartridge for best
performance.

{Color} cartridge is out of ink

Replace the ink cartridge. See Remove an ink cartridge
on page 150.

{Color} printhead is missing

Install the correct printhead. See Insert a printhead on page 157.

{Color} printhead out of warranty

The printhead’s warranty has ended, because of the length of time
it has been in operation, because of the volume of ink used, or
because non-HP ink has been used in the system. See the limited
warranty document.

An error has occurred in printhead detection

Remove the printhead, clean any ink from the electrical connectors
on the printhead (do not try to clean the nozzles), and reinsert the
printhead. See The Internal Print Server recommends replacing or
reseating a printhead on page 401.

Checking file system

After a dirty power off, the printer performs a file system check,
which will take some minutes.

Checking printer

The printer is completing checks and cool-down cycle after finishing
a job.

Clean drop detector spittoon

You are advised to clean the ink deposits. See Clean the dropdetector ink deposits on page 242.

Cleaner roll jam.

Go to the Internal Print Server and select the Ink System menu, then
Check cleaner roll. Pull out the printhead cleaning roll assembly,
raise the pinchwheels, wind the roll forward manually, then lower
the pinchwheels and push the assembly back into the printer.
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Text messages (continued)
Message

Recommendation

Color calibration cancelled because of scanning errors

The color calibration chart could not be scanned successfully with
the current substrate. See Color calibration fails on page 407.

FW upgrade post actions

The firmware update is being performed.

Initializing

The Internal Print Server is connecting to the printer.

Initializing, please wait

The Internal Print Server is starting the printer.

Ink drying

The printer is drying the last passes of a job after printing it.

Ink system not ready to print

Wait a while. If the printer does not recover, restart it.

Job canceled due to lack of data received from the IPS

If the problem persists, check the configuration of the Internal Print
Server computer.

Line sensor calib. error: substrate too small

Load a larger substrate.

Low cleaner roll

Be ready to replace the printhead cleaning roll soon.

Lower lever

Lower the substrate pressure handles.

Maintenance #N advised. Please contact HP

You are advised to contact your service representative. See
HP Customer Care Centers on page 409.

No substrate loaded

Load substrate.

Offline

The printer is shut down or not detected.

Please close safety sensor

An open safety circuit has been detected, and should be closed in
order to continue working.

Please turn emergency stop buttons to release them.

An emergency button has been pressed, and must be released to
continue working.

Preparing to print

The printer is performing checks and warm-up prior to printing.

Printer cannot carry on printing

Check that the three-phase power supply is working and that the
ambient temperature is within the normal range. This problem can
also be caused by holes in the substrate, by reflective or
transparent substrates, or by a dirty or faulty temperature sensor.

Printer cannot cool down

If the ambient temperature is within the normal range, this problem
may be caused by removing the substrate too quickly after printing.
Try leaving the substrate in the printer until temperatures settle
down after printing.

Printer cannot warm up

Check that the three-phase power supply is working. This problem
can also be caused by holes in the substrate, by reflective or
transparent substrates, or by a dirty or faulty temperature sensor.

Printheads not aligned

Align the printheads. See Align the printheads on page 172.

Printhead replacement incomplete

The printhead replacement process was unsuccessful. See The
Internal Print Server recommends replacing or reseating a
printhead on page 401.

Printing

The printer is printing.

Ready

The printer is ready to receive and print a job.

Remove {color} printhead

Remove the printhead. See Remove a printhead on page 154.

Replace {color} cartridge

Replace the ink cartridge. See The Internal Print Server
recommends replacing or reseating an ink cartridge on page 400.

Replace {color} printhead

Replace the printhead. See The Internal Print Server recommends
replacing or reseating a printhead on page 401.
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Text messages (continued)
Message

Recommendation

Replace aerosol filter

You are advised to replace both aerosol filters. See Replace the
aerosol filters on page 162.

Reseat {color} cartridge

Reseat the ink cartridge. See The Internal Print Server recommends
replacing or reseating an ink cartridge on page 400.

Reseat {color} printhead

Reseat the printhead. See The Internal Print Server recommends
replacing or reseating a printhead on page 401.

Select substrate name in the IPS

Select the name of the loaded substrate in the Internal Print Server.

Starting up

The printer is being detected while starting up.

Substrate jam: remove substrate

See The substrate has jammed on page 359.

Substrate may be detached from the rear spindle or slippage
detected. Substrate will be unloaded.

See The substrate is not attached to the core and/or spindle
on page 360.

System error

The printer has a system error. In the alert window, you should see
the numerical code of the system error.

System in sleep mode

The printer is in sleep mode.

Very low cleaner roll

Be ready to replace the printhead cleaning roll very soon.

Visually check printer for readiness, then press the blinking rearm
button to provide full power.

Press the blue, blinking button to finish the printer’s start-up
procedure.

Numerical error codes
Error code

Recommendation

10.04.XX:YY

Problem with e-cabinet fuses. You may need to run a subsystem diagnostic to confirm that fuse
replacement is required.

10.06.09:40

The emergency stops and/or safety relay have been activated. Check that the emergency stops are not
activated. If the problem persists, run a diagnostic to identify the issue.

51.01.00:92

The main window is open. Close the window to continue printing. If the problem persists, run a
diagnostic to identify the issue.

51.02.00:92

The front cover is open. Close the front cover to continue printing. If the problem persists, run a
diagnostic to identify the issue.

51.03.00:92

The loading table is not closed. Close the loading table to continue printing. If the problem persists, run
a diagnostic to identify the issue.

51.04.00:92

The emergency stops and/or safety relay have been activated. Check that the emergency stops are not
activated. If the problem persists, run a diagnostic to identify the issue.

86.01.00:01

Carriage movement failure. Ensure that maintenance routines are up to date, then perform Reinitialize
carriage from the Internal Print Server. Also perform the carriage-rail cleaning process (see Clean the
carriage rails and replace the oiler foams on page 216).

86.04.XX:08

Possible scan-axis jam detected. Check that servicing and substrate paths are completely clean and
clear of obstacles, then perform Reinitialize carriage from the Internal Print Server. If the problem
persists, run subsystem diagnostics and call your service representative.

NOTE: The above table includes the most significant numerical codes. If you receive an error code that is not in
the table, follow the instructions in the message.
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Glossary

Aerosol filter
The printheads produce many fine droplets of ink, most of which are placed accurately on the substrate. However, a small
proportion of these droplets escape sideways; the two aerosol filters are placed on either side of the printhead carriage to
intercept them.
Bleeding
A print-quality defect that occurs when the ink spreads on the substrate across areas of different colors.
Carriage beam
The beam supporting the printhead carriage as it moves back and forth across the printer.
Coalescence
A print-quality defect that looks like a higher level of whiter grain.
Cockle
A substrate condition in which it is not lying perfectly flat, but rises and falls slightly in shallow waves.
Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited
color gamut and may not be physically capable of matching certain colors precisely.
Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.
Color model
A system of representing colors by numbers, such as RGB or CMYK.
Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same
color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a
particular set of RGB numbers results in different colors on different monitors.
Curing
Curing is needed to coalesce the latex, creating a polymeric film which acts as a protective layer, while at the same time
removing the remaining co-solvents from the print. Curing is vital to ensure the durability of the printed images.
Drying
The heat applied in the printing zone removes water and fixes the image to the substrate.
ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of
the main hazards to the electronics products. Therefore, to prevent damage some precautions are needed when setting up
the product, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device or render it
unusable. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed
grounded part of the product (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink
cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area,
and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity
environments.
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Ethernet
A popular computer networking technology for local area networks.
Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).
Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.
I/O
Input/Output: this term describes the passing of data between one device and another.
ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.
Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.
Ink density
The relative amount of ink that is deposited on the substrate per unit of area.
Ink deposit
The printheads sometimes expel a small amount of ink into the ink deposits in order to check the status of each nozzle.
Ink limits
A means of specifying the maximum amount of ink of all colors in total that can be laid down onto a given substrate.
Ink restrictions
A means of specifying the maximum amount of each color of ink that can be laid down onto a given substrate.
IP address
A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers separated by dots.
LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.
Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the substrate.
Passes
The number of passes specifies how many times the printheads will print over the same area of substrate.
Platen
The flat surface within the printer over which the substrate passes while it is being printed on.
Printhead
A removable printer component that takes ink of a particular color or colors from the corresponding ink cartridge(s) and
deposits it on the substrate, through a cluster of nozzles.
Printhead cleaner roll
A roll of absorbent material used to clean surplus ink from the printheads after each pass over the substrate.
Spindle
A rod that supports a roll of substrate while it is being used for printing.
Substrate
A thin, flat material made to be printed on.
TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.
Tension
Tension is applied at the input and the output side of the printer. It needs to be evenly distributed along the whole width of
the substrate, thus substrate loading is a critical operation.
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Vacuum pressure
The vacuum applied to the substrate in the printing zone helps to hold the substrate down on the print platen, keeping the
distance to the printheads constant.
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Symbols/Numerics
3000/3100/3200 dual-roll printing
61
3500/3600 dual-roll split spindles
center support 63
3x00 printer maintenance kit 191

B
banding problems 181
broken bag 322

cartridges
misuse 153
caution 7
collector
detached substrate 376
fails intermittently 376
skew or telescoping 376
stops winding 375
substrate jam 376
winds wrong way 376
color calibration 178
color consistency 41
color consistency between printers
180
color profile 180
components of printer 10
condensation collector bottle
about 150
empty 213
crop 133
curing fan
clean 355
replace 315
curing module and airlet plates
clean 350
curing module side rubber
replace 339
Customer Care 409

C
calibrate
dual-roll center support 370
carriage
reinitialize 407
carriage beam position 123
carriage beam screws
grease 268
carriage bottom
clean 238
carriage rails
clean 216
clean manually 334

D
day and night kit 94
delete a print job 133
documentation 2
double side block out; multijobs 142
double-sided layout 135
double-sided printing 87
drive roller
clean 209
drop detector ink vessel
empty 271
drying fans array
replace 290

A
acoustic specifications 414
add a print job 125
aerosol fan module
replace 286
aerosol filter
about 149
aerosol filters
clean 206
replace 162
air supply requirements 413
alerts
errors 25
alerts, warnings 25
alignment
check center support 369
automatic tracking 181
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drying filter
about 149
drying filters
replace 164
drying lamps
replace 295
drying quartz glass
replace 311
dual roll-to-roll configuration
dust and aerosol
check 277

77

E
e-box fan filter
clean 247
replace 258
e-cabinet fan filters
clean 245
replace 256
e-cabinet fuse
replace 324
ecological specifications 414
edge holders 43
electromagnetic disturbances 406
emergency stop buttons 10
environmental specifications 414
error messages 415
F
features of printer 1
firmware update 26
functional specifications 411
H
hard disk specification 413
how to use your printer 1
HP Customer Care 409
HP Proactive Support 408
I
image composition
impinging plate
clean 261

134

Index 421

in-line slitters 99
in-line slitters 99
ink cartridge
about 148
bent connector 400
cannot insert 400
insert 151
maintain 152
not recognized 400
remove 150
reseat 400
specification 411
status 152
ink collector
replace foams 353
wipe 349
wipe ribs 348
ink collector kit 48
ink deposits
about 150
clean 242
intermediate tank
replace 322
Internal Print Server
language 21
maintenance 28
preferences 21
start 20
units of measurement
upgrade 26
introduction jdf 29

weekly 202
when required 276
maintenance kits 190
maintenance off/on 195
maintenance tools 192
maintenance with Print Care 192
maintenance without Print Care 193
memory specifications 413
move the printer 17
multiple exports
export 102
N
nesting 144
non-hp ink
consequences 153
O
oil collector caps
empty 229
oiler foams, replace 216
on-the-fly adjustment 113
output platen
clean 211
output platen light 19

21

L
labels, warning 8
LED proofing lights 101
light
output platen 19
lights
LED proofing 101
load substrate
cannot load 359
load substrate into printer 65
load substrate onto the spindle 59
M
maintenance
125 liters 216
1500 liters 256
3 liters 347
40 liters 353
500 liters 252
ink collector 500 355
mandatory 202
uninstall ink collector 349
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P
perforated plate
clean 343
physical specifications 412
pinch clamp
replace 336
pinchwheel submodule
replace 278
pinchwheels
clean 209
porous substrates 48
power specifications 413
prepare to print 43
primer
replace 280
print adjustment 113
Print Care restarts 407
print jobs 125
print masks 112
print modes 412
print queue 132
print zone
clean 202
print-quality problems
general 378
printer
move 17
status beacon 18

printer cleaning kit 190
printer does not print 406
printer does not restart 406
printer does not start 406
printer not detected 407
printer on/off 16
first time 16
printer software 15
printer status 25
printer status beacon 18
printer's main components 10
printer's main features 1
printhead
about 148
align 172
cannot insert 401
check and clean 160
insert 157
maintain 160
remove 154
reseat 401
specification 411
printhead alignment diagnostics
plot 175
printhead cleaning roll
about 149
errors 405
replace 167
printhead cleaning waste bottle
empty 342
printhead contacts
clean 326
printhead primers
greese 273
printhead rejected 405
printing masks 112
printing resolutions 412
printing speeds 412
Proactive Support 408
protector
wipe 347, 349
protector textile substrate edge holder
replace 358
Q
QR code

2

R
Raster Image Processor 15
rear scan-axis beam
clean 264
restart and print 147
RIP 15
adding jobs from 125
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rocker pads
replace 337
roll-to-collector configuration 84
roll-to-free-fall configuration 81
roll-to-free-fall roller
clean 333
roll-to-roll configuration 67
rotate a print job 131
rubber blade
replace 252
S
safe mode 161
safety labels 8
safety precautions 2
saver
substrate 94
scan axis encoder
clean 338
service information print 409
service station cap
replace 319
service station caps
clean 340
skew option; check 85
slow printing 406
software 15
specifications
acoustic 414
air supply 413
ecological 414
environmental 414
functional 411
hard disk 413
ink supplies 411
memory 413
physical 412
power 413
print modes 412
printing resolutions 412
printing speeds 412
substrate size 411
substrate weight vs width 411
spindle latch opens 361
spindle valve
replace 331
spittoon
about 149
replace 166
substrate
advance compensation 181
cannot load 359
center support latch noise 373
configurations 41
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detached from core 360
drops of ink 368
dual roll to roll 77
edit preset 110
ink marks 366
jammed 359
load into printer 65
load onto the spindle 59
maintain 39
new 103
not flat 360
online manager 117
physical marks 367
porous 48
preset 102
remove preset 116
roll to collector 84
roll to free fall 81
roll to roll 67
shrinkage 374
sizes (max and min) 411
skewed 362
sticks to platen 366
supported types 35
telescoping 362
tips 39
unload 92
variable shrinkage 374
vibration noise 361
view information 92
weight (vs width) 411
wizard 108
wrinkles 363
substrate edge holders 43
substrate input output
clean 250
substrate saver 94
substrate-advance sensor
clean 204
support services
HP Customer Care 409
HP Proactive Support 408

U
unload substrate 92
using the guide 1
V
vapor removal external filter
clean 263
W
warning 7
warning labels 8
welcome to your printer 1
working jdf 29

T
telephone support 409
thunderstorm 406
tiling 134
optimize 104
transmission and rods
clean and grease 270
transmission gears and rods
clean and grease 267
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